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Legal Information
The Schneider Electric brand and any registered trademarks of Schneider Electric Industries SAS
referred to in this guide are the sole property of Schneider Electric SA and its subsidiaries. They
may not be used for any purpose without the owner's permission, given in writing. This guide and its
content are protected, within themeaning of the French intellectual property code (Code de la
propriété intellectuelle français, referred to hereafter as "the Code"), under the laws of copyright
covering texts, drawings andmodels, as well as by trademark law. You agree not to reproduce,
other than for your own personal, noncommercial use as defined in the Code, all or part of this guide
on any medium whatsoever without Schneider Electric's permission, given in writing. You also
agree not to establish any hypertext links to this guide or its content. Schneider Electric does not
grant any right or license for the personal and noncommercial use of the guide or its content, except
for a non-exclusive license to consult it on an "as is" basis, at your own risk. All other rights are
reserved.

Electrical equipment should be installed, operated, serviced andmaintained only by qualified
personnel. No responsibility is assumed by Schneider Electric for any consequences arising out of
the use of this material.

As standards, specifications and designs change from time to time, please ask for confirmation of
the information given in this publication.



Safety Information
Important Information

Read these instructions carefully and look at the equipment to become familiar with the
device before trying to install, operate, service or maintain it. The following special
messages may appear throughout this bulletin or on the equipment to warn of potential
hazards or to call attention to information that clarifies or simplifies a procedure.

The addition of either symbol to a "Danger" or "Warning" safety label
indicates that an electrical hazard exists which will result in personal injury if
the instructions are not followed.
This is the safety alert symbol. It is used to alert you to potential personal
injury hazards. Obey all safety messages that follow this symbol to avoid
possible injury or death.

DANGER
DANGER indicates a hazardous situation which, if not avoided, will result in death or serious
injury.

WARNING
WARNING indicates a hazardous situation which, if not avoided, could result in death or
serious injury.

CAUTION
CAUTION indicates a hazardous situation which, if not avoided, could result inminor or
moderate injury.

NOTICE
NOTICE is used to address practices not related to physical injury.

Please Note
Electrical equipment should be installed, operated, serviced andmaintained only by qualified
personnel. No responsibility is assumed by Schneider Electric for any consequences arising out of
the use of this material.

A qualified person is one who has skills and knowledge related to the construction, installation, and
operation of electrical equipment and has received safety training to recognize and avoid the
hazards involved.
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Safety Precautions
During installation or use of this software, pay attention to all safety messages that occur in the
software and that are included in the documentation. The following safety messages apply to this
software in its entirety.

WARNING
UNINTENDED EQUIPMENT OPERATION
• Do not use the software or devices for critical control or protection applications where human
or equipment safety relies on the operation of the control action.

• Do not use the software to control time-critical functions.
• Do not use the software to control remote equipment without proper access control and status
feedback.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

WARNING
INACCURATE DATA RESULTS
• Do not incorrectly configure the software or the devices.
• Do not base your maintenance or service actions solely onmessages and information
displayed by the software.

• Do not rely solely on softwaremessages and reports to determine if the system is functioning
correctly or meeting all applicable standards and requirements.

• Consider the implications of unanticipated transmission delays or failures of communications
links.

Failure to follow these instructions can result in death, serious injury, equipment
damage, or permanent loss of data.

WARNING
POTENTIAL COMPROMISE OF SYSTEM AVAILABILITY, INTEGRITY, AND
CONFIDENTIALITY

Use cybersecurity best practices to help prevent unauthorized access to the software.

Failure to follow these instructions can result in death, serious injury, equipment
damage, or permanent loss of data.

Work with facility IT System Administrators to ensure that the system adheres to the site-specific
cybersecurity policies.

Solution Guide SafetyPrecautions
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Overview
EcoStruxure™Energy Expert – hereafter referred to as Energy Expert – is an engineered solution
that embeds features of EcoStruxure™PowerMonitoring Expert (PME) into EcoStruxure™
Building Operation (Building Operation).

The Energy Expert solution provides access to PME Dashboards, Reports, Diagrams, alarm and
real-time data through Building Operation, for a seamless user experience.

Energy Expert is intended for large buildings, such as high-rise commercial office buildings,
shoppingmalls, and university campuses. It provides easy to understand energy information for
buildingmanagers with limited electrical systems knowledge.

Solution Guide Overview
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About This Document
Applicability

This guide applies to the Energy Expert 2.0 solution only. It does not apply to earlier or later versions
of this solution. The Energy Expert 2.0 solution is based on PowerMonitoring Expert 9.0 and
Building Operation 2.0.

Target Audience
This guide is intended for Application Engineers, third-party integrators, and other qualified
personnel who are responsible for installing and integrating PME with Building Operation.

The deployment of the Energy Expert solution requires application engineering expertise in installing
and configuring Building Operation and PME.



Solution Components
The Energy Expert 2.0 solution includes the following compontents:

Building Operation 2.0
Building Operation software provides integratedmonitoring, control andmanagement of energy,
HVAC systems, lighting and fire safety systems. It is a centralized system with scalability from a
single building to a global enterprise.

Power Monitoring Expert 9.0
PowerMonitoring Expert is a complete supervisory software for powermanagement applications. It
enables you tomaximize operational efficiency, optimize your power distribution system, and
improve your bottom-line performance.

EcoStruxure™ Web Services (EWS)
EcoStruxureWeb Services (EWS) is a Schneider Electric standard for sharing data among various
EcoStruxure software platforms to facilitate the creation of EcoStruxure solutions. EWS is based
on conventional Web Services technology (SOAP, WSDL) and provides a way for solution
architects and solution development teams to build solutions that require data to be shared among
different EcoStruxure software platforms.

SmartWidgets
SmartWidgets are device driver packages for Building Operation. SmartWidgets make it fast and
easy for you to add devices like PowerMeters to the software. They are easy to install and they
provideModbus register mappings for the commonmeasurements for a given device type. They
also provide Building Operation graphics components for consistent visualization and interaction
with devices.

Extract Transform Load (ETL) Tool
The Extract, Transform, Load (ETL) tool connects to the Building Operation EWS server on either
Enterprise Server or Application Server, extracts select historical data from trend logs, and inserts
the data into the PME database. This makes trend data from Building Operation available to PME
Dashboards and Reports.

Solution Guide Overview
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Solution Limitations
Only the PME features that are embedded in Building Operation and that are described in this
document are available in the Energy Expert solution. The following additional PME features are
available in a fully licensed version of the software:

l WebClients with access to Dashboards, Diagrams, Trends, Alarms, Reports

l EmbeddableWeb Applications: Trends, Alarms

l Engineering Tools: Vista, Designer, Virtual Processor (VIP)

l Power Quality Analysis Features such as Waveform Viewer, Harmonics Analysis, Phasor Dia-
gram, and so on

l Power Quality Reports

Only the PME Standalone Architecture installation type, where the PME application server and the
database server are installed on the same computer, is supported by the Energy Expert solution.
The PME Distributed Database architecture installation type is not supported. See the
EcoStruxure™PowerMonitoring Expert 9.0 System Guide for more information on PME installation
architectures.



Resources
Supporting Documentation

l EcoStruxure™PowerMonitoring Expert 9.0 System Guide

l Architectural Guidelines 2.0.1 - EcoStruxure BuildingManagement

l IT System Planning Guide - EcoStruxure BuildingManagement

l EcoStruxure Building Operation System ReferenceGuide

l EcoStruxure Building Operation Technical ReferenceGuide

l EcoStruxure Building Operation IT ReferenceGuide

Other
l Exchange Extranet Downloads (Energy Expert Toolkit)

l PME Downloads (Device Drivers, and so on)

l PowerMonitoring Expert Design andQuote tools:

Daisy Chain Calculator

Commissioning TimeCalculator

DatabaseGrowth Calculator

Solution Guide Overview
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Design
This chapter includes the following topics:

1. Software compatibility

2. Computer hardware

3. Solution architectures

4. Guidance on choosing an architecture

5. Communications and data transfer

6. Commissioning time

Solution Guide Design
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1. Software compatibility
This section describes the Energy Expert solution software compatibility as well as the operating
environment requirements.

NOTICE
LOSS OF COMMUNICATION
• Activate product and component licenses prior to the expiry of the trial license.
• Activate sufficient licenses for the servers and devices in your system.
• Export the existing hierarchy template out of PowerMonitoring Expert before importing a new
template. The new template can overwrite the existing template, which can permanently
remove all information contained in the original.

• Backup or archive any SQL Server database data before adjusting any databasememory
options.

• Only personnel with advanced knowledge of SQL Server databases shouldmake database
parameter changes.

Failure to follow these instructions can result in loss of data.

NOTICE
UNAUTHORIZED OR UNINTENDED ACCESS TO CUSTOMER DATA
• Personnel setting up Energy Expert third-party authenticationmust be aware that links to data
are not secure.

• Do not setup access links to sensitive or secure data.

Failure to follow these instructions can result in unauthorized or unintended access to
sensitive or secure customer data.

Building Operation and PME version compatibility
The Energy Expert solution supports the following software versions:

SBO 1.6 SBO 1.7 SBO 1.8 SBO 1.9 EBO 2.0
PME 8.0 Y Y
PME 8.1 Y Y Y
PME 8.2 Y Y Y
PME 9.0 Y Y

Operating Environment

PME

PME supports the following environments and software:



NOTE: The operating system and SQL Server combination you choosemust be supported by
Microsoft. This applies to edition, version, and 32-/64-bit.

Software Supported versions

Operating system

Windows 7 Professional/Enterprise (for Engineering
clients only)
Windows 10 Professional/Enterprise
Windows Server 2012 R2 Standard/Enterprise
Windows Server 2016 Standard

Database system**

SQLServer 2012 Express
SQL Server 2014 Express
SQL Server 2016 Express (included with PME)
SQL Server 2017 Express
SQL Server 2012 Standard/Enterprise/Business
Intelligence
SQL Server 2014 Standard/Enterprise/Business
Intelligence
SQL Server 2016 Standard/Enterprise/Business
Intelligence
SQL Server 2017 Standard/Enterprise/Business
Intelligence

Virtual environment***

VMWareWorkstation 10
VMWare ESX1 6.0
Oracle Virtual Box 5.0.4
Microsoft Hyper-V fromWindows 8.1, Windows Server
2012
Citrix XenServer 6.2
Parallels Desktop 10
QEMU-KVM

Microsoft Excel Microsoft Excel 2010, 2013, 2016

DesktopWeb browser

Microsoft Internet Explorer 11
Microsoft Edge
Google Chrome version 42 and later
Mozilla Firefox version 35 and later
Apple Safari versions 7 or 8 and later

MobileWeb browser
Safari on iOS8.3+ operating systems, Chrome on Android
systems

.NET Framework
4.6 for PME
3.5 (or 3.5 SP1) for the PME installer
4.0 for the PowerMonitoring Expert licensing component

** PME includes a free version of SQL Server Express. You have the option to install this Express
version during the installation of PME, if you don't want to use a different SQL Server.

*** Youmust configure virtual environments with a supportedWindows operating system and SQL
Server edition. It is possible to mix virtual and non-virtual environments for PME server and clients.

Solution Guide Design
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NOTE: Apply the latest updates to the OS and SQL Server before installing or upgrading PME.

NOTE: PME can be installed in a domain environment. However, it cannot be installed on a
computer that is a domain controllers. If PME is installed on a server that is subsequently changed
to a domain controller, the software ceases to function correctly.

Building Operation

Refer toEcoStruxure™Building Operation Information Technology System Planning Guide for
supported operating systems and SQL Server versions.

Integration requirements

l For deployments where Building Operation and PME are installed on the same server, the oper-
ating environment must be supported by both systems.

l The following browsers are supported when using PMEWeb Applications in Building Operation
WebStation:

Microsoft Internet Explorer 11

Google Chrome

Mozilla Firefox

l Installing PME and Building Operation Report Server on same computer is NOT supported.

l Sharing SQL Server between PME and Building Operation Report Server is NOT supported.

Port Settings

Building Operation

The Enterprise Server uses HTTP and TCP protocols to communicate with other servers and
clients. In the Software Administrator, you configure the port number of each protocol the Enterprise
Server listens to when communicating through a specific protocol. Refer to theEcoStruxure™
Building Operation Information Technology System Planning Guide for a full list of required open
ports.

PME

See PME IP Port Requirements for more information.

Changing Port Settings

Building Operation and PME both use the sameHTTP (80) and HTTPS (443) ports by default. If you
install Enterprise Server and PME on the same computer, youmust change these ports for Building
Operation to avoid a port conflict.

For example, use 8080 and 446 as shown below:



Therefore, during the design phase, the IT policy needs to be checked tomake sure this is
acceptable. If it is not, PME and the Enterprise Server should not be installed on the same
computer, and should instead be installed on separate servers.

Solution Guide Design
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2. Computer hardware
PME

Choosing Computer Type, CPU, and RAM

The computer type, CPU, and RAM determine the overall performance and reliability of the system.
CPU is important for device communications and RAM affects SQL Server performance.

As a starting point for the selection of these components, we are defining two different system
categories, Basic Systems andAdvanced Systems. Decide which category best describes your
system needs and then use the information provided in the tables below to define your computer
hardware specifications.

Basic Systems
A basic system is defined by the following characteristics:

l Factory default measurement logging (logging frequency >= 15minutes)

l No custom applications

l NoPower Quality Performancemonitoring

l Only a small number of branch circuit monitor devices in the system

l A device typemix of approximately:

70% entry level devices (for example iEM3xxx)

20% intermediate level devices (for example PM8xxx)

10% advanced level devices (for example ION9000)

Minimum recommended computer hardware for servers in Basic Systems:

System Size Devices Users Computer hardware

Small ≤ 100 ≤ 5
Desktop
Intel Core i5 (2 core)
8 GB (RAM)

Medium

≤ 250 ≤ 10
Workstation
Intel XeonW-21xx (4 core)
16GB (RAM)

≤ 600 ≤ 10
Server
Intel Xeon E3-12xx (6 core)
24GB (RAM)

Large ≤ 2500 ≤ 10
Server
Intel Xeon E3-12xx (10 core)
32GB (RAM)

Advanced Systems
An advanced system is defined by the following characteristics:

l Custommeasurement logging with <15minute intervals

l Custom applications using the VIP module



l Power Quality Performancemonitoring

l Large number of concurrent users

l High percentage of advanced level devices in the system

l Large number of branch circuit monitor devices in the system

l Large scale data exchange with third party systems (for example throughOPC or EWS)

l Other resource intensive software systems installed on the same computer

Minimum recommended computer hardware for servers in Advanced Systems:

System Size Devices Users OPC Tags HW

Small ≤ 100 ≤ 15 5000
Workstation
Intel XeonW-21xx (4 core)
16GB (RAM)

Medium

≤ 250 ≤ 20 10000
Server
Intel Xeon E- 12xx (6 core)
24GB (RAM)

≤ 600 ≤ 35 30000
Server
Intel Xeon E3-12xx (10 core)
32GB (RAM)

Large ≤ 2500 ≤ 50 50000

Server
Intel Xeon Scalable Silver (12
core)
64GB (RAM)

Choosing Hard Disk Drives (HDDs)

The HDDs determine the historical data access performance and the amount of historical data that
can be stored in the system. HDD configurations are also important for system availability and
recovery.

HDD Size

The HDD must have enough space for the different programs and applications that are running on
the computer. This includes space for the historical data that is recorded by the system and some
free space as a buffer.

The following table shows the estimated HDD space that is required, without the historical data
logs. The estimates are rounded up and allow for updates and systemmaintenance.

Component HDD space
Windows Operating System software 100GB
Microsoft SQL Server software 2GB
PME software 5GB
PME system databases 5GB
PME historical database (see below)
Free space 30% of the HDD size

Solution Guide Design
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PME historical database

The HDD space that is required for the historical database (ION_Data), is equal to five times the
size of themain database file (ION_data.mdf).

It can be broken down into the following components:

Component HDD space
Main database
file (.mdf)

(1x) ION_data.mdf size

Transaction log
file (.ldf)

(1x) ION_data.mdf size

Backups (2x) ION_data.mdf size
Free Space for
Backups or
tempDB

(1x) ION_data.mdf size

Total (5x) ION_data.mdf size

The estimates above are based on the following assumptions:

l The .ldf file is typically just 10% of the .mdf size, but occasionally expands to 100% during nor-
mal operation.

l The system default is to keep two database backups.

l 100% of the .mdf size is required for free space. The tempDB will occasionally expand to 100%
of the total .mdf size, but not at the same time as a backup. If the backups and tempDB are on
different hard drive groups, they each require x1 .mdf in hard drive space.

Main Database File Size (ION_data.mdf)

Unlike the system software, the historical database size is continuously growing. Its size and
growth can be estimated based on the amount of:

l Factory default measurement logging

l Custommeasurement logging

l Power quality event logging

Also, the database occasionally grows by 10% to create room for additional measurements. This
growth operation can occur at any time and you need to consider it in the database size
calculations.

NOTE: Use the DatabaseGrowth Calculator tool to estimate the database growth for your
system. The tool is available through the Exchange Community. See Resources for link
information.



HDD Configuration

HDDs can be configured as single drives or drive groups. For a small Basic Systems, a single HDD
is sufficient. For all other systems, we recommend that you separate themajor components into
different HDD groups.

RAID Systems

In addition to separating the software components into different hard drive groups, redundant arrays
(RAID) can be used to add simple redundancy. In a RAID 1 configuration, one HDD is a complete
copy of a second HDD. If either of the two HDDs stops operating, the other takes over without any
data loss. The faulty HDD can then be replaced to restore the RAID configuration.

Recommended RAID 1 configurations:

2x HDD

Component
Group 0

HDD1 + HDD2
OS ü

tempDB ü

MDF ü

LDF ü

Backups ü

4x HDD

Component
Group 0 Group 1

HDD1 + HDD2 HDD3 + HDD4
OS ü

tempDB ü

MDF ü

LDF ü

Backups ü

6x HDD

Component
Group 0 Group 1 Group 2

HDD1 + HDD2 HDD3 + HDD4 HDD5 + HDD6
OS ü

tempDB ü

MDF ü

LDF ü

Backups ü

Solution Guide Design
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6x HDD

Component
Group 0 Group 1 Group 2 Group 3
HDD1 +
HDD2

HDD3 HDD4 + HDD5 HDD6

OS ü

tempDB ü

MDF ü

LDF ü

Backups ü

8x HDD

Component Group 0 Group 1 Group 2 Group 3
HDD1 +
HDD2

HDD3 +
HDD4

HDD5 + HDD6
HDD7 +
HDD8

OS ü

tempDB ü

MDF ü

LDF ü

Backups ü

NOTE: Plan for system growth by having a computer with space for additional HDDs. This makes
it easy to add additional HDDs as the system grows.

NOTE: It is possible to use other RAID configurations, such as RAID 0 or RAID 5. These
configurations are not discussed in this document.

Building Operation
For information on Building Operation hardware specifications, see the IT System Planning Guide -
EcoStruxure BuildingManagement.

PME and Building Operation on the same computer

CPU and RAM

As a general guideline, we recommend that you use the PME Advanced Systems hardware
specifications for systems based on Architecture 2 where the PME and Building Operation software
is installed on the same server.

HDD

To install PME and Building Operation on the same server, add 2GB to the required PME HDD
space for the Building Operation application and additional space for historical data in Building
Operation.



3. Solution architectures
The Energy Expert solution supports the following integration architectures.

WARNING
UNINTENDED EQUIPMENT OPERATION
• Do not use the software or devices for critical control or protection applications where human
or equipment safety relies on the operation of the control action.

• Do not use the software to control time-critical functions.
• Do not use the software to control remote equipment without proper access control and status
feedback.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

WARNING
INACCURATE DATA RESULTS
• Do not incorrectly configure the software or the devices.
• Do not base your maintenance or service actions solely onmessages and information
displayed by the software.

• Do not rely solely on softwaremessages and reports to determine if the system is functioning
correctly or meeting all applicable standards and requirements.

• Consider the implications of unanticipated transmission delays or failures of communications
links.

Failure to follow these instructions can result in death, serious injury, equipment
damage, or permanent loss of data.

Architecture 1 – Devices Connected to Building Operation
l Power devices are connected to Building Operation (Automation Server or Enterprise Server).

l Logging of historical data is done by Building Operation (Automation Server or Enterprise
Server).

l Historical data (Trend Logs), for display in Dashboards and Reports, is copied from Building
Operation to PME using the ETL.

NOTE: (Optional) Historical data for simple trending can be displayed directly through Building
Operation Trend objects.

l PME serves up historical data views in its Web Applications (Dashboards, Reports) to Building
Operation through its securedWeb Server.

Solution Guide Design
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Architecture 2 – Devices Connected to PME
l Power devices are connected to PME.

l Logging of historical data is done by PME.

NOTE: (Optional) Historical data for simple trending can be copied to Building Operation via
EWS, and displayed through Trend objects.

l Real-time data and alarm data are provided to Building Operation via EWS

l PME serves up historical data views in its Web Applications (Dashboards, Reports) to Building
Operation through its securedWeb Server

NOTE: Hybrid versions of the architectures are possible, to meet specific application needs.

The following diagram shows an integrated view of both architectures:

Real-time Data Flow
Regardless of how the data is collected, directly by Building Operation or by PME, it will be viewed
by the user in Building Operation user interface.

Architecture 1

Building Operation collects the real-time data from the devices through an Automation Server or
Enterprise Server.



Architecture 2

PME collects the real-time data and provides it to Building Operation through EWS.

Alarms Data Flow
All alarm datamust end up in the Building Operation database, whether the alarms are triggered in
Building Operation or PME.

In Architecture 1, all alarm data is logged directly to the Building Operation database. Youmust
configure power alarms in Building Operation, manually, or through existing alarms in the
SmartWidget.

In Architecture 2, power alarm data is first logged to the PME database and then copied to the
Building Operation database using EWS. . Youmust configure device based or software based
power alarms in PME.

Historical Data Flow

Historical Data for Simple Trending in Building Operation

You can use the Building Operation Trend objects for displaying simple trend data. In this case, any
historical data collected in PME, that is to be displayed in Building Operation, needs to be copied to
Building Operation.

NOTE: This does not involve PME Dashboards or Reports.

Architecture 1

Building Operation collects the historical data directly.

Architecture 2

PME collects the historical data and copies it to Building Operation via EWS.

NOTE: The data transfer interval can be set to the PME logging interval, for example 15minutes,
or to a longer interval, such as once per day, to transfer a larger set of data per connection.

Historical Data for Dashboards and Reports

For complex historical data and larger data sets, use the PME Dashboards and Reports
applications for displaying the data. In this case, any historical data in Building Operation that is to
be displayed in a dashboard or report needs to be copied to PME, using the ETL tool.

Architecture 1

Building Operation collects the historical data and copies it to PME, using the ETL tool.

Architecture 2

PME collects the historical data directly.

Solution Guide Design
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4. Guidance on choosing an architecture
There are a number of factors to consider when choosing whether to use Architecture 1,
Architecture 2, or a combination of the two. The key factors to consider are:

l Data collection

l User experience

l Commissioning time

l IT considerations

NOTE: Hybrid versions of the architectures are possible, to meet specific application needs.

Data Collection
To decide which architecture is best for data collection, consider the following:

A. Device type of the powermonitoring devices

B. Number of registers to be requested

C. Device location

A. Device Type

Which types of power devices are used in the system is themost important aspect to consider
when selecting an architecture.

Use the flow chart below to help you with the decisionmaking process:



Descriptions:

SE (Schneider Electric) device

Most of the SE meters and circuit breakers are supported in PME by default. In addition, a large
number of add-on device drivers for PME can be downloaded from the Exchange community. For
those device types that are not supported by existing drivers, you can create custom drivers with
tools provided by PME. The commissioning time is reduced when there are pre-existing drivers for
your device types in PME.

Building Operation has SmartWidgets for some of the SE power devices. For those device types
that are not supported, youmust perform manual mapping in order to communicate to the device.
The commissioning time is reduced when there is a SmartWidget for your device.

NOTE: If the device uses a protocol other thanModbus, further investigation on gateways might
be needed before choosing a communication architecture.

ION meter

ION meters use ION protocol, which is supported by PME but not by Building Operation. Therefore,
it is required to connect thesemeters to PME (à Architecture 2).
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NOTE: Most of the ION meters also support Modbus protocol. However, advanced functions,
such as waveforms, on-board logging or on-board alarms, are not available throughModbus
communication. Therefore, connecting an ION meter throughModbus is not recommended.

Multi-address device

A Multi-address device is aModbus device that has multiple Modbus IDs, such as theMasterpact.
Multi-address devices are supported in PME but not in Building Operation. In Building Operation,
multiple Modbus devices need to be created for eachmulti-address device, because each Building
Operation device can only have oneModbus ID. This increases the complexity of the system tree
structure and requires more commissioning time and effort as compared to PME (à Architecture 2).

PQ (Power Quality) functions

If the devices have PQ functions and you want to make use of these functions, Architecture 2 is
recommended because PME provides access to events, waveforms, reports, and all other power
quality related information (à Architecture 2).

On-board logging

If the devices have on-board logging functions, Architecture 2 is recommended because PME can
retrieve the on-board logs instead of doing software based logging, like Building Operation(à
Architecture 2).

NOTE: On-board data logging is typically more reliable andmore accurate than software based
logging.

On-board alarming

If the devices have on-board alarming functions, Architecture 2 is recommended because PME can
retrieve the on-board alarms instead of monitoring the values and generating alarms in the software,
like Building Operation(à Architecture 2).

NOTE: On-board alarming is typically more reliable andmore accurate than software based
alarming, which is particularly important for power failure root cause analysis.

Conclusion:

For many applications, Architecture 2 is the better choice with regards to powermonitoring device
types. However, when only low-end powermeters, energy meters, or pulsemeters are used, there
is no difference between the two architectures.

B. Number of Registers to be Requested

If only kWh and a few powermeasurements are needed from a device, then either Architecture 2 or
Architecture 1 can be used, as long as the existing Automation Server can handle theModbus serial
loop communication of the power devices.

However, if many measurements are needed for each power device, we recommend you use
Architecture 2 to keep communication of the power devices separated from the building automation
devices.



C. Device Location

Consider the device location and communication network layout when choosing an architecture. If
all power devices are located together in the electrical room, then we recommend you use
communication gateways, such as the EGX, to connect them with dedicated daisy chains.
However, when a limited number of devices is located close to an Automation Server, it might be to
connect them directly to that server.

TIP: Since you can always combine the two architectures, choose themost convenient way to
connect to the devices.

User experience
The user experience differs between the two architectures in two ways:

l The types of graphics available to display real-time power device data

l The update rate for real-time values

Graphics for Power Devices

Architecture 1

Real-time data is collected and displayed directly by Building Operation. If there is a SmartWidget
available for a device type in Building Operation, users can use the pre-built graphics in the
SmartWidget. If there is no SmartWidget for the device, users must build their own graphics based
on their needs.

Architecture 2

Real-time data is collected by PME and then transferred to Building Operation through EWS. This
real-time data can then be displayed in the sameway as in Architecture 1.

However, it is also possible to use the native PME diagrams to display the data, and then integrated
the diagrams into Building Operation through the PMEWeb Applications. This provides muchmore
detailed electrical views with more electrical information.
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Here is an example of a PME diagram with real-time data:

Unlike Building Operation, PME has native support for many types of power devices. Using the
diagrams in PME provides electrical views with more detailed information, reducing commissioning
time. However, for simple power devices with only a few registers, the extended diagrams from
PME become less valuable.

NOTE: If a device type is not natively supported by PME, additional commissioning time is
needed for creating a custom device type and diagrams.

Update Rate for Real-time Values

The number of communication layers the real-time values have to go through, in each polling cycle,
differs between the two architectures. This can affect the real-time data update rate in the user
interface.

Architecture 1

In Architecture 1, Building Operation polls the devices directly. The update rate of the real-time
values in the user interface depends on the following:

l Serial communication speed

l Number of devices in the serial loop and number of registers to be requested

l Capability of the Automation Server or Enterprise Server and its load

Architecture 2

In Architecture 2, PME polls the devices directly and then transfers the data to Building Operation
through EWS. The update rate of the real-time value in user interface depends on the following:

l Update rate for EWS communication

l Serial communication speed

l Number of devices in the serial loop and numbers of registers to be requested



l Capability of the PME server

l Bandwidth allocation between real-time and log retrieving of PME

Because of the added communication layers, and the available real-time data bandwidth in PME,
the update rate for a real-time value for architecture 2 is typically slower than Architecture 1. Refer
to 5. Communications and data transfer for more information.

Conclusion

If the real-time update rate is your top priority and only a small number of registers are needed,
choose Architecture 1. Otherwise, choose Architecture 2 tomake use of all the functions of your
power devices.

Commissioning time
The engineering time required for the integration varies for different architectures. See the 6.
Commissioning time section for details.

IT Considerations
The server recommendations are different for Architecture 1 and Architecture 2. See 2. Computer
hardware for more information.
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5. Communications and data transfer
System communication design varies significantly between Architecture 1 and Architecture 2.

Architecture 1

Device Communications

In Architecture 1, device communications is handled by Building Operation (Enterprise Server,
Automation Server, or any other BMS field-level devices).

Refer to theArchitectural Guidelines 2.0.1 - EcoStruxure BuildingManagement document and
relevant device documentation for more communication design information.

Logging Data in Building Operation

In Architecture 1, historical data is collected in TrendLogs. TrendLogs can be fed by any Building
Operation variables, including BACnet, LON, XML, or Modbus Point.

NOTE: When logging data in Building Operation, it is recommended to use interval trend log to log
the raw data frommeters. The cumulative raw data is then inserted into the PME database by the
ETL tool. PME Dashboards and Reports have an aggregationmechanism tomake use of the data.
Hourly, daily, andmonthly usage does not need to be calculated in Building Operation for PME
use.

If both Trendlog and Extended Trendlog are used, it is recommended to send the data in the
Trendlog to PME (via ETL) to avoid the lagging between Extended Trendlog and Trendlog.

It is recommended to plan the variables to be logged during the design phase so that the size of the
Trendlog files can be forecast. Also, it is important to plan which Trendlogs are to be transferred to
PME in order to forecast the size and growth of the database.

ETL Jobs

An ETL job is a set of task definitions that the ETL engine follows in order to Extract, Transform, and
Load data from one data source to another. An ETL job contains an extract task to pull the data, a
transform task tomanipulate the data, and a load task that applies the data to the new location.

After the job is set up, you can set the job to run as a service. When set to run as a service, a job
automatically runs at set times based on the settings you input in the Job tab. The Sleep Time
Between Execution value (in seconds) allows you to define the frequency with a default value of
3600 seconds. The value defines when new data can be displayed in the Dashboards and Reports.
You can use a smaller value if you want the job to runmore frequently. For meter interval data, 900



seconds is usually fast enough for the updates. When increasing this value, consider the Building
Operation Trendlog size tomake sure it can be covered before being overwritten in order to prevent
missing TrendLogs.

ETL does not use any of the PME processes, so this has little impact on PME performance while
loading. SQL supports multi-threading and will serve both ETL and PME needs. If SQL is
overloaded, the data buffer handles it.

Architecture 2

Real-time Communication

The following flow chart shows the detail of the real-time data flow in PME when integrating with
Building Operation under Architecture 2.

EWS Communication

There are two configurable settings that control the EWS communication and that you can use to
optimize system performance: Value Poll Interval, in Building Operation, andReal-time Refresh
Rate, in PME.

Value Poll Interval

In the Building Operation EWS Interface, you can configure the Value Poll Interval, which defines
the frequency of the EWS polling, for real-time values. The default value is 20 seconds.
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Real-time Refresh Rate

In the PME EWS server web.config file, in ...\Power Monitoring

Expert\applications\EWS, you can set the Real-time Refresh Rate. This setting controls how
often the PME EWS server updates the real-time data it serves up. The default Real-time Refresh
Rate setting is 30 seconds.

Default set of EWS web.config file settings in PME:

<appSettings>

<add key="ServiceInventoryEndpoint"

value="http://STANDALONE:23102/CoreServicesHost/Inventory/InventoryService" />

<add key="EWSRealTimeTimeout" value="45" />

<add key="ServiceLocation" value="EWS Services" />

<add key="DigestAuthenticationModule_Realm" value="DataExchangeService" />

<add key="AllowMD5DigestHash" value="1" />

<add key="EWSEnabled" value="1" />

<add key="ContainerItemStructure" value="0" />

<add key="NaNValue" value="" />

<add key="ConcatSourceAlarmEventId" value="1" />

<add key="RealTimeRefreshRate" value="30" />

<add key="RealTimeSessions" value="10" />

<add key="InternalStructureCacheTimeInSeconds" value="120" />

<add key="NumberOfDaysBackToInclude" value="10" />

<add key="InvalidAlarmTypes" value="ALM_CONTROL_EVENT,ALM_LOOSE_DROPOUT,ALM_

GENERIC_EVENT,ALM_CLOCK" />

</appSettings>



Communication Performance

The following shows the results of an EWS server performance test in PME:

NOTE: This test was performed on an earlier version of the Energy Expert solution, called Power
Manager at that time.

Computer Type:Server
OS:Windows Server 2012 R2
SQL: 2012 Standard SP1
CPU: x2 Intel Xeon E56xx (4 core)
RAM: 24GB
HDD: x6 300GB
Software:Building Operation 1.6 + PowerManager 1.0

Number of
Devices

Number of Tags per
Device

Total Number of
tags

Average Response Time
(s)

5 1 5 < 1
5 4 20 < 1
5 10 50 1.25

500 1 500 3
500 4 2000 6
500 10 5000 13.5
1500 1 1500 5.75
1500 4 6000 18
2000 1 2500 6.5

NOTE: The EWS response time is independent of themeasurement and device type, as long as
the number of measurements, and the number of devices they were distributed across, remains
the same.
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The chart below shows a graphical representation of the EWS response time vs. Number of tags in
an EWS request:

As discussed previously, the EWS request is sent from Building Operation only when there is a
need, for example a graphic is open. Therefore, typically an EWS request from Building Operation to
PME contains less than 1000 tags. For example, if 100 devices are shown in one graphic, and each
has four bound values, then an EWS request for the 400 values (tags) is sent to the PME EWS
Server when the graphic is opened in Building Operation. In case, based on the above test results,
the EWS response time is about three seconds. This provides plenty of buffer time with a 20 second
value polling setting in Building Operation as the default.

NOTE: Consider the impact on other parts of the Building Operation system, when tuning the
polling rate to achieve faster refresh.

Alarm Communication

In Architecture 1, alarms are created in Building Operation, Automation Server or Enterprise Server.

In Architecture 2, technically the alarms can be created in both systems, PME or Building
Operation. So a proper design of the alarm generation logic and communication is important for a
successful solution.

PME Alarms

PME alarm data is transferred to Building Operation using EWS. It is important to understand the
two possible sources of an alarm in the PME system:

l On-board alarm –Generated and logged in the device (meter, circuit breaker, and so on)

l Software based alarm –Generated by the PME software, and logged in the computer cache.



On-board Alarms

For critical alarms, such as circuit breaker trips, power outage, or over current, try to use the device
on-board alarms in circuit breakers or meters because this is the core function of the power devices
– to detect a failure and log it with a time stamp. Even for a non-critical alarm, on-board alarms are
recommended to use to gain higher system reliability and also tomake use of the device
functionality.

Software based Alarms

If the device does not have on-board alarming, or additional alarms need to be created, it is
recommended to create the alarm in PME, with the Alarm Configuration tool, rather than create an
alarm in Building Operation based on real-time values read via EWS.

NOTE: VIP alarms are not exposed through EWS.

EWS Alarm Communication

The following flow chart shows the details of the alarm data flow in PME when integrating with
Building Operation under Architecture 2.

PME alarms are polled only if the Alarm Polling is enabled for the EWS interface in Building
Operation.
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A filter can be configured to poll only the alarms that are needed.

The priority of an alarm or event can be configured in the PME system. The typical PME alarm
priority categorization is:

l High priority alarm: 193 - 255

l Med priority alarm: 128 - 192

l Low priority alarm: 64 -127

l Information: 0 - 63.

NOTE: The PME EWS server exposes only alarms with a priority between 64 and 255 (not
configurable).

When a user acknowledges EWS alarms in Building Operation, the corresponding alarms in the
PME system are also acknowledged automatically.

Performance: Alarm Latency

With the default software settings, an on-board alarm event is expected to be seen, in Building
Operation within 90s on average. The settings can be tuned to achieve faster performance. Using
the same concept, for a software based alarm, the latency depends on the Building Operation EWS
polling rate and the alarm polling rate defined for the alarm.

NOTE: Consider the impact on other parts of the system, such as the real-time data performance
when tuning the polling rate to achieve a faster alarm refresh rate.

Best Practice for Using EWS Alarms in Building Operation

When choosing Architecture 2, it is not recommended to create Building Operation alarms based on
real-time values read via EWS. For real-time values, EWS communication only takes place when
there is a need, for instance, a graphic is opened by the user. In contrast, if an alarm is created
based on an EWS tag, then the EWS real-time subscription for this value will be constantly active.



However, in Building Operation, the EWS alarm object is not as same as a regular alarm objects. If
there are requirements for consistent alarm messages, alarm priority, and user action associations,
which EWS alarms may not meet, it is recommended to use the Building OperationSum Alarm
function to create a new alarm on top of one or more EWS alarms. Then the newly created Building
Operation alarm can bemanaged consistently with other Building Operation alarms. Refer to
Building Operation online help for more information about the Sum Alarm function.
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6. Commissioning time
The engineering time required for the integration varies for different architectures. Typically, it is
faster to deploy Architecture 2 than Architecture 1 for the following reasons:

l When the power devices are supported by PME, it is faster to configure the devices in
Architecture 2 than in Architecture 1, even when there are SmartWidgets available in Building
Operation. When no SmartWidgets are available, the time for creating theModbus map in Build-
ing Operation can be considerable.

l Configuring the ETL to setup the historical data transfer from Building Operation to PME, which
is required for Architecture 1, can add considerable deployment time.

Architecture 1
Below are commissioning time estimates for Energy Expert solutions based on Architecture 1:

Architecture 1 Configuration Workflow
Average
Time
(min)

Standard
Deviation
(min)

1

Installing and licensing Building Operation *

16.7 1.5

1.1 Installing and licensing License Server
1.2 Installing Enterprise Server
1.3 InstallingWorkstation

1.4
InstallingBuilding OperationConnector
components, snippets, and binding template

1.5
Single-server install only: Changing Building
Operation ports

2

Installing and licensing PME *

54.7 18.4
2.1 Installing PME
2.2 Activating PME licenses
2.3 Single-server install only: Changing PME ports

3

Configure the devices in Building Operation with
SmartWidgets

81.7 36.6

3.1 ConfiguringModbus Master Interface
3.2 Importing SmartWidgets
3.3 Modifying SmartWidgets graphic
3.4 Creating trend logs for SmartWidgets
3.5 Copy, paste and edit to have the full system

4

ETL

40.3 30.3

4.1 Installing ETL
4.2 Creating ETL job
4.3 Adding and configuring the tasks
4.4 Configuring themapping
4.5 Run job once and then register as a service



5

Integration Utility and Building Operation Import

12.7 15
5.1

Setting up the two tabs with "Reports Home
Link" and "Dashboards Home Link"

5.2 Exporting the XML
5.3 Importing the XML

6
Setting up Dashboards and Reports *

39.7 21.16.1 Configuring Dashboards
6.2 Configuring Reports

7
Setting up Graphics *

141.7 40.87.1 Setting up Electrical One Line Diagram
7.2 Setting up System Network Health screen

Total 387.3 116.9

* These steps are identical for both architectures. The timing differences are due to different speed
of different validators.

Architecture 2
Below are commissioning time estimates for Energy Expert solutions based on Architecture 2:

Architecture 2 Configuration Workflow
Average
Time
(min)

Standard
Deviation
(min)

1

Installing and licensing Building Operation *

14.0 6.1

1.1 Installing and licensing License Server
1.2 Installing Enterprise Server
1.3 InstallingWorkstation

1.4
Installing Building Operation Connector components,
snippets, and binding template

1.5
Single-server install only: Changing Building Operation
ports

2

Installing and licensing PME *

41.0 8.2
2.1 Installing PME
2.2 Activating PME licenses
2.3 Single-server install only: Changing PME ports

3

Configure the devices in PME

23.0 9.0
3.1 Adding Devices in PME
3.2 Generating a Vista Network Diagram
3.3 Update EWS Server
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4

Integration Utility and Building Operation Import

15.3 7.8
4.1

Setting up the four tabs with " All Device Diagram
Links", "Reports Home Link", "Dashboards Home
Link", "EWS Link & All Measurements"

4.2 Exporting the XML
4.3 Importing the XML

5
Setting up Dashboards and Reports *

29.7 85.1 Configuring Dashboards
5.2 Configuring Reports

6
Setting up Graphics *

138.7 27.76.1 Setting up Electrical One Line Diagram
6.2 Setting up System Network Health screen

Total 261.7 66.8

* These steps are identical for both architectures. The timing differences are due to different speed
of different validators.

Estimation Guidelines
Below are guidelines for estimating the engineering time required to set up the key components of
an Energy Expert solution.

Software Installation

The installation and licensing of the solution does not vary based on the size of the system.

Device Configuration

The time required to configure the devices varies greatly based on the device types and their native
support in the system. Do not simply multiply the amount of time provided in our commissioning
time estimates by the number of devices in your system. Use the estimates only as a general
guideline for the engineering time that might be required.

ETL

Configuring the ETL to setup the historical data transfer from Building Operation to PME is an
additional task for Architecture 1, which takes a considerable amount of time. The required effort
depends on the number of devices, device types, and the number of logs andmeasurement types.
The use of batch editing, when configuring theMapping in the ETL, can significantly reduce the
configuration time.

Integration Utility

The time it takes to integrate PME and Building Operation by using the Integration Utility does not
vary based on the size of the system. The exception being the following:

l The time it takes to populate the list under the EWS tab will vary somewhat based on size of the
system.

l The export and import in Building Operation takes slightly longer for larger systems.



Setting up Dashboards and Reports

The time for setting up Dashboards and Reports is determined by the customer needs. The
reference system used for estimation covers basic Dashboards and Reports for the power
management of a building.

Setting up Graphics

For the graphics configuration (Electrical Network Graphics) the time recorded was the time to build
them from scratch. The default Electric One Line Diagram ANSI/IEC and default Electrical Health
Summary Screen is part of the reference system package. Time can be saved by modifying the
default diagrams rather than building them from scratch.
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Installing
Installing the Energy Expert solution includes the following steps:

1. Downloading the Energy Expert Toolkit

2. Installing Building Operation

3. Installing components, snippets, and binding template

4. Installing PME

5. Installing ETL (only for Architecture 1 solutions)

NOTE: Steps 1 - 4 are required for both solution architectures.

See the following sections for details.
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1. Downloading the Energy Expert Toolkit
The Energy Expert Toolkit is used to integrate PME into Building OperationWorkStation.

The Toolkit contains:

l Building Operation components, snippets, and binding template

l Integration Utility

l ETL

To get the toolkit, download the Energy Expert Tools.zip file from the Exchange Extranet
(see Resources for link information). Extract the files in the zip archive to the location on the
Building Operation server, where you want to run the tools.



2. Installing Building Operation
The following describes the installation and licensing of Building Operation. Refer to the
“Installation” section in theEcoStruxure Building Operation IT ReferenceGuide for more
information.

To install Building Operation

1. Install License Administrator.

a. When the License Administrator installation wizard prompts, include the License Admin-
istrator and License Server components.

b. Open License Administrator and activate the licenses.

NOTICE
LOSS OF COMMUNICATION
• Activate product and component licenses prior to the expiry of the trial license.
• Activate sufficient licenses for the servers and devices in your system.

Failure to follow these instructions can result in loss of data.

2. Install Enterprise Server.

3. Install Workstation.

Changing Building Operation port settings (for single server installation only)

If Building Operation and PME are installed on the same server, youmust change the ports used by
Building Operation through the Software Administrator in order to avoid conflicts between Building
Operation and PME. The default ports of 80 and 443 are reserved for PME.

To change the Building Operation server ports:

1. Open Software Administrator.

2. Click Stop Service if the service is currently running.

3. Under Communication Ports, change the values for the server ports, for example change the
HTTP Port to 8080 and the HTTPS Port to 446.

NOTE: For the HTTP server port, do not use the value 80, and for the HTTPS server port, do
not use the value 443—these values are reserved for PME.
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4. Click Start Service, allow time for the service to start, and then click OK to exit.

After you changed the server port settings, youmust modify the Building OperationWorkstation
login.

Tomodify the Building OperationWorkstation login:

1. OpenWorkstation.

2. Add ":446" (the HTTPS port defined above) to the server information. For example, if your
server name is "Standalone", make it appear as "Standalone:446".

3. Provide your user name and password credentials and click Log on.



3. Installing the components, snippets, and binding template
Install the components, snippets, and the binding template into Building Operation.

Components are standardized, predefined graphics that represent features in a live system. They
are located in dedicated libraries, and are displayed in the Components pane. You add components
to a graphic instead of drawing all the drawing objects yourself to simplify the graphics creation
process.

Snippets are standardized, predefined functions that typically represent a feature in a live system.
They are located in dedicated libraries, and are displayed in the Snippets pane.

The binding template is used to automatically bind EcoStruxureWeb Services (EWS)
measurements or SmartWidget values to correspondingmeasurements in Building Operation
graphics library objects. Using the binding template, you create bindings between the Automation
Server program variables, internal values, and I/O points.

NOTE: Before you install these tools, close the Building Operation Graphics Editor.

Installing Components and Snippets
1. In File Explorer, navigate to where you extracted the Energy Expert Toolkit.

2. Navigate to theEnergy Expert Tools > EBO Components for Energy Expert > Graphics
Editor > Components folder.

3. Double-click each file in the Components folder. The components (ANSI Symbols, Generic
Components, IEC Symbols, andMeter Graphics) are installed in the Graphics Editor and
appear in the Components pane at the left.

4. Navigate to theEnergy Expert Tools > EBO Components for Energy Expert > Graphics
Editor > Snippets folder.

5. Double-click the file in the Snippets folder. The snippets are installed and appear in the Snip-
pets pane at the left.

Importing the Binding Template
1. Log on toWorkStation.

2. In the System Tree, expandServer > System.

3. Right-click Binding Templates and select Import from the list. TheOpen dialog appears.

4. Navigate toEnergy Expert Tools > EBO Components for Energy Expert > WorkStation
and select PowerManager - Binding Template.xml.

5. Click Open. The Import dialog appears.

6. Click Import.

7. Click Closewhen the import is complete.
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4. Installing PME
The following describes the installation and licensing of PME.

NOTE:
If possible, log on to yourWindows system using the built-in local Administrator account for
installing PME. If that is not possible, use an account that is amember of the Administrators
group. Permissions for the Administrators group can be restricted by system policies whichmight
affect the PME installation. The built-in Administrator account does not have such limitations.

Starting with Microsoft Windows 10 andWindows Server 2016, the Administrator account cannot
be used for software installation. For these operating systems use an account that is amember of
the Administrators group

Installing the PME software
To install the PME software:

1. Insert the Energy Expert DVD ormount the Energy Expert ISO. Double-click MainSetup.exe
to begin the installation. The installation dialog appears.

2. Select a language from the drop down list, and click Next. Follow the install pages and instruc-
tions until you get to the Setup Type page.

3. For Setup Type, select Standalone Server. The other Setup Types are not supported for
Energy Expert. Click Next.

4. Follow the install pages and instructions, using the default settings where possible, until you
get to the Supervisor Account page.

5. For the Supervisor Account, set a strong password for the supervisor user containing at least
8 characters. Click Next.

6. Follow the install pages and instructions, using the default settings where possible, until you
have completed the installation.

7. Click Closewhen the installation is complete.

For more details on installing PME, see theEcoStruxure™PowerMonitoring Expert 9.0 System
Guide.

Activating the Energy Expert licenses for PME
The PME software that is part of the Energy Expert solution, includes a 90-day Energy Expert Trial
license for all Energy Expert features. Youmust activate valid, purchased licenses for Energy
Expert within 90 days, or some software functionality is disabled.

NOTICE
LOSS OF COMMUNICATION
• Activate product and component licenses prior to the expiry of the trial license.
• Activate sufficient licenses for the servers and devices in your system.

Failure to follow these instructions can result in loss of data.



To activate the licenses:

1. On the PME server, open the Floating LicenseManager.

2. Click Activate to open the License Activation dialog.

3. Enter the Activation IDs that you received with Energy Expert (for example, device licenses,
optional softwaremodules, and so on). Accept the default settings and click Next to activate
the licenses.

4. When the license activation process finishes, click Finish. The licenses appear in the Float-
ing LicenseManager.
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5. Open the PME Management Console and login with the supervisor account to confirm that the
license is working.

6. Click Help > About to display information about your Energy Expert licenses.

NOTE: Device licenses are required for all the devices connected to PME under Architecture
2. The Energy Expert Trial license for PME includes unlimited device license for the first 90
days.

For further instructions on the purchase and activation of licenses, see theEcoStruxure™Power
Monitoring Expert 9.0 System Guide.



5. Installing ETL (only for Architecture 1 solutions)
The ETL is only used with Architecture 1, where it copies historical data from Building Operation to
PME.The ETL installer is included in the Energy Expert Toolkit.

NOTE: OnWindows Operating Systems with restricted permissions, the ETL tool might not
initialize and load its plugins on start up. This is due to limited write permission on the ETL default
install folder (...\Program Files\...). A possible solution is to install ETL to a custom folder
with write permission (for example, C:\ETL).

To install the ETL

1. In File Explorer, navigate to where you extracted the Energy Expert Toolkit.

2. Navigate toEnergy Expert Tools, and run the Energy Expert ETL.exe to open the
installer.

3. Follow the install pages and instructions, using the default settings where possible, until you
have completed the installation.
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Configuring
Configuring the Energy Expert solution includes the following steps:

1. Configuring server settings

2. Configuring communications

3. Configuring PMEWeb Applications

4. Integrating PMEWeb applications in Building Operation

5. Setting upGraphics in Building Operation

6. Configuring Dashboards and Slideshows

NOTE: These steps are required for both solution architectures, unless specifically called out in
the workflow steps.

See the following sections for details.
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1. Configuring server settings
PME server

Install a security certificate for TLS 1.2

PME uses Transport Layer Security (TLS) 1.2 for an encrypted, authenticated connection using
HTTPS between the server and theWeb clients.

For TLS to function correctly, a security certificate must be installed on the PME server andmust be
bound to the Default Web Site, which is used by PME. By default, if no bound certificate is
detected, PME is installed with a self-signed certificate. We strongly recommend that you replace
the self-signed certificate with an authority issued certificate.

Set SQL Server memory options

Set the SQL Server memory options to optimize system performance.

NOTE: Setting the SQL Server memory options applies only to full, standard editions of SQL
Server. It does not apply to SQL Server Express editions.

See Setting SQL Server memory options for details.

See theEcoStruxure™PowerMonitoring Expert 9.0 System Guide for additional recommended
post-installation configuration steps.

Building Operation server

Add PME server as Trusted site in Internet Options

Building Operation and PME can be installed on the same server (operating system) or on two
separate servers.

When installing on separate servers, youmust configure Internet Explorer on the Building Operation
computer to add the PME server URL as a Trusted site.

To add the PME server URL as a Trusted site:

1. Open Internet Explorer, navigate to Tools > Internet Options and then click Security.

2. Select Local intranet, and then click Sites. The Local intranet dialog appears.

3. (For IE 11) In Local intranet, click Advanced.

4. In theAdd this website to the zone field, enter your PME server site address, and then click
Add. Your PME server site is now added as a Local intranet site zone.

5. Click OK. Your system can now authenticate your PowerMonitoring Expert server.



2. Configuring Communications
The configuration of the software and device communications is dependent on the solution
architecture. The following describes the configuration required for Architecture 1 and 2.

WARNING
INACCURATE DATA RESULTS
• Do not incorrectly configure the software or the devices.
• Do not base your maintenance or service actions solely onmessages and information
displayed by the software.

• Do not rely solely on softwaremessages and reports to determine if the system is functioning
correctly or meeting all applicable standards and requirements.

• Consider the implications of unanticipated transmission delays or failures of communications
links.

Failure to follow these instructions can result in death, serious injury, equipment
damage, or permanent loss of data.

Architecture 1
Configuring communications for Architecture 1 includes the following steps:

1. Adding devices to Building Operation

2. Configuring EWS settings in Building Operation

3. Configuring the ETL

See the following sections for details.

Adding devices to Building Operation

Add the power devices to Building Operation. For information on how to add devices to Building
Operation, see theEcoStruxure Building Operation Technical ReferenceGuide.

Configuring EWS settings in Building Operation

In Building OperationWorkstation, navigate to <Your server name>\System\EcoStruxure

Web Services and check to see that the EWS Server settings match the following:
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Confirm that:

l Enable EWS Server is set to "True"

l Ensure secure communication is set to “Disabled”

l Server Value is set to “True.”

We recommended you setup a dedicatedETLUser account for EWS in Building Operation.

To create an account:

1. Navigate to <Your Server name>\System\Domains\Local\Users\ and click New >
User Account.



2. Make sure ETLUser is amember of “Administrators” account group:

Configuring the ETL

The ETL tool connects to the Building Operation EWS server, reads out the required historical data
(Trend logs), and inserts that data into the PME database. Within the ETL, the task descriptions
required to complete the data copy process are organized into Jobs.

An ETL Job contains the following:

l An Extract task to read out the data from a server (in this case, Building Operation)

l (Optional) A Transform task to edit the data

l A Load task to write the data to the new location (in this case, the PME database).

TIP: When creating a new job in ETL, you can clone an existing job, rather thanmaking a job from
scratch. To clone a job, select an existing job from the JobManagement drop down and click Edit.
In the Job tab, change the name to reflect the new job. Click the Task tab and edit the new job as
necessary. Click Apply orOK from any tab location to save the job with the new name.

The following sections describe how to configure an ETL Job for the Energy Expertsolution,
Architecture 1 implementation.

Prerequisites

Before configuring the ETL, confirm that:

l Building Operation is installed and configured.

l Trend logs and Extended Trend logs are setup and ready to use in Building Operation. For
information regarding Trend logs, refer to the "Trend log" section in theEcoStruxure Building
Operation System ReferenceGuide

l PME is installed and configured

l The EWS server in Building Operation is functioning correctly.

l ETL is installed correctly
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Creating an ETL job

To create an ETL job:

1. On your desktop, double-click the shortcut EcoStruxure ETL 4.6 (Building Operation to PME) -
ETL Administration Tool. The ETL Engine Job Configuration Tool dialog appears.

2. Click New. The Job tab appears.

3. Enter the name of the job in the Name field. If you are running the job as a service, review and
change if necessary the Sleep Time Between Execution value. This value determines the
length of time between jobs when a job is run as a service. The default value is 3600 seconds.

4. Click the Tasks tab. The Tasks pane appears.

TIP: See ETL tips and tricks for information such as batch edits, sorting an searching data grids,
running a jobmanually or as a service, editing job tasks.

Adding and configuring the Extract task

To add and configure the Extract task:

1. From theSelect Category drop-down, select Extract.

2. From theSelect Type drop-down, select EBOEWSExtractTask, and then click Add. The
EBOEWS Extract Task appears in the pane below.



3. Select the task to show the task settings in the right pane.

4. Complete all fields as necessary for the task. Complete at least the following fields:

Web Service User Name – The Building Operation EWS user name (for example: admin)

Web Service Password – The Building Operation EWS password

Web Service URL – Replace localhost:8080 with your <server name>:<http port num-
ber>

NOTE: The ETL does not support secure HTTP (HTTPS) URLs. Do not use HTTPS URLs with
the Building Operation EWS server.

NOTE: The ETL does not support the SHA-256 Cryptographic Hash Algorithm for authentication.
Youmust enable theMD5Cryptographic Hash Algorithm for authentication in Building Operation
for the Energy Expert solution. The option can be found inWorkStation Control Panel >
Security Settings > Disable MD5 Hash.

To test your EWS connection, click theWeb Service URL row to display an ellipsis button. Click
the ellipsis button. Enter yourWeb Service URL and then click Test.

Refer to Extract task: Setting parameters and recommended values in the Reference section to see
a complete list of parameters and recommended values for each setting.
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(Optional) Adding and configuring the Transform task

A Transform task is not required for the Energy Expert solution. However, it is possible to improve
the data quality for the display in PME Dashboards and Reports by correcting irregular timestamps
for interval logged data. The IntervalizeDataTransformTask task in the ETL can be used for this
purpose. It is designed to adjust the log timestamps to a pre-defined interval.

Below is an example of a 15-minute interval data log with irregular timestamps, before and after the
transform:

Before transforming After transforming (15 min. interval)
Value Timestamp Value Timestamp
1.23 23:58:12 1.23 00:00:00
2.34 00:07:11 n/a n/a
3.45 00:13:13 3.45 00:15:00
4.56 00:31:14 3.45 00:30:00
5.67 00:43:17 5.67 00:45:00

NOTE: The transform only corrects the timestamps, not the logged data values for the intervals.
This can introduce inaccuracies in the logged data.

DONOT use this transform task,

l for Change of Value (COV) data logs

l when timestamp consistency between the data in Building Operation and PME is important

To add and configure the Intervalize Data Transform task:

1. From theSelect Category drop-down, select Transform.

2. from theSelect Type drop-down, select IntervalizeDataTransformTask and then click Add.
The Intervalize Transform Task appears in the pane below.



3. Select the task to show the task settings in the right pane.

4. Complete all fields as necessary for the task. Complete at least the following field:

Target Reading Interval – Set this value to your Trend log logging interval (default is fif-
teenminutes).

Refer to Transform task: Setting parameters and recommended values in the Reference section to
see a complete list of parameters and recommended values for each setting.

Adding and configuring the Load task

To add and configure the Load task:

1. From the Select Category drop down, select Load .

2. Select PowerMonitoring Expert Load Task from the Select Type drop-downmenu, and then
click Add. The PowerMonitoring Expert Load Task appears in the pane below.
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3. Select the task to show the task settings in the right pane.

4. Complete all fields as necessary for the task. Complete at least the following fields:

Database Settings –Make sure all 3 database settings are correct.

Enable Recorder and Channel Creation – Set this value to True.

NOTE: If you plan to use the Energy Cost Report or Load Profile Report, review theEnable
Recorder and Channel Creation setting in Load task: Setting parameters and
recommended values.

5. After you finish configuring all necessary tasks, click Apply to save your changes without exit-
ing the job, or click OK to save and exit the job.

Refer to Load task: Setting parameters and recommended values in the Reference section to see a
complete list of parameters and recommended values for each setting.

Mapping Building Operation tags to PME measurements

Building Operation is a tag-based system, while PME is a Device/Measurement-based system.
Therefore, youmust use theMappings tab tomanually map the tags to the corresponding
Device/Measurements.

TIP: See ETL tips and tricks for information such as batch edits, sorting an searching data grids,
running a jobmanually or as a service, editing job tasks.

Tomap tags tomeasurements:

1. In the ETL tool, select the job you created for the Energy Expert solution.

2. Click theMappings tab. TheMappings dialog appears.



3. Click Load Sources. Trend logs from Building Operation load and appear in theMappings
pane.

Depending on the size and the design of your system, the Trend logs may take some time (up
to 30minutes) to load.

After you click Load Sources, the Client status details appear at the lower left of the dialog and
show the number of tags loaded and folders searched.

4. Once loaded, identify the rows containing the Trend logs that you want to import into PME.

5. For each row, do the following:

Complete the Target Device field by selecting an existing device from the drop-down list,
or by entering a new name for a device.

NOTE:
If you create a new device, your new device namemust match the PME naming
convention. The following limitations apply:

Names cannot contain spaces or the following characters: \ / : * ? " < > { } . , ' & @ |
% #

Do not use names such as CON, AUX, COM1, and LPT1when naming sites and
devices.

Complete the Target Measurement field by selecting an existingmeasurement from the
drop-down list.
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Refer to Measurement mapping for ETL in the Reference section to learn about themost
common, supportedmeasurements used in PME and how to link to typical Building
Management tags.

Select the Time Zone from the dropdown list.

Change the value for the scale, if necessary.

Select the checkbox in the Included column at the left to include the Trend log in this job.

6. After you havemapped all desired Trend logs, click Apply to save the job.

Troubleshooting missing Trend logs

All Building Operation Trend logs should appear in the Trend log list. If Trend logs do not appear,
check the following:

l Missing bindings: Values that have not been bound to the graphics.

l Trend log status is not Started: If the Trend log status is not “Started” in Building Operation
through the EWS server, the Trend logs will not be exposed in the ETL tool, and therefore, those
Trend logs will not be returned or displayed in the ETL tool. All Trend logs should be exposed in
the ETL tool and appear in theMappings tab when you click Load Sources. Before you run an
ETL job, in Building Operation, check tomake sure that the Trend log status is set to “Started”;

l Meters/servers offline: The Trend logs are connected to devices or servers that are offline.

l Extended Trend log link not broken: Trend logs that are beingmonitored by Extended Trend logs
where the connection is not broken.

Architecture 2
Configuring communications for Architecture 2 includes the following steps:

1. Adding devices to PME

2. Updating the PME EWS server

See the following sections for details.



Adding devices to PME

NOTE: Device licenses are required for all devices connected to PME. The PME trial license, that
is part of the Energy Expert solution, includes an unlimited device license for the first 90 days. You
must activate valid purchased licenses within 90 days, otherwise some software functionality is
disabled.

NOTICE
LOSS OF COMMUNICATION
• Activate product and component licenses prior to the expiry of the trial license.
• Activate sufficient licenses for the servers and devices in your system.

Failure to follow these instructions can result in loss of data.

UseManagement Console in PME to add, remove or configure system components, such as
Ethernet or serial metering devices, in your system.

NOTE: RunManagement Console as Administrator user. To do this, right-click theManagement
Console program icon and select Run as administrator from the context menu. If you do not run
it as Administrator, then certain tools such as Update EWS Server are not functional.

NOTE: Only users with Supervisor or Operator access level in PME canmake network changes in
theManagement Console.

NOTICE
NETWORK INOPERABILITY

Do not make unauthorized changes in the network configuration usingManagement Console.

Failure to follow these instructions can result in an unstable or unusable network.

See the following sections for details on how to add devices.

Setting up your network in Management Console

The Primary Server contains all the PowerMonitoring Expert programs and it controls the overall
operation of your energy management system. The primary server is displayed on the Server screen
when you first start Management Console.

To start building your system, add and configure your sites and devices.

Overview

Site and Device Naming restrictions

The following applies to Site, Device Group, and Device Name naming:
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l Names cannot contain spaces or the following characters: \ / : * ? " < > { } . , ' & @ |% #

l Do not use names such as CON, AUX, COM1, and LPT1when naming sites and devices.

Adding network components

For details on adding various components, see the following sections.

Follow the procedure below to add a new network component:

1. In the System Setup pane, select the icon for the type of item that you want to add ( Site,
Device, orDial Out Modem).

2. Right-click the display window, select New, and then select the specific type of network
component from the shortcut menu to open theConfiguration dialog.

The options differ depending on which system setup icon you selected.

3. Use the fields and drop-downmenus to configure properties. Mandatory items are highlighted
in red. To configure advanced properties, right-click the dialog and select Advanced Prop-
erties. For more shortcut menu options, see Configuration Dialog shortcut menus, below.

4. Click OK to add the component.

Configuration Dialog shortcut menus
Right-click theConfiguration dialog to access the following shortcut menu options:

l Property Details: This opens a window that contains information on the selected property,
includingminimum andmaximum allowable values, if applicable.

l Advanced Properties: This exposes all the property fields that are hidden in the default (basic)
view. For further information about the Time synchronization option. see Time synchronization
for ION meters for further information.

l Reset All To Default: Resets all properties to their original values.

Adding a server

Click the Servers icon, right-click the display window and select New > Computer. Fill in the
mandatory Name field.

Adding devices

Setting Up devices for direct serial communications

To set up devices for RS-232 or RS-485 communications on a direct serial loop, first add a direct
site in Management Console and specify a serial communications port on the computer.



Step1: Adding a direct site
Click the Sites icon. Right-click the display window and select New > Direct Site. Fill in theName
andSerial Port fields. Configure the other fields as you require.

Step 2: Adding a device to the direct site
Click the Devices icon. Right-click the display window and select New > Serial Device onDirect
Site. Fill in these fields:

l Group: Type a name for the group or select an existing group from the list.

l Name: Type the name you want to give the device.

l Device Type: Select the type of the device.

l Unit ID: Type the Unit ID of the device; the range is 1-9999 for ION devices or 1-247 for Mod-
bus RTU devices.

l Site: Select the direct site you previously set up.

l Time Zone: Select the timezone you want the device data to be displayed in, in the software.
This setting is only used for the display of timestamped data in the software. It does not affect
the configuration of themonitoring device itself.

Configure the other fields as you require.

Setting up devices for Ethernet gateway communications

To set up devices for Ethernet gateway communications, first add and configure an Ethernet
gateway site. Ethernet gateways that can be used include those that are simple Ethernet-to-Serial
converters, or any gateway or data concentrator that provides ModbusTCP communications.

Step 1: Adding an Ethernet gateway site

Click the Sites icon. Right-click the display window and select New > Ethernet Gateway Site.

Complete theName, IP Address or Host Name and TCP/IP Port fields. (The IP address can be
IPv4 or IPv6.) The TCP/IP Port identifies which communications port is used to connect to the
serial devices. The port you use depends on the type of Ethernet gateway you want to set up (use
7801 for an EtherGate gateway via COM1 or use port 502 for aModbus gateway).

Configure the other fields as you require.

Step 2: Adding a Device to the Ethernet Gateway Site
Click the Devices icon. Right-click the display window and select New > Serial Device on
Ethernet Gateway Site. Fill in these fields:

l Group: Type a name for the group or select an existing group from the list.

l Name: Type the name you want to give the device.

l Device Type: Select the type of device.

l Unit ID: Type the Unit ID of the device; the range is 1-9999 for ION devices or 1-247 for Mod-
bus devices.

l Site: Select the Ethernet gateway site you previously set up.
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l Time Zone: Select the timezone you want the device data to be displayed in, in the software.
This setting is only used for the display of timestamped data in the software. It does not affect
the configuration of themonitoring device itself.

Configure the other fields as you require.

Adding an Ethernet device
Ethernet devices are configured in PME by providing fixed IP addresses (IPv4 or IPv6) and ports, or
based on device names. Device names must be used for devices with dynamic address
assignment, for example using the DHCP protocol. When device names are used, then a form of
name resolutionmechanism is required on the network.

To add an Ethernet device, click the Devices icon. Right-click the display window and select
New > Ethernet Device. Fill in theGroup, Name, Device Type, IP Address or Host Name, and
Time Zone fields. (The IP address can be IPv4 or IPv6.) Configure the other fields as you require.

NOTE: For the Time Zone field, select the timezone you want the device data to be displayed in,
in the software. This setting is only used for the display of timestamped data in the software. It
does not affect the configuration of themonitoring device itself.

Setting up devices for OPC communications

To set up devices for OPC communications, first add anOPC site.

Step 1: Adding an OPC site

Click the Sites icon. Right-click the display window and select New > OPC Site. Fill in theName
andAddress fields. Configure the other fields as you require.

Make sure you follow the correct syntax when typing in the address for the OPC site. Select the
Address field to see an example address in the Property Description section (near the bottom of the
OPC Site Configuration dialog).

Step 2: Adding a device to the OPC site

NOTE: At least oneOPC Device Type needs to be preconfigured before anOPC Device can be
created inManagement Console. Contact Technical Support for assistance.

Click the Devices icon. Right-click the display window and select New > OPC Device. Fill in the
Group, Name, Device Type, Site (select the OPC site you previously set up), and Time Zone.
Configure the other fields as you require.

NOTE: For the Time Zone field, select the timezone you want the device data to be displayed in,
in the software. This setting is only used for the display of timestamped data in the software. It
does not affect the configuration of themonitoring device itself.

Adding a modem

1. Click theDial Out Modems icon, right-click the display window and select New, then select
eitherSerial Modem (hardwaremodem) orWinModem (Windows modem).



2. Fill in the values for themandatory fields:

ForSerial modem, select theModem Type from the list. If your modem is not in this list,
select “Generic ION Modem -Other”. Select theSerial Portwhere your modem is con-
nected.

ForWinModems, select theModem Name from the list.

Configure the other fields as you require.

3. Click OK.

WinModem installation notes
Before you can use aWinModem, youmust first install it on your computer (follow the instructions
that camewith theWinModem product). After you restart the computer, set up theWinModem:

1. In Microsoft Windows, click Start > Settings > Control Panel, then double-click Phone and
Modem Options.

2. Click theModems tab, select yourWinModem, then click Properties.

3. Click the Advanced tab, then click Change Default Preference.

4. Set Port speed to match the baud rate that is used between themeter and themodem on the
remote end of the connection (bothmodems must be set to the same baud rate).

5. Set Flow Control to “None”.

6. Click OK to save your changes.

NOTE: Youmay need to restart your computer for the settings to take effect.

Editing a network component

1. Click the icon in the System Setup pane for the type of component you want to edit.

2. In the display window, right-click the network component you want to edit and select
Configure <Network Component> (with <Network Component> being the type of
component you want to edit).

You can rename devices or groups displayed in the Devices pane without selecting the
Configure option. SeePowerMonitoring Expert – System Guide for more information.

NOTE: If you rename a group or device, the data that is already stored in the database is
associated with the new group or device name. New data will be added to the database using
the new name.

3. Make the required changes. To display all configurable fields, right-click theConfiguration
dialog and select Advanced Properties.

4. Click OK when you are finished to save your changes.
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Deleting a network component

1. Click the System Setup icon for the type of component you want to delete.

2. In the display window, right-click the network component you want to delete and select Delete
(or select the item and press the DELETE key).

3. Click Yes to confirm the deletion orNo to cancel.

NOTE: When you delete a Site or a Server, all devices associated with it are also deleted.

Updating the EWS Server

After adding the devices or making any changes to the device configuration in the PME, youmust
update the EWS server through theUpdate EWS Server tool in theManagement Console.

NOTE: RunManagement Console as Administrator user. To do this, right-click theManagement
Console program icon and select Run as administrator from the context menu. If you do not run
it as Administrator, then certain tools such as Update EWS Server are not functional.

To update EWS Server:

1. OpenManagement Console.

2. Select Tools > System > Update EWS Server. A dialog box appears indicating that the
update to the EWS server configuration was successful.

3. Click OK when the Update EWS Server confirmation dialog appears.



3. Configuring PME Web Applications
Configuring the PMEWeb applications may include the following components:

l User Accounts

l Hierarchy Manager

l Modeling Configuration

l Rate Editor

l Diagnostics and Services

l Localization

l Registration Information

l Report Theme

l Theme

SeeWeb Applications Settings for details.
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4. Integrating PME Web applications in Building Operation
Integrating PMEWeb applications in Building Operation includes the following steps:

1. Configuring Diagrams, Reports, Dashboards, and EWS integration options with the Energy
Expert Integration Utility

2. Generating the configuration import file for Building Operation

3. Importing the configuration file into Building Operation

4. Setting up EWS credentials in PME (server) and Building Operation (client)

See the following sections for details.

Prerequisites
Before using the Energy Expert Integration Utility, complete the following tasks:

l Install and configure PME.

l Install and configure Building Operation.

l (Only for Architecture 2 solutions) Add devices to PME.

l (Only for Architecture 2 solutions) Update the EWS Server.

l (Optional) Configure PME and Building Operation to useWindows Active Directory users and
user groups.

l (Optional) Install and configure an authority issued security certificate on the PME server.

NOTE: Run the Integration Utility on the PME server, with aWindows account that has sysadmin
access to the SQL database instance.

Configuring Diagrams, Reports, Dashboards, and EWS integration options
You use the Energy Expert Integration Utility, on the PME server, to configure Diagrams, Reports,
Dashboards, and EWS integration options for integration into Building Operation. As a result of the
configuration, the utility creates a configuration file, that is then imported into Building Operation.

NOTE: The Energy Expert Integration Utility is part of the Energy Expert Toolkit. You need to run
this utility on the PME computer. If Building Operation and PME are installed on separate
computers, then copy or download the Toolkit to the PME computer and extract its contents. See
1. Downloading the Energy Expert Toolkit for more information.

To configure Diagrams, Reports, , Dashboards, and EWS integration options:

1. Navigate to the Integration Utility folder where you extracted the Energy Expert Toolkit files.

2. Run the IntegrationUtility application.

3. Login to the utility with a supervisor-level account. The Integration Utility dialog appears.

4. Select and configure the options in each tab. See below for details on the tab options.

5. Click Export, after you have completed all applicable tabs, to start the process of generating
the configuration file for Building Operation.



6. Continue with Generating the configuration import file for Building Operation for details on how
to generate the file.

WARNING
INACCURATE DATA RESULTS
• Do not incorrectly configure the software or the devices.
• Do not base your maintenance or service actions solely onmessages and information
displayed by the software.

• Do not rely solely on softwaremessages and reports to determine if the system is functioning
correctly or meeting all applicable standards and requirements.

• Consider the implications of unanticipated transmission delays or failures of communications
links.

Failure to follow these instructions can result in death, serious injury, equipment
damage, or permanent loss of data.

Tab option details:

Diagrams tab (only for Architecture 2 solutions)

1. From the Export pane, select one of the following options:

All Device Diagram Links - This creates device diagram links for every device in the
system.

Specific Device Diagram Links - Allows you to select from the list all devices that you
want to include in the import file.

2. From the To pane, select theWorkstation Import File option.

Reports tab

1. From the To pane, select theWorkstation Import File option.
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Dashboards tab

1. From the To pane, select theWorkstation Import File option.

EWS tab (only for Architecture 2 solutions)

1. Click theEWS tab. Allow time for this screen to load.

2. From the Export pane, select one of the following options:

EWS Link Only – This creates the EWS Interface in Building Operation without any pre-
hosted Sources or measurements coming from PME. Sources andMeasurements need
to be hostedmanually by the user. This manual process can take a long time when host-
ing large number of SourceMeasurement pairs.

EWS Link & All Measurements – (Use this option if you are not sure what to select) –
This creates the EWS Interface in Building Operation and also pre-hosts all PME Sources
with all their respective exposedMeasurements. Exposedmeasurement can be changed
at a later point, see Hosting EWS values in Building Operation for details.

EWS Link & Specific Measurements – Allows you to define what Source and what
Measurement will be pre-hosted in the EWS Interface created in Building Operation.

3. (If you selected EWS Link & Specific Measurements) Select the sources andmeasurements



to be exposed through EWS.

4. From the To pane, select theWorkstation Import File option.

Generating the configuration import file for Building Operation
After configuring Diagrams, Reports, Dashboards, and EWS integration options, the next step is to
generate the configuration file for Building Operation. The workflow below is a continuation of the
Configuring Diagrams, Reports, Dashboards, and EWS integration options step described in the
previous section.

To create the import file:

1. In the Energy Expert Integration Utility dialog, click Export. This opens the Authentication
Method dialog.

2. In AuthenticationMethod, select the authenticationmethod you want to use for accessing
PME content in Building Operation. The following options are available:

NOTICE
UNAUTHORIZED OR UNINTENDED ACCESS TO CUSTOMER DATA
• Personnel setting up Energy Expert third-party authenticationmust be aware that links to
data are not secure.

• Do not setup access links to sensitive or secure data.

Failure to follow these instructions can result in unauthorized or unintended access
to sensitive or secure customer data.

Manual PME Authentication – Prompts the user for PME credentials when a hyperlink
to a PME web application is opened. The user is only prompted for PME credentials the
first time they open a link during a Building Operation session.
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Automatic PME Authentication (least secure) – Creates unique hyperlinks to PME web
applications with embedded, encrypted PME credentials. The links open without prompt-
ing the user for credentials. This method provides a seamless user experience within
Building Operation but it is less secure than theManual PME Authenticationmethod
because the hyperlinks could be captured and used to access PME applications from any
computer that has access to the PME server.

Windows Authentication (most secure) – Logs the user into PME using their current
Windows credentials. This method provides a seamless user experience with Building
Operation and is themost secure.

NOTE: To use this option, Building Operation and PME must be configured to use
Windows Active Directory users and user groups.

3. Click Next. This opens the Energy Expert Credentials dialog.

4. In Energy Expert Credentials:

If you selectedManual PME Authentication orWindows Authentication in the pre-
vious step, leave theUser Name andPassword boxes empty and continue with step 5.

If you selectedAutomatic PME Authentication in the previous step, then enter aUser
Name andPassword for a PME user account with operator access level. These
credentials will be encrypted and embedded in the hyperlinks.



5. Click Next. This opens the Transport Method dialog

6. In Transport Method, configure the following fields:

PME Server Name - Enter the name of the PME server. If you are using HTTPS to con-
nect to PME, then this server namemust exactly match the name in the security cer-
tificate used for the PME server.

NOTE: A name resolutionmechanism for the server namemust be in place for both the
PME and Building Operation servers. If that is not possible, then youmust add the
necessary entries to the host files on both servers.

Use HTTPS (most secure) – This protocol provides data encryption and identification of
the website andWeb server it is connecting to.

NOTE: Youmust have a security certificate installed on the PME server, and the server
name in the certificate must match the name in the PME Server Name field of this
dialog.

NOTE: By default, the EWS server in PME is configured for HTTP client connections.
Follow the steps in Configuring the PME EWS server for HTTPS to enable HTTPS client
connections.

Use HTTP (least secure) – This protocol does NOT provide data encryption or iden-
tification of the website andWeb server it is connecting to.
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7. Click Next.

8. In the Export Location dialog, click to navigate to your export location. Enter a file name,
and then click Save.

9. Click Export. The Integration Utility exports the configuration import file in .xml format.

Importing the configuration file into Building Operation
The configuration file, that was created in the previous step, needs to be imported into Building
Operation. To prepare for the import, copy the file to a location that is accessible from the Building
Operation server.

To import the configuration file into Building Operation:



1. Open Building Operation and log intoWorkStation.

2. Right-click the Enterprise server (the highest level in the System Tree), and select Import....

3. Navigate to and select the configuration file.

4. Click Import. The file import process completes. A new folder called “Energy Expert” appears
in the System Tree.

NOTE: You can run the Integration Utility more than once. However, importing the configuration
file multiple times without deleting the previously imported folder will create a duplicate entry in the
target Building Operation system.

Setting up EWS credentials in PME (server) and Building Operation (client)
EWS credentials must be set for both the PME EWS server and the Building Operation EWS client.

To set the credentials for the PME EWS server:

1. Open PMEWeb Applications, and select SETTINGS > EcoStruxure Web Services.

NOTE: Access Web Applications through theWeb Applications shortcut in the Power
Monitoring Expert desktop folder on the PME server. Or, to go directly to the
EWS configuration page, open the following URL: https://<server_
name>/Web/#Settings/Ews
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2. Click Change Credentials and enter aUser name andPassword.

3. Click Save.

To set the credentials for the Building Operation EWS client:

1. InWorkStation, open the Energy Expert folder.

2. Right-click the EWS Client and click Properties.

3. Enter the user name and password in the Authentication field.

4. Click OK.



5. Setting up Graphics in Building Operation
Building Operation Components and Snippets

The Energy Expert Integration Toolkit includes components and snippets for the creation of
Graphics in Building Operation.

NOTE: These components and snippets were installed on the Building Operation server in a
previous step. See 3. Installing the components, snippets, and binding template for details.

Components

Animated Components for ANSI and IEC

The Energy Expert Integration Toolkit includes a set of animated Components that are based on the
American National Standards Institute (ANSI) and International Electrotechnical Commission (IEC)
symbol standards. These can be used by the Building Operation Graphics Editor.

Static device images

The Energy Expert Integration Toolkit includes a library of device images that can be used in the
Building Operation Graphics Editor. Use the images represent the devices and equipment present in
your system. They can be added to a diagram by selecting the device from theMeter Graphics
category and dragging the image to the work area.

The library contains images for the following devices:

l ION6200 l PM5000 Series
l ION7550/7650 l EM3500 Series
l PM700 Series l Acti 9 iEM 3000 Series
l PM800 Series l Veris E50 Series
l PM3200 Series

NOTE: Device images are available for: a). meters that are bound and show data, and b). meters
that are not bound and show no data. Choose the device images that best represent your system.

Snippets

The Energy Expert Integration Toolkit includes a Building Operation snippet that is designed to be
used with the ANSI and IEC components.

Advanced Tooltip Snippet

The Advanced Tooltip Snippet provides information regarding a specific device when the pointer
hovers over it. The display text of the tool tip can be customized and the following properties can be
defined:

l Font size

l Font color

l Number of decimal places to display

l Measurements to show
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Setting up Electrical Network Graphics
Use the Building Operation Graphics Editor to create Graphics that represents an electrical network.
For example a one-line Graphic, that includes all of themetering devices and circuits, or an
Electrical Health Summary Graphic that shows the loading of themetered circuits in the system.

Example of a one-line Graphic, created with the Building Operation Graphics Editor:

Example of an Electrical Health Summary graphic, created with the Building Operation Graphics
Editor:



Basic instructions for setting up Electrical Network Graphics

WARNING
INACCURATE DATA RESULTS
• Do not incorrectly configure the software or the devices.
• Do not base your maintenance or service actions solely onmessages and information
displayed by the software.

• Do not rely solely on softwaremessages and reports to determine if the system is functioning
correctly or meeting all applicable standards and requirements.

• Consider the implications of unanticipated transmission delays or failures of communications
links.

Failure to follow these instructions can result in death, serious injury, equipment
damage, or permanent loss of data.

To set up an Electrical Network Graphic:

1. Open the Building Operation Graphics Editor.

2. Create an electrical network diagram by dragging and dropping graphics onto your new file
from the imported graphics libraries (meter graphics, symbols, controls, and so on) in the left
pane.

3. For the Energy Expert Toolkit components that you drag and drop into the graphic, select the
component, and thenmodify the component Name, in the General section of the Properties
pane. The Namemust match the PME “GroupName.DeviceName” or the SmartWidget Name
of the device for which you want to display data.

NOTE: This Name is used by the binding template for measurement binding. See Binding
Graphics tomeasurements for details.

For more details on how to use the Graphics Editor, see theEcoStruxure Building Operation
Technical ReferenceGuide and the Building Operation Graphics EditorWeb help.
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Binding Graphics to measurements
The Energy Expert Integration Toolkit includes a binding template to automate the binding of
Building Operation graphics components to devicemeasurements.

When you create the EWS interface in Building OperationWorkstation, a connection is made
between Building Operation and PME. The Energy Expert folder in Building OperationWorkstation
then contains all the device names andmeasurements from PME. Any graphics components that
have the correct PME device name set up will be bound to their device counterpart when the binding
template is applied. Since the binding template also contains theModbus Point name often used in
SmartWidgets, it can also be used to bind graphics to values from the SmartWidgets.

NOTE: This binding template was installed on the Building Operation server in a previous step.
See 3. Installing the components, snippets, and binding template for details.

Prerequisites

Before applying the binding template, confirm the following:

l The EWS interface has been established

l The components in the Building Operation Graphics Editor diagram have been correctly con-
figured

l The binding template has been imported into Building OperationWorkstation

Applying the binding template

WARNING
INACCURATE DATA RESULTS
• Do not incorrectly configure the software or the devices.
• Do not base your maintenance or service actions solely onmessages and information
displayed by the software.

• Do not rely solely on softwaremessages and reports to determine if the system is functioning
correctly or meeting all applicable standards and requirements.

• Consider the implications of unanticipated transmission delays or failures of communications
links.

Failure to follow these instructions can result in death, serious injury, equipment
damage, or permanent loss of data.

To apply the binding template:

1. In Building OperationWorkstation, in the System Tree pane, right-click the graphic item for
which you want to use the binding template.

2. Select Edit Bindings from the list. The Binding point list appears in the work area.

3. Drag and drop the Energy Expert folder or the folder that contains the SmartWidgets to the
Energy Expert- Basic binding template. The Confirm Binding dialog appears.



4. Confirm that the binding and binding points are correct.

5. Click File > Savewhen finished.

NOTE: The Energy Expert binding template can only be used for an English version of the Energy
Expert solution. For non-English systems, you need tomanually bind the EWS values or create a
custom binding template.
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6. Configuring Dashboards and Slideshows
Use the Dashboards application to view high level historical and real-time data, for example Key
Performance Indicators (KPIs). The information in the Dashboards application is accessed through
dashboards with gadgets. Dashboards are saved in the Dashboard Library. In addition to viewing
individual dashboards, you can create slideshows to automatically display a sequence of
dashboards.

WARNING
INACCURATE DATA RESULTS
• Do not incorrectly configure the software or the devices.
• Do not base your maintenance or service actions solely onmessages and information
displayed by the software.

• Do not rely solely on softwaremessages and reports to determine if the system is functioning
correctly or meeting all applicable standards and requirements.

• Consider the implications of unanticipated transmission delays or failures of communications
links.

Failure to follow these instructions can result in death, serious injury, equipment
damage, or permanent loss of data.

PowerMonitoring Expert (PME) does not provide any pre-configured dashboards or slideshows.
Configure your own dashboards, gadgets, and slideshows tomeet your needs.

Open the Dashboards application from theDashboards link in theWeb Applications banner.

For information on how to configure the Dashboards application, see:

Dashboards:

l Adding a new dashboard

l Editing a dashboard

l Sharing a dashboard

l Moving a dashboard

l Deleting a dashboard

l Set default options for a dashboard

l Configuring a slideshow

Gadgets:

l Adding a gadget to a dashboard

l Editing a gadget

l Moving or resizing a gadget on a dashboard

For more information on this feature, see theEcoStruxure™PowerMonitoring Expert 9.0 System
Guide.



Adding a new dashboard
Add new dashboards to view high level historical and real-time data, for example in the form of Key
Performance Indicators (KPIs).

NOTE: Only you and supervisor level Users can view, edit, and delete a Private dashboard.

To add a completely new dashboard:

1. In Dashboards, open the Dashboard Library and navigate to the folder where you want to cre-
ate the dashboard.

2. (Optional) Add a new folder by clickingAdd Folder at the bottom of the Library panel, or
by clickingAdd Folder in theOptionsmenu at the top of the Library.

3. In the Dashboard Library, at the bottom of the panel, click Add Dashboard . This creates
a new dashboard and opens the Dashboard Settings.

4. In Dashboard Settings, enter a dashboard name, select a location and set the access per-
missions to Public or Private.

5. (Optional) Click Styling to open the Dashboard Styling window. In Dashboard Styling, select
a background image or background color for the dashboard and set the default opacity for the
gadgets.

6. (Optional) You can add gadgets to the dashboard now, or save the empty dashboard and add
gadgets later. See Adding a gadget to a dashboard for more details.

7. Save the dashboard.

To add a copy of an existing dashboard to the Library:

1. In Dashboards, open the Dashboard Library and navigate to the dashboard you want to copy.

(Optional) Add a new folder by clickingAdd Folder at the bottom of the Library panel, or
by clickingAdd Folder in theOptionsmenu at the top of the Library.

2. Right-click the dashboard name or click Options for this dashboard, and select Duplicate to
create a copy in the same folder. Select Copy To to create a copy in a different folder.

3. (Optional) In the Dashboard Library, select the new dashboard, right-click the dashboard name

or click Options for this dashboard, and select Edit to open the Dashboard Settings.
Change the dashboard name.

4. Save themodified Dashboard Settings.

Related topics:

Dashboards:

l Adding a new dashboard

l Editing a dashboard

l Sharing a dashboard

l Moving a dashboard

l Deleting a dashboard

Solution Guide Configuring

7EN02-0414-00 Page 91



Configuring Solution Guide

Page 92 7EN02-0414-00

l Set default options for a dashboard

l Configuring a slideshow

Gadgets:

l Adding a gadget to a dashboard

l Editing a gadget

l Moving or resizing a gadget on a dashboard

Editing a dashboard
Edit dashboards to update the dashboard name, add new gadgets, change the dashboard styling,
change the access permissions or change the location of the dashboard in the Dashboard Library.

NOTE: Only you and supervisor level Users can view, edit, and delete a Private dashboard.

To edit a dashboard:

1. In Dashboards, open the Dashboard Library and navigate to the dashboard you want to edit.

2. Right-click the dashboard name or click Options for this dashboard, and select Edit to open
the Dashboard Settings. Change the dashboard name, add gadgets, change the dashboard
styling, change the access permissions, or change the location of the dashboard in the
Library.

3. Save themodified dashboard settings.

Related topics:

Dashboards:

l Adding a new dashboard

l Editing a dashboard

l Sharing a dashboard

l Moving a dashboard

l Deleting a dashboard

l Set default options for a dashboard

l Configuring a slideshow

Gadgets:

l Adding a gadget to a dashboard

l Editing a gadget

l Moving or resizing a gadget on a dashboard

Sharing a dashboard
Share dashboards with other User Groups.



NOTE: For Sharing to be enabled, at least one user group, in addition to the Global group, must be
configured. To share an item with another user group, youmust be amember of that group.

To share a dashboard:

1. In Dashboards, open the Dashboard Library and navigate to the dashboard you want to share.

2. Right-click the dashboard name or click Options for this dashboard, and select Share. This
opens the Share Dashboard window.

3. In Share Dashboard, select the User Groups you want to share this dashboard with.

4. (Optional) Specify a name for the shared dashboard. The groups you are sharing this dash-
board with will see this name. The name of the original dashboard remains unchanged.

5. Click OK to share this dashboard.

NOTE: When you share an item with another User Group, it appears in theShared folder of this
group. You cannot share a shared item.

Related topics:

Dashboards:

l Adding a new dashboard

l Editing a dashboard

l Sharing a dashboard

l Moving a dashboard

l Deleting a dashboard

l Set default options for a dashboard

l Configuring a slideshow

Gadgets:

l Adding a gadget to a dashboard

l Editing a gadget

l Moving or resizing a gadget on a dashboard

Moving a dashboard
Move dashboards to a different location in the Dashboard Library to make them easier to find or
easier to manage.

Tomove a dashboard:

1. In Dashboards, open the Dashboard Library and navigate to the dashboard you want to move.

(Optional) Add a new folder by clickingAdd Folder at the bottom of the Library panel, or
by clickingAdd Folder in theOptionsmenu at the top of the Library.
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2. Right-click the dashboard name or click Options for this dashboard, and selectMove To....
This opens the Select Location window.

3. In Select Location, select the location where you want to move this dashboard.

4. Click OK to move the dashboard.

Related topics:

Dashboards:

l Adding a new dashboard

l Editing a dashboard

l Sharing a dashboard

l Moving a dashboard

l Deleting a dashboard

l Set default options for a dashboard

l Configuring a slideshow

Gadgets:

l Adding a gadget to a dashboard

l Editing a gadget

l Moving or resizing a gadget on a dashboard

Deleting a dashboard
Delete dashboards that are no longer needed.

To delete a dashboard:

1. In Dashboards, open the Dashboard Library and navigate to the dashboard you want to delete.

2. Right-click the dashboard name or click Options for this dashboard, and select Delete

3. In Delete Content, click Yes, to delete the dashboard from the Dashboard Library.

Related topics:

Dashboards:

l Adding a new dashboard

l Editing a dashboard

l Sharing a dashboard

l Moving a dashboard

l Deleting a dashboard

l Set default options for a dashboard

l Configuring a slideshow



Gadgets:

l Adding a gadget to a dashboard

l Editing a gadget

l Moving or resizing a gadget on a dashboard

Set default options for a dashboard
The default dashboard is the one that is displayed when you first open Dashboards. You can set a
dashboard to be your own personal default, or the default for the system.

NOTE: For each user, Set as my default supersedes Set as system default. For example, if a
user with supervisor level access sets a dashboard as the system default dashboard, and another
user sets a different dashboard as their default dashboard, that user's default dashboard takes
priority over the system default dashboard, but only for them.

To set the default options for a dashboard:

1. In Dashboards, open the Dashboard Library and navigate to the dashboard you want to set as
default.

2. Right-click the dashboard name or click Options for this dashboard, and select Set as
default to open the Configure Default Item dialog.

3. Turn on one or both of Set as my default andSet as system default.

4. Click OK to save themodified Dashboard Settings.

Related topics:

Dashboards:

l Adding a new dashboard

l Editing a dashboard

l Sharing a dashboard

l Moving a dashboard

l Deleting a dashboard

l Set default options for a dashboard

l Configuring a slideshow

Gadgets:

l Adding a gadget to a dashboard

l Editing a gadget

l Moving or resizing a gadget on a dashboard
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Configuring a slideshow
Use the Slideshow Manager to create, edit, or delete a slideshow.

Creating a slideshow
To create a slideshow:

1. In Dashboards, open the Dashboard Library, and click Slideshow Manager in theSettings
menu at the top of the library

2. In Slideshow Manager, click Add Slideshow to open the Add New Slideshow dialog.

3. Type a name for the slideshow in theName field.

4. Click any of the dashboards in theShared Dashboards list to add them to theDashboard
Playlist area on the right. Alternatively, begin typing in theSearch field to filter the list for
selection.

The dashboards are listed in the Playlist area in the order that you selected them.

5. Tomodify the list of dashboards in theDashboard Playlist, click the dashboard name to dis-
play the edit options, then:

a. Click theDelete icon to remove the dashboard from the Playlist.

b. Click theUp orDown arrow tomove the dashboard to an earlier or later sequence in the
Playlist, respectively.

6. Select the speed for the transition from dashboard to dashboard in theSelect Transition
Time list.

7. Click OK to save your slideshow.

8. Click Close to close the Slideshow Manager.

Editing an existing slideshow
To edit an existing slideshow:

1. In Dashboards, open the Dashboard Library, and click Slideshow Manager in theSettings
menu at the top of the library

2. In Slideshow Manager, click the slideshow you want to edit, then click Edit to open the Edit
Slideshow dialog.

3. Change the name of slideshow, modify the dashboards in the play list, change the slide cap-
tion for the slideshow, or adjust the slide transition time.

4. Click OK to save your changes and to return to the Slideshow Manager.

5. Click Close to close the Slideshow Manager.

Deleting a slideshow
To delete a slideshow:

1. In Dashboards, open the Dashboard Library, and click Slideshow Manager in theSettings
menu at the top of the library

2. In Slideshow Manager, click the slideshow you want to delete, then click Delete to open the
Delete Slideshow dialog.



3. Click OK to permanently delete the slideshow and to return to the Slideshow Manager.

4. Click Close to close the Slideshow Manager.

Sharing a slideshow
To share a slideshow:

1. In Dashboards, open the Dashboard Library, and click Slideshow Manager in theSettings
menu at the top of the library

2. In Slideshow Manager, click the slideshow you want to share, then click Share to open the
Share Slideshow URL dialog.

The dialog includes the URL for the slideshow, which you can copy and distribute so that
others can access the slideshow.

NOTE: The client browser must have access to the URL to view the slideshow.

3. Click Close to close the Slideshow Manager.

Related topics:

Dashboards:

l Adding a new dashboard

l Editing a dashboard

l Sharing a dashboard

l Moving a dashboard

l Deleting a dashboard

l Set default options for a dashboard

l Configuring a slideshow

Gadgets:

l Adding a gadget to a dashboard

l Editing a gadget

l Moving or resizing a gadget on a dashboard

Adding a gadget to a dashboard
Add gadgets to a dashboard to display historical and real-time data. Without gadgets, a dashboard
does not display any data.

NOTE: Gadgets that require special licensing only appear in the list after the correct licensing has
been installed.

To add a gadget to the dashboard:

1. Click Add Gadget to open theGadget Setup dialog.
By default, all gadgets are included in the dialog. To filter the gadgets by category, click one of

Solution Guide Configuring

7EN02-0414-00 Page 97



Configuring Solution Guide

Page 98 7EN02-0414-00

the categories on the left, for exampleCommon orComparison.

2. Select the gadget that you want to add to the dashboard and click Next.
Gadget settings are specific to each gadget. For example, some gadgets require a data series
consisting of sources andmeasurements, while other gadgets have no such requirement.

3. Click Next to proceed through the pages of the Gadget Setup dialog.

4. Click Finish to close the Gadget Setup dialog and to add the gadget to the dashboard.

5. Repeat the process to add additional gadgets to your dashboard.

Related topics:

Dashboards:

l Adding a new dashboard

l Editing a dashboard

l Sharing a dashboard

l Moving a dashboard

l Deleting a dashboard

l Set default options for a dashboard

l Configuring a slideshow

Gadgets:

l Adding a gadget to a dashboard

l Editing a gadget

l Moving or resizing a gadget on a dashboard

Editing a gadget
To edit the settings for a gadget:

1. Click Settings in the gadget and select Edit to open theGadget Setup.

2. In Gadget Setup, change any of the settings on the tabs.

3. Click Save to update the gadget settings and to close the Gadget Setup dialog.

TIP: In gadgets where a time range has been specified when the gadgets are configured, the time
range selection is included on the gadgets in the dashboard. You can quickly change the time
range for the gadget by selecting another period of time from the list in the time range field. The
time range is applied to the gadget only while you continue to view the dashboard. If you navigate
to another dashboard and then come back to this dashboard, the time range on the gadget reverts
to the value that you set when you configured the gadget.



Related topics:

Dashboards:

l Adding a new dashboard

l Editing a dashboard

l Sharing a dashboard

l Moving a dashboard

l Deleting a dashboard

l Set default options for a dashboard

l Configuring a slideshow

Gadgets:

l Adding a gadget to a dashboard

l Editing a gadget

l Moving or resizing a gadget on a dashboard

Moving or resizing a gadget on a dashboard
You canmove or resize a gadget on a dashboard when the dashboard is in edit mode.

Moving a gadget

1. Right-click a dashboard name in theDashboard Library, then click Edit in themenu.

2. Position themouse pointer in the title area of the gadget that you want to move.

The pointer changes to theMove shape (an image with 4 arrows).

3. Drag and drop the gadget to another position on the dashboard.

Other gadgets on the dashboard are re-positioned if additional space is required.

4. Click Finish inDashboard Controls to save your change.

Resizing a gadget

1. Right-click a dashboard name in theDashboard Library, then click Edit in themenu.

2. Position themouse pointer at the lower right corner of the gadget.

A small triangular shape indicates that you can drag the corner.

3. Drag the corner to increase or reduce the size of the gadget.

Other gadgets on the dashboard are re-positioned if additional space is required.

4. Click Finish inDashboard Controls to save your change.

Related topics:

Dashboards:

l Adding a new dashboard

l Editing a dashboard
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l Sharing a dashboard

l Moving a dashboard

l Deleting a dashboard

l Set default options for a dashboard

l Configuring a slideshow

Gadgets:

l Adding a gadget to a dashboard

l Editing a gadget

l Moving or resizing a gadget on a dashboard



Operating
This chapter includes the following topics:

1. Accessing Dashboards and Slideshows

2. Accessing Reports

3. Accessing Alarms

4. Accessing EWS real-time values (only for Architecture 2 solutions)

5. Accessing device diagrams (only for Architecture 2 solutions)

NOTE: For these applications to display correctly in Building OperationWebStation, youmust use
a supportedWeb browser version. SeeOperating Environment for details.
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1. Accessing Dashboards and Slideshows

WARNING
INACCURATE DATA RESULTS
• Do not incorrectly configure the software or the devices.
• Do not base your maintenance or service actions solely onmessages and information
displayed by the software.

• Do not rely solely on softwaremessages and reports to determine if the system is functioning
correctly or meeting all applicable standards and requirements.

• Consider the implications of unanticipated transmission delays or failures of communications
links.

Failure to follow these instructions can result in death, serious injury, equipment
damage, or permanent loss of data.

Use the Dashboards application to view high level historical and real-time data, for example Key
Performance Indicators (KPIs). The information in the Dashboards application is accessed through
dashboards with gadgets. Dashboards are saved in the Dashboard Library. In addition to viewing
individual dashboards, you can create slideshows to automatically display a sequence of
dashboards.

TIP: You can open the Dashboards application from theDashboards link in theWeb Applications
banner.

For information on how use the Dashboards application, see:

l Viewing Dashboards

l Dashboard Slideshows

l Playing a Slideshow

Formore information on this feature, see theEcoStruxure™PowerMonitoring Expert 9.0 System
Guide.

Viewing Dashboards
View Dashboards tomonitor key performance indicators, historical trends, and other high-level
information for themonitored power system. Dashboards are one of themain applications for
viewing power system information.

To view aDashboard:

1. In Dashboards, open an existing Dashboard from the Dashboard Library or add a new Dash-
board.

2. View the Dashboard Gadgets displayed in the Dashboards display pane.

Related topics:

l Viewing Dashboards

l Dashboard Slideshows



l Playing a Slideshow

Dashboard Slideshows
Use slideshows to create collections of dashboards that are displayed in sequence without user
interaction. A slideshow displays each of its dashboards for a short period of time and then displays
the next dashboard. When it reaches the end, it starts over again with the first dashboard. It
continuously cycles through all its dashboards in this way. Slideshows are a good option for
unattended, kiosk type displays. See Configuring a slideshow for more details.

Related topics:

l Viewing Dashboards

l Dashboard Slideshows

l Playing a Slideshow

Playing a Slideshow
Slideshows are a good option for unattended, kiosk type displays.

To play a Slideshow:

1. In Dashboards, open the Dashboards Library, and click Slideshow Manager in theOptions
menu at the top of the Dashboard Library. This opens the Slideshow Manager window.

2. In Slideshow Manager, select the slideshow you want to view, and click Play. This opens a
new browser window, playing the slideshow.

3. Return to the original browser window and click Close in the Slideshow Manager to close it.
The slideshow continues to play in the new browser window until you close that window.

Related topics:

l Viewing Dashboards

l Dashboard Slideshows

l Playing a Slideshow
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2. Accessing Reports

WARNING
INACCURATE DATA RESULTS
• Do not incorrectly configure the software or the devices.
• Do not base your maintenance or service actions solely onmessages and information
displayed by the software.

• Do not rely solely on softwaremessages and reports to determine if the system is functioning
correctly or meeting all applicable standards and requirements.

• Consider the implications of unanticipated transmission delays or failures of communications
links.

Failure to follow these instructions can result in death, serious injury, equipment
damage, or permanent loss of data.

Use the Reports application to generate historical data reports. You can view the reports in PME, or
download them in different formats for sharing or storing externally. To generate a report, you can
either run it manually, setup an automatic schedule, or define trigger events such as a system
disturbance.

Reports are based on historical data that is stored in the PME database. A report can simply display
the historical data or it can process data to show patterns and relationships. The Tabular Report is
an example of a simple report that shows data in a table. The Energy Modeling report is an example
of a report that processes different types of input data to produce predictions and comparisons
displayed in chart and diagram formats.

Reports are generated based on report templates. PME provides a wide range of default templates.
You can change the colors and logo used for these templates. To customize the types of inputs or
outputs of the default templates you need to create custom templates. Creating custom templates
requires engineering work outside of PME.

The Reports user interface (UI) has twomain areas: the Report Library and the Reports Display. To
see a report in the Reports Display, you select the report in the Report Library.

TIP: You can open Reports from theREPORTS link in theWeb Applications banner.

For more information see:

l Generating a report

l Downloading a report

Report templates
The report templates that are included with PME by default cover a wide range of applications. The
templates are grouped into folders based on application. Choose the templates that best meet your
reporting needs. See theEcoStruxure™PowerMonitoring Expert 9.0 System Guide for more
information on Report templates.



NOTE: Some report templates are part of add-on softwaremodules for PME and are enabled
through themodule licenses.

Subscriptions
Subscribe to a report to have it generated automatically based on a schedule or on a trigger event.
For example, you can subscribe to a report and have it generated daily at a certain time, or monthly
on a certain day and time. A trigger event can be any event in the system, for example a device
setpoint going active, or a breaker tripping.

Ownership and Sharing
Reports can bemade Private or Public. A Private report can only be seen by the person who created
it and by users with Supervisor access permissions. A Public report is visible to all users,
regardless of their access levels. By default, a report is only visible in the user group where it was
created. Tomake a report visible to other user groups, you have to Share the report with this user
group.

For more information on this feature, see theEcoStruxure™PowerMonitoring Expert 9.0 System
Guide.

Generating a report
Generate a report to view powermonitoring system information.

To generate a report:

1. In Reports, open the Report Library and navigate to the report or the report template you want
to generate.

2. Click the report name to display the report in the Reports Display pane.

3. Set the input parameters for the report and click Generate Report.

NOTE: If you chose a report, then the saved input parameters are set to their saved values.
If you chose a report template, then all input parameters are unselected or have generic
default values.

4. The report output is displayed in the Reports Display pane.

Related topics:

l Generating a report

l Downloading a report

Downloading a report
Download a report in one of the supported formats (PDF, Excel, Tiff Image) to share the report
output with others, or to save it externally

To download a report:

1. In Reports, generate a report.
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2. In the Reports Display pane, view the generated report and click Download report as on the
toolbar immediately above the report output. Choose the format you want to download the
report in.

3. The report is downloaded in the selected format.

Related topics:

l Generating a report

l Downloading a report



3. Accessing Alarms
Alarms are automatically transferred from PME to Building Operation through EWS, and appear with
all other alarms in the Alarms pane, when both the Interface and the Alarm Polling are enabled.

NOTE: To verify that the Interface and the Alarm Polling are enabled: In the System Tree, right-
click on theEnergy Expert > EWS Client folder, and then select Properties.

WARNING
INACCURATE DATA RESULTS
• Do not incorrectly configure the software or the devices.
• Do not base your maintenance or service actions solely onmessages and information
displayed by the software.

• Do not rely solely on softwaremessages and reports to determine if the system is functioning
correctly or meeting all applicable standards and requirements.

• Consider the implications of unanticipated transmission delays or failures of communications
links.

Failure to follow these instructions can result in death, serious injury, equipment
damage, or permanent loss of data.

To view the Alarms for this client:

1. Log into Building OperationWorkStation

2. Scroll down to the Alarms viewer pane at the bottom of the dialog to see all active alarms,

The Building Operation “Sum Alarm” is an ideal way to leverage alarms flowing from EWS. It allows
the users to create actions and notifications on filtered PME alarms. See theEcoStruxure Building
Operation System ReferenceGuide for more information.
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4. Accessing EWS real-time values (only for Architecture 2
solutions)

The Energy Expert folder that you imported into Building Operation contains groups, devices and
measurements within the EWS Client folder.

WARNING
INACCURATE DATA RESULTS
• Do not incorrectly configure the software or the devices.
• Do not base your maintenance or service actions solely onmessages and information
displayed by the software.

• Do not rely solely on softwaremessages and reports to determine if the system is functioning
correctly or meeting all applicable standards and requirements.

• Consider the implications of unanticipated transmission delays or failures of communications
links.

Failure to follow these instructions can result in death, serious injury, equipment
damage, or permanent loss of data.

To access EWS real-time values:

1. Log in to Building OperationWorkStation.

2. In the System Tree, navigate to the Energy Expert folder and click the EWS Client folder. The
EWS Client tab appears.



3. Click the “+” icon next to each subfolder in the System Tree to expand the contents of each,
and then click on an item in the subfolder. The List View appears in the right pane and shows a
list of measurements for that item.

4. Double-click a device to view the complete list of measurements for that device.

5. In the EWS Client pane, right-click on a column heading, and then select Add/Remove
Columns.

6. Select the check box next to Value and EWS State. Now, the two new columns with data
appear.

NOTE: The default refresh rate for EWS values is set to 20 seconds.

NOTE: If you find that somemeasurements for a device aremissing from the list of
measurements, do the following:
Confirm that all of themeasurements you want for that device are exposed. SeeModifying which
measurements EWS Server exposes by default for details. If all of themeasurements you want for
the device are exposed but still do not appear in the list of measurements, repeat the procedure to
create and host the EWS interface. (PME takes some time between enabling the EWS server and
when the EWS client shows the exposedmeasurements.) See Creating and hosting the EWS
interface in Building OperationWorkstation for details.
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5. Accessing device diagrams (only for Architecture 2 solutions)
You can access PME device diagrams from within Building Operation in order to view graphical data
for the device data you imported.

WARNING
INACCURATE DATA RESULTS
• Do not incorrectly configure the software or the devices.
• Do not base your maintenance or service actions solely onmessages and information
displayed by the software.

• Do not rely solely on softwaremessages and reports to determine if the system is functioning
correctly or meeting all applicable standards and requirements.

• Consider the implications of unanticipated transmission delays or failures of communications
links.

Failure to follow these instructions can result in death, serious injury, equipment
damage, or permanent loss of data.

To access device diagrams

1. Log in to Building OperationWorkStation.

2. In the System Tree, navigate to Energy Expert and click the Diagram Links folder. You will
find a list of WebDiagram links in the Diagram Links pane at the right for the default WebDia-
grams that you selected and exported with the Integration Utility.



3. In the Diagram Links tab, double-click aWebDiagram file. TheWebDiagram graphic opens
for this device.

4. Select the different tabs in theWebDiagram screen to view other data values for this device.
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Reference
This chapter contains specific information on technical details related to the Energy Expert solution.
This information is referenced in the other sections of this document.

Use the links below to find the item you are looking for:

Add-on device drivers for PME
Advanced ETLConfiguration
Configuring the PME EWS server for HTTPS
Database growth calculations
Default device type support
Deploying and configuring aMulti-input Setpoint Display Bar graphic component
Deploying and configuring a Single-input Thermometer graphic component
Exposing custom device driver measurements through EWS
Manual integration steps without using the Integration Utility
PME IP Port Requirements
Setting SQL Server memory options
Terms and definitions
Time synchronization for ION meters
Web Applications Settings
Web security changes
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Add-on device drivers for PME
You can download add-on device drivers from the Exchange community. See Resources for
contact information.

For devices, for which default drivers or downloadable add-on drivers do not exist, you can use the
Device Type Editor (DTE) tool in PME to create custom device drivers. For more information on this
feature, see theEcoStruxure™PowerMonitoring Expert 9.0 System Guide.



Advanced ETL Configuration
Position Counters

Position counters keep track of the data that is extracted from EBO and then loaded intoPME. Each
Trend log specified in ETL has a position counter associated with it. The position counter represents
a timestamp of themost recent data point loaded for each Trend log. When ETL is run, only data
after this timestamp value is extracted from the EBO Trend log.

To view the position counters for themapped Trend logs:

l Click the Positions tab. The Positions tab appears showing the position counters.

Resetting and resending the data (optional)

If you need to re-extract previously extracted data, or if you want to load data after a specific date,
you canmanually update the position counter. Otherwise, manually updating the position counter is
not necessary.

To reset and resend the data for themapped Trend logs:

1. Enter a specific value in the text box to set all position counters.

2. Click Initialize. Mapped Trend logs appear with associated timestamp data for each.

Now, the next time you run ETL, only data after the given timestamp is loaded.

Logging set up
The Logging feature allows you to enable the various logs where ETLwrites the information
regarding the status of your ETL job. These logs can help when searching for the cause of an
unsuccessful ETL job.

To enable the ETL logs:
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1. Select the applicable job in ETL from the dropdownmenu and click Edit.

2. Click the Logging tab. The Logging tab appears.

3. Select the Enabled checkbox for the Trace Log, Error Log, Customer Log, andWindows Event
Log as required.

4. Provide the location for the log file in the Log File field, or leave at the default location.

5. Set theMaximum Log File Size andMaximum Log Files for each log, or leave at the default
settings.

6. If required, select the Enabled checkbox for Email Notifications and complete the fields for To
Email Address, From Email Address, and SMTP Server Address.

7. Click OK to save and exit the job.

Extract task: Setting parameters and recommended values

Extract task settings

Setting
Name

Description Setting Parameters / Recommended Values

Web
Service

Number
of threads
to use

Themaximum number of threads
to use when contacting the EWS
server for the list of Trend logs.
Set value to 4 for most cases,
however, set value to a lower
number if the EWS server is
overwhelmed with requests.

Enter a value of 4.



Setting
Name

Description Setting Parameters / Recommended Values

Timeout
(in
minutes)
for EWS
response

The length of time (in minutes) to
wait for a response from the EWS
server when requesting
information.

Enter a value of 10.

Web
Service
User
Name

The user name forWeb Service. Provide EBOWorkstation user name.

Web
Service
Password

Password for theWeb Service
user name.

Provide EBOWorkstation password.

Web
Service
URL

The URL of the EcoStruxureWeb
Service called by this task.

Provide URL information. Default URL

http://localhost:8080/EcoStruxure/DataExchange.
Replace “localhost:8080” with your web server
address and port as needed.

Reading
Interval

Interval
Length
Discovery

When set to True, allows the
extract task to determine the
reading interval for each pair
based on each pair's data.

Set to 'True'

Record
State
Filter

Limit
Results
Based on
Record
State

When set to True, enables a
check on record state. Only
records with a specified record
state will be used. all other
records will be ignored. When set
to false, check is disabled and all
records regardless of their record
state are used.

Set to 'False'

Allowed
Record
State

Sets the specific record check to
be used by the Limit Results
Based on Record state setting.
Record states can beGood,
Uncertain, Forced, Offline, or
Error.

Value not used if Limit Results setting is 'False'.
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Transform task: Setting parameters and recommended values

Transform task settings

Setting
Name

Description
Setting Parameters /
Recommended Values

Transform

Intervalization
Method

Specifies themethod used when converting
the values from an irregular interval into a
regular interval.

Use default 'Last Known Value'
setting

Intervalize to
present time

When set to True, the data is intervalized up
to the current system time. If set to false,
the data is intervalized up to themost
recent data point.

Set value to “False”

Target
Reading
Interval
(minutes)

Data is intervalized to a reading interval
specified in this field.

Interval value in minutes. Select a
value from the dropdown list.
Default value of 15minutes is
suitable in most cases.

Load task: Setting parameters and recommended values

Load task settings

NOTE: Youmust set the Enable Recorder and Channel Creation parameter to ‘True’ in order for
some Energy-related reports to run:

Setting Name Description
Setting Parameters /

Recommended Setting
Database Settings

SQL Command
Timeout

Time in seconds before stopping a SQL
command attempt and generating a
message.

Default value is 3600 seconds
(1 hour).

Database Settings
(ApplicationModules)

Connection string to the Application
Modules database

Provide connection information
to ApplicationModules
database for your system.
Information can be found
through SQL Management
Studio.

Database Settings
(ION_Data)

Connection string to the ION_Data
database

Provide connection information
to ION_Data database for your
system. Information can be
found through
SQL Management Studio.



Setting Name Description
Setting Parameters /

Recommended Setting

Database Settings
(ION_Network)

Connection string to the ION_
Network_Database where source
information should be loaded. Only
applicable if the Enable Network
Database Source Creation setting is
True.

Provide connection information
to ION_Network database for
your system. Information can
be found through
SQL Management Studio.

Group NameSettings

Add the 'Group Name'
Prefix to Sources if
Needed

When set to 'True', the task adds a
group name prefix to all sources that do
not already have one. When set to
'False', a group name prefix will not be
added.

Set to 'False'.

Group Name
The name provided in this setting is
used as the Group Name prefix setting
described above.

If the previous setting is 'False',
this setting does not need to be
filled in.

Mapping Options –
Source andQuantity
End Names
Populate Button –
Automatically Set
Quantity ‘End Names’
to ‘Start Names’

Set to ‘False’.

Populate Button –
Automatically Set
Source ‘End Names’ to
‘Start Names’

Set to ‘False’.

Null Values

Allow Null Values

When set to 'False' the task ignores
any null values. When set to 'True', the
null values are inserted into the
database.

Set to 'False'.

Overwrite Values
Allow existing values
to be overwritten.

Set to ‘False’.

Recommended
Source-Quantity Pairs
Settings
Limit Recommended
Pairs to Known
Quantities

Set to ‘True’.

Recorders and
Channels
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Setting Name Description
Setting Parameters /

Recommended Setting

Enable Recorder and
Channel Creation

When set to 'False', the task does not
create recorders and channels while
inserting data. Some reports require
that the parameter is set to ‘True’ to
run.

Set to ‘True’.

Set the
ISCurrentConfiguration
Flag to False for New
Channels

 Leave this default setting to
‘True’.

Source andQuantity
Creation Settings

Enable Quantity
Creation

When set to 'False' disables creating
quantities if they are not already in the
database.

Set to 'False'.

Enable Source
Creation in ION_Data

When set to 'True', the setting enables
the creation of sources that are not
already in the ION_Data database.

Set to 'True'.

Enable Source
Creation in ION_
Network

When set to 'True', the setting enables
the creation of sources that are not
already in the ION_Network database.

Set to 'True'.

Set Active Flag for All
New Sources

When set to 'True', all new sources are
marked as Active.

Set to 'True'.

Set Measurement
Descriptive Name

When set to 'True', enables setting the
descriptive name of new
measurements.

Set to 'True'.

Set Measurement
Engineering Name

When set to 'True', enables setting the
engineering name of new
measurements.

Set to 'True'.

Source Namespace
Settings

Source Namespace
Override

Namespace given to all sources that
do not have a namespace or that are
created during the Load Task.

IONEnterprise

Source Type Settings

Override Source Type
When set to 'True', enables the use of
the Source TypeOverride value when
creating sources.

Set to 'True'.

Source TypeOverride
The source type to use when creating
sources.

Presumed downstream device.



Manage ETL jobs
You can set up logging to helpmanage ETL jobs. You can also switch between ETL jobs, change
the order of ETL tasks, and remove ETL tasks from an ETL job.

Switching between ETL jobs

1. Click OK at the bottom right to save and exit the current job.

2. In the Job Management list select an ETL job and click Edit.

Removing a task from an ETL job

1. In the Job Management list click the applicable ETL job and then click Edit.

2. Click the Tasks tab.

3. Highlight the task that you want to remove from the left pane.

4. Click Delete

5. Click OK to save and exit the job.

Tips for working with mappings
Loading sources can return thousands of rows. To help youmanage a large result set, the
ETL Administration Tool includes several features to help you search, filter, and update loaded
sources.

Highlighting rows

Highlighting a source row lets you work with that source. When you highlight a row you can copy,
include or exclude the row from the ETL job, or perform a batch edit on the row.

To highlight a row:

1. Click the row.

To highlight successive rows:

1. Click the row.

2. Press Shift and click another row.

To highlight non-successive rows:

1. Press Ctrl and click the desired rows.

To highlight all rows:

1. Press Ctrl + A.

Batch Edits

A batch edit lets you update all highlighted rows at once.
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To perform a batch edit:

1. In theMappings pane highlight the rows you want to edit.

2. Right-click and click Batch Edit.

The Batch Edit Mappings dialog appears.

3. Complete all applicable fields in the dialog as needed.

NOTE: You have to complete the Target Device and Target Measurement fields before you
can select Included for the row.

4. While the rows are still highlighted, right-click and click Include Selected Mapping(s). The
Included check box is checked for the selected rows and these devices are included in the
job.

5. Click OK, and then click Apply to save the changes to the job. The Batch Edit values appear
for the selected rows.

Sorting contents by column

To sort contents by column:

1. Right-click a column heading and from the sort menu choose to sort column contents by
ascending or descending order.

Searching by column

To search by column:

1. Click in the Auto Filter Row (search field below a column heading.)

2. Begin typing characters. Column contents appear based on the search criteria you enter. Note



that characters are not case sensitive.

Filtering content by column

To filter the contents by column:

1. Click the filter symbol to the right of the column heading, and then choose (Custom), (Blanks),
(Non blanks), Checked, Unchecked, or a specific device.

2. If you choose (Custom), you can define a unique filter, based on your input, in the Custom
AutoFilter dialog. Complete the fields in the dialog and then click OK.

Filtering content using the Filter Editor

To filter the contents using the Filter Editor:

1. Right-click the column header you want to filter and them click Filter Editor.

Youmust complete the Target Device and Target Measurement fields before you can select
Included for the row.

2. Click an operator or enter a filter value.

3. Click Apply.

The sources are filtered based on the filtering criteria you enter.

4. Click OK to return to theMappings tab.
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Copying and pasting devices

You can select and copy one or more devices and paste that data into a document, such as a text
editor or a spreadsheet.

To copy and paste devices into a document:

1. In theMappings tab select one or more device rows.

2. Press CTRL+C or right-click and click Copy.

3. Open your document and place the cursor where you want to paste.

4. Press CTRL+V or right-click and click Paste.

The device data appears in the document.

Grant database permissions for ETL job run as a service
By default, when an ETL job is run as a service it runs under the NT AUTHORITY\SYSTEM
Windows user account.

With SQL Server 2012 and later, the NT AUTHORITY user does not have database permissions. If
an ETL job is run using the NT AUTHORITY user, the ETL cannot connect to the PowerMonitoring
Expert database and the ETL job fails.

For the ETL job to succeed, youmust first grant database permissions to this user.

To grant database permissions to the NT AUTHORITY user, log in to SQL Server Management
Studio as an administrator and run the following script:

USE [ION_Data]

GO

CREATE USER [NT AUTHORITY\SYSTEM] FOR LOGIN [NT AUTHORITY\SYSTEM]

GO

EXEC sp_addrolemember N’db_owner’, N’NT AUTHORITY\SYSTEM’

GO

USE [ION_Network]

GO

CREATE USER [NT AUTHORITY\SYSTEM] FOR LOGIN [NT AUTHORITY\SYSTEM]

GO

EXEC sp_addrolemember N’db_owner’, N’NT AUTHORITY\SYSTEM’

GO

NOTE: If security concerns limit you from using the default NT AUTORITY user, create a
dedicatedWindows user to run the ETL job as a service.

To use a dedicatedWindows user:

1. Create aWindows user. Note that if the ETL is installed to its default location – C:\Program
Files\... – theWindows user must have Administrator access.

2. Set the ETL job to run as a service under the new Windows user.



3. Log in to SQL Server Management Studio as an administrator and run the above script, sub-
stituting NT AUTHORITY\SYSTEM with the new Windows user

Measurement mapping for ETL
This table describes the suggestedmappings for supported EBO values:

Descriptive Name Unit Name Unit Symbol Suggested Mappings
Absolute voltage in dB dBuV
AbsoluteHumidityMass kg/kg

lb/lb

Acceleration
meters per
second squared

m/s²

feet per second
squared

ft/s²

inches per
second squared

in/s²

Acidity pH
Angle radian rad

deg

Fundamental Current Angle A
Fundamental Current Angle B
Fundamental Current Angle C
Fundamental Current Angle N
Fundamental Current Angle G

grad
Angular momentum joule second Js
Area squaremeter m²

square inch in²
square foot ft²
square yard yd²
acre a.
squaremile mile²

Capacitance farad F

Compressibility
meters squared
per Newton

m²/N

Conductance siemens S

Conductivity
siemens per
meter

S/m

Corrosion Rate m/yr
in/yr
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Descriptive Name Unit Name Unit Symbol Suggested Mappings

Currency currency1

Energy Cost
Energy Cost AUD
Energy Cost EUR
Energy Cost GBP
Energy Cost CNY

currency2
currency3
currency4
currency5
currency6
currency7
currency8
currency9
currency10

Current A

Current Phase Average
Current Phase A
Current Phase B
Current Phase C
Neutral Current
Ground Current

Current Density A/m² Current Density (A/m^2)

Density
grams per cubic
meter

g/m³

pounds per cubic
inch

lb/in³

pounds per cubic
foot

lb/ft³

Diffusivity
meters squared
per second

m²/s

foot squared per
second

ft²/s

Dipole Moment debye
coulombmeter

Electrical Field
Strength

V/m

Energy J

Wh

Active Energy Delivered (kWh)
Active Energy Received (kWh)
Active Energy Delivered-Received
(kWh)



Descriptive Name Unit Name Unit Symbol Suggested Mappings

Btu

Water Heat Flow (BTU 59)
Energy Consumption (BTU ISO)
Air Heat Flow (BTU 59)
Air Heat Flow (BTU ISO)
Natural Gas Energy Flow (BTU 59)
Natural Gas Energy Flow (BTU ISO)
Steam Heat Flow (BTU 59)
Steam Heat Flow (BTU ISO)
Hot Water (Btu)
Gas btus

cal
thermal
tonh

Energy Apparent Vah
Apparent Energy Received (KVAh)
Apparent Energy Delivered-Received
(KVAh)

Energy Reactive Varh

Reactive Energy Delivered (kVarh)
Reactive Energy Received (kVarh)
Reactive Energy Delivered-Received
(kVarh)

Enthalpy J/kg Specific Enthalpy (J/kg)
Btu/lb Specific Enthalpy (BTU 59/lb av)

Enthalpy Dry Air J/kg dry air Specific Enthalpy Dry Air (J/kg)

Btu/lb dry air
Specific Enthalpy Dry Air (BTU 59/lb
av)

Entropy J/K

Flow
cubic meters per
second

m³/s

Steam Volume Flow Rate (m^3/s)
Water Volume Flow Rate Supply
(m^3/s)
Water Volume Flow Rate Return
(m^3/s)
Water Volume Flow Rate (m^3/s)
Air Volume Flow Rate (m^3/s)
Natural Gas Volume Flow Rate
(m^3/s)
Wastewater Volume Flow Rate
(m^3/s)
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Descriptive Name Unit Name Unit Symbol Suggested Mappings

cubic meters per
minute

m³/min

Steam Volume Flow Rate (m^3/min)
Water Volume Flow Rate Supply
(m^3/min)
Water Volume Flow Rate Return
(m^3/min)
Water Volume Flow Rate (m^3/min)
Air Volume Flow Rate (m^3/min)
Natural Gas Volume Flow Rate
(m^3/min)
Wastewater Volume Flow Rate
(m^3/min)

cubic meters per
hour

m³/h

Steam Volume Flow Rate (m^3/h)
Water Volume Flow Rate Supply
(m^3/h)
Water Volume Flow Rate Return
(m^3/h)
Water Volume Flow Rate (m^3/h)
Air Volume Flow Rate (m^3/h)
Natural Gas Volume Flow Rate
(m^3/h)
Wastewater Volume Flow Rate
(m^3/h)

cubic feet per
second

ft³/s

Steam Volume Flow Rate(cf/s)
Water Volume Flow Rate Supply
(cf/s)
Water Volume Flow Rate Return
(cf/s)
Water Volume Flow Rate (cf/s)
Air Volume Flow Rate (cf/s)
Air Volume Flow Rate (scf/s)
Natural Gas Volume Flow Rate (cf/s)
Natural Gas Volume Flow Rate
(scf/s)
Wastewater Volume Flow Rate (cf/s)



Descriptive Name Unit Name Unit Symbol Suggested Mappings

cubic feet per
minute

ft³/min

Steam Volume Flow Rate(cf/min)
Water Volume Flow Rate Supply
(cf/min)
Water Volume Flow Rate Return
(cf/min)
Water Volume Flow Rate (cf/min)
Air Volume Flow Rate (cf/min)
Air Volume Flow Rate (scf/min)
Natural Gas Volume Flow Rate
(cf/min)
Natural Gas Volume Flow Rate
(scf/min)
Wastewater Volume Flow Rate
(cf/min)

cubic feet per
hour

ft³/h

Steam Volume Flow Rate(cf/h)
Water Volume Flow Rate Supply
(cf/h)
Water Volume Flow Rate Return
(cf/h)
Water Volume Flow Rate (cf/h)
Air Volume Flow Rate (cf/h)
Air Volume Flow Rate (scf/h)
Natural Gas Volume Flow Rate (cf/h)
Natural Gas Volume Flow Rate
(scf/h)
Wastewater Volume Flow Rate (cf/h)

gallons per
second

Usgal/s

Water Volume Flow Rate Supply
(gal/s)
Water Volume Flow Rate Return
(gal/s)
Water Volume Flow Rate (gal/s)
Wastewater Volume Flow Rate
(gal/s)

Flow
gallons per
minute

Usgal/min

Water Volume Flow Rate Return
(gal/min)
Water Volume Flow Rate Return
(gal/min)
Water Volume Flow Rate (gal/min)
Wastewater Volume Flow Rate
(gal/min)
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Descriptive Name Unit Name Unit Symbol Suggested Mappings

gallons per hour Usgal/h

Water Volume Flow Rate Supply
(gal/h)
Water Volume Flow Rate Return
(gal/h)
Water Volume Flow Rate (gal/h)
Wastewater Volume Flow Rate
(gal/h)

liters per second l/s

Water Volume Flow Rate Supply (L/s)
Water Volume Flow Rate Return (L/s)
Water Volume Flow Rate (L/s)
Wastewater Volume Flow Rate (L/s)

liters per minute l/min

Water Volume Flow Rate Supply
(L/min)
Water Volume Flow Rate Return
(L/min)
Water Volume Flow Rate (L/min)
Wastewater Volume Flow Rate
(L/min)

liters per hour l/h

Water Volume Flow Rate Supply (L/h)
Water Volume Flow Rate Return (L/h)
Water Volume Flow Rate (L/h)
Wastewater Volume Flow Rate (L/h)

liq oz/s

Water Volume Flow Rate Supply (fl
oz imp/s)
Water Volume Flow Rate Return (fl
oz imp/s)
Water Volume Flow Rate (fl oz imp/s)
Wastewater Volume Flow Rate (fl oz
imp/s)

imperial gallons
per minute

Ukgal/min

Water Volume Flow Rate Supply (gal
imp/min)
Water Volume Flow Rate Return (gal
imp/min)
Water Volume Flow Rate (gal
imp/min)
Wastewater Volume Flow Rate (gal
imp/min)

Flow RateMass g/s
lb/s
oz/s
g/min
g/h
lb/min



Descriptive Name Unit Name Unit Symbol Suggested Mappings
Uston/h

Force N
lbf

Frequency Hz

Frequency (Hz)
Frequency (MHz)
Frequency (kHz)
Frequency (MHz)

cycles/min
cycles/h
/s
/min
/h

Frequency %/s

Grammage (GSM) g/m²

Grammage (GSM) (g/m²)
Grammage (GSM) (mg/m²)
Grammage (GSM) (kg/m²)
Grammage (GSM) (Mg/m²)

Heat Capacity J/(g·C) Specific Heat Capacity (J/(g deg C))

Btu/(lb·F)
Specific Heat Capacity (BTU 59/(lb
av deg F))

Heat Degree Days °Cdays Heating Degree Days Celsius
°Fdays Heating Degree Days Fahrenheit

Heat Flux W/m²
Btu/(s·ft²)
W/ft²

Heat Transfer
Coefficient

W/(m²·K)
Heat Transfer Coefficient (W/(m^2
K))

Btu/(s·ft²·K)
Heat Transfer Coefficient (BTU 59/(s
ft^2 K))

Humidity % Rh

Relative Humidity (Hour Interval)
Air Relative Humidity Supply
(percent)
Air Relative Humidity Return
(percent)
Air Relative Humidity Mixed (percent)
Weather Relative Humidity
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Descriptive Name Unit Name Unit Symbol Suggested Mappings

Illuminance lux lx

Illuminance (lx)
Illuminance (Mlx)
Illuminance (Klx)
Illuminance (Mlx)
Global Horizontal Illuminance (Hour
Interval)
Direct Normal Illuminance (Hour
Interval)
Diffuse Horizontal Illuminance (Hour
Interval)

ft·cd

Candelas per sq.
meter

H

Illuminance (H)
Illuminance (mH)
Illuminance (kH)
Illuminance (MH)

Inductance henry H
Length meter m

inch in
foot ft
yard yd
mile mile

Linear Momentum Newton Second Ns

Luminance
candelas per
squaremeter

cd/m²

Luminous Flux lm
Luminous Intensity cd
Magnetic Dipole
Moment

A·m²

Magnetic Field
Strength

A/m

Magnetic Flux Wb
Magnetic Flux Density T
Mass gram g

pound lb
ounce oz

carat
grains
USTon

Mass Transfer
Coefficient

(mol/(s·m²))/
(mol/m³)
(mol/(s·ft²))/
(mol/ft³)



Descriptive Name Unit Name Unit Symbol Suggested Mappings
Mass Velocity g/(s·m²)

lb/(s·ft²)
Moles mole mol

lbmol
Moment of Inertia g/m²

lb/ft²
Momentum g·m/s

lb·ft/s
NoCategory NoUnit

?
Percent Obscuration %/m

%/ft

Percentage %
Damper Position (percent)
Valve Position (percent)

ppm
CO₂Concentration Indoor (ppm)
CO₂Concentration Outdoor (ppm)

ppb
Phase deg

Power W
Active Power Phase B (kW)
Active Power Phase A (kW)
Active Power Phase C (kW)

VA
Apparent Power Phase A (KVA)
Apparent Power Phase B (KVA)
Apparent Power Phase C (KVA)

Btu/s
hp

Btu/h

Water Heat Flow Rate (BTU 59/h)
Water Heat Flow Rate (BTU ISO/h)
Energy Consumption Rate (BTU
59/h)
Energy Consumption Rate (BTU
ISO/h)
Air Heat Flow Rate (BTU 59/h)
Air Heat Flow Rate (BTU ISO/h)
Natural Gas Energy Flow Rate (BTU
59/h)
Natural Gas Energy Flow Rate (BTU
ISO/h)
Steam Heat Flow Rate (BTU 59/h)
Steam Heat Flow Rate (BTU ISO/h)

tons refrig
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Descriptive Name Unit Name Unit Symbol Suggested Mappings

Power Factor cosf
Power Factor Signed Phase A
Power Factor Signed Phase B
Power Factor Signed Phase C

Power Reactive var
Reactive Power Phase A (kvar)
Reactive Power Phase B (kvar)
Reactive Power Phase C (kvar)

Pressure N/m²

Air Pressure (N/m^2)
Natural Gas Pressure (N/m^2)
Steam Pressure (N/m^2)
Water Pressure Supply (N/m^2)
Water Pressure Return (N/m^2)
Water Pressure (N/m^2)

Pa

Air Pressure (Pa)
Natural Gas Pressure (Pa)
Steam Pressure (Pa)
Water Pressure Supply (Pa)
Water Pressure Return (Pa)
Water Pressure (Pa)
Water Pressure Differential (kPa)

psi

Air Pressure psi Natural Gas
Pressure (psi)
Steam pressure (psi)
Water Pressure Supply (psi)
Water Pressure Return (psi)
Water Pressure (psi)

mHg

Air Pressure (m Hg)
Natural Gas Pressure (N/m^2)
Steam Pressure (N/m^2)
Water Pressure Supply (N/m^2)
Water Pressure Return (N/m^2)
Water Pressure (N/m^2

inH₂0

Air Pressure (in H2O)
Natural Gas Pressure (in H2O)
Steam Pressure (in H2O)
Water Pressure Supply (in H2O)
Water Pressure Return (in H2O)
Water Pressure (in H2O)



Descriptive Name Unit Name Unit Symbol Suggested Mappings

bar

Air Pressure (bar)
Natural Gas Pressure (bar)
Steam Pressure (bar)
Water Pressure Supply (bar)
Water Pressure Return (bar)
Water Pressure (bar)
Water Pressure Differential (bar)
Air Pressure Absolute (bar)

Pressure mH₂0

Air Pressure (m H2O)
Natural Gas Pressure (m H2O)
Steam Pressure (m H2O)
Water Pressure Supply (m H2O)
Water Pressure Return (m H2O)
Water Pressure (m H2O)

inHg

Air Pressure (in Hg)
Natural Gas Pressure (in Hg)
Steam Pressure (in Hg)
Water Pressure Supply (in Hg)
Water Pressure Return (in Hg)
Water Pressure (in Hg)

db (SPL) Sound Pressure Level (dB)

Pressure Drop Per
Length

Pa/m

Air Pressure Drop Per Length (Pa/m)
Natural Gas Pressure Drop Per
Length (Pa/m)
Steam Pressure Drop Per Length
(Pa/m)
Water Pressure Supply Drop Per
Length (Pa/m)
Water Pressure Return Drop Per
Length (Pa/m)
Water Pressure Drop Per Length
(Pa/m)

psi/ft

Air Pressure Drop Per Length (psi/ft)
Natural Gas Pressure Drop Per
Length (psi/ft)
Steam Pressure Drop Per Length
(psi/ft)
Water Pressure Supply Drop Per
Length (psi/ft)
Water Pressure Return Drop Per
Length (psi/ft)
Water Pressure Drop Per Length
(psi/ft)
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Descriptive Name Unit Name Unit Symbol Suggested Mappings
Resistance ohm Ω Resistance
Resistivity ohmmeter Ωm
Specific Entropy J(g·K)

Btu/(lb·R)
J/(kg·K)

Specific Humidity
g H₂0/kg dry
air

Specific Volume m³/g
ft³/lb

Surface Energy
Density

J/m²

J/ft²
W/(h·m²)
W/(h·ft²)

Surface Tension N/m²
lbf/ft

Temperature °C

Weather Temperature CelsiusWater
Temperature (deg C)
Water Temperature Supply (deg C)
Water Temperature Return (deg C)
Water TemperatureMixed (deg C)
Air Temperature (deg C)
Air Temperature Return (deg C)
Air Temperature Supply (deg C)
Steam Temperature (deg C)
Compressed Air Temperature (deg C)
Natural Gas Temperature (deg C)
Steam Temperature (deg C)
Ambient Temperature Celsius
Temperature Celsius

K



Descriptive Name Unit Name Unit Symbol Suggested Mappings

°F

Weather Temperature Fahrenheit
Water Temperature (deg F)
Water Temperature Supply (deg F)
Water Temperature Return (deg F)
Water TemperatureMixed (deg F)
Air Temperature (deg F)
Air Temperature Return (deg F)
Air Temperature Supply (deg F)
Steam Temperature (deg F)
Compressed Air Temperature (deg F)
Natural Gas Temperature (deg F)
Steam Temperature (deg F)
Ambient TemperatureFahrenheit
Temperature Fahrenheit

Temperature Diff Δ°C

Weather Temperature Differential
(deg C)
Water Temperature Differential (deg
C)
Water Temperature Supply
Differential (deg C)
Water Temperature Return
Differential (deg C)
Water TemperatureMixed Differential
(deg C)
Air Temperature Differential (deg C)
Steam Temperature Differential (deg
C)
Temperature Differential (deg C)
Ambient Temperature Differential
(deg C)

ΔK
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Descriptive Name Unit Name Unit Symbol Suggested Mappings

Δ°F

Weather Temperature Differential
(deg F)
Water Temperature Differential (deg
F)
Water Temperature Supply
Differential (deg F)
Water Temperature Return
Differential (deg F)
Water TemperatureMixed Differential
(deg F)
Air Temperature Differential (deg F)
Steam Temperature Differential (deg
F)
Temperature Differential (deg F)
Ambient Temperature Differential
(deg F)

Temperature Rate of
Change

°C/min

Air TemperatureMixed Rate of
Change (deg C/min)
Air Temperature Rate of Change (deg
C/min)
Air Temperature Return Rate of
Change (deg C/min)
Air Temperature Supply Rate of
Change (deg C/min)
Ambient Temperature Rate of
Change (deg C/min)
Steam Temperature Rate of Change
(deg C/min)
Temperature Rate of Change (deg
C/min)
Water TemperatureMixed Rate of
Change (deg C/min)
Water Temperature Rate of Change
(deg C/min)
Water Temperature Return Rate of
Change (deg C/min)
Water Temperature Supply Rate of
Change (deg C/min)
Weather Temperature Rate of
Change (deg C/min

K/min



Descriptive Name Unit Name Unit Symbol Suggested Mappings

°F/min

Air TemperatureMixed Rate of
Change (deg F/min)
Air Temperature Rate of Change (deg
F/min)
Air Temperature Return Rate of
Change (deg F/min)
Air Temperature Supply Rate of
Change (deg F/min)
Ambient Temperature Rate of
Change (deg F/min)
Steam Temperature Rate of Change
(deg F/min)
Temperature Rate of Change (deg
F/min)
Water TemperatureMixed Rate of
Change (deg F/min)
Water Temperature Rate of Change
(deg F/min)
Water Temperature Return Rate of
Change (deg F/min)
Water Temperature Supply Rate of
Change (deg F/min)
Weather Temperature Rate of
Change (deg F/min)
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Descriptive Name Unit Name Unit Symbol Suggested Mappings

Temperature Rate of
Change

°C/h

Air TemperatureMixed Rate of
Change (deg C/h)
Air Temperature Rate of Change (deg
C/h)
Air Temperature Return Rate of
Change (deg C/h)
Air Temperature Supply Rate of
Change (deg C/h)
Ambient Temperature Rate of
Change (deg C/h)
Steam Temperature Rate of Change
(deg C/h)
Temperature Rate of Change (deg
C/h)
Water TemperatureMixed Rate of
Change (deg C/h)
Water Temperature Rate of Change
(deg C/h)
Water Temperature Return Rate of
Change (deg C/h)
Water Temperature Supply Rate of
Change (deg C/h)
Weather Temperature Rate of
Change (deg C/h)

K/h



Descriptive Name Unit Name Unit Symbol Suggested Mappings

°F/h

Air TemperatureMixed Rate of
Change (deg F/h)
Air Temperature Rate of Change (deg
F/h)
Air Temperature Return Rate of
Change (deg F/h)
Air Temperature Supply Rate of
Change (deg F/h)
Ambient Temperature Rate of
Change (deg F/h)
Steam Temperature Rate of Change
(deg F/h)
Temperature Rate of Change (deg
F/h)
Water TemperatureMixed Rate of
Change (deg F/h)
Water Temperature Rate of Change
(deg F/h)
Water Temperature Return Rate of
Change (deg F/h)
Water Temperature Supply Rate of
Change (deg F/h)
Weather Temperature Rate of
Change (deg F/h)

Thermal Conductance W/(m²·K)

Thermal Conductivity W/(m²·K/m)

Air Thermal Conductivity (W/(m K))
Water Thermal Conductivity (W/(m
K))
Steam Thermal Conductivity (W/(m
K))
Natural Gas Thermal Conductivity
(W/(m K))

Btu/(h·ft²·F/ft)

Air Thermal Conductivity (BTU 59/(h
ft deg F))
Water Thermal Conductivity (BTU 59/
(h ft deg F))
Steam Thermal Conductivity (BTU
59/(h ft deg F))
Natural Gas Thermal Conductivity
(BTU 59/(h ft deg F))

Thermal Linear
Expansion

m/C

in/F
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Descriptive Name Unit Name Unit Symbol Suggested Mappings
ft/F

Thermal Pressure psi/oF
Thermal Volume
Expansion

m³/C

in³/F
ft³/F

Thermoelectric Power V/K
Time year

month
week
day
h
min
s

Time Accuracy s/h
Torque Nm

lbf·in
lbf·ft

Turbidity NTU
Velocity m/s Air Velocity (m/s)

m/h Air Velocity (m/h)
mile/h Air Velocity (mile/h)
ft/s Air Velocity (ft/s)
ft/min Air Velocity (ft/min)
m/min Air Velocity (m/min)

Velocity Angular
radians per
second

rad/s

revolutions per
minute

RPM

Voltage V

Average Voltage Line-to-Neutral
Voltage Phases AB
Voltage Phases BC
Voltage Phases CA
Voltage Phases AN
Voltage Phases BN
Voltage Phases CN

Volume m³

Air Volume (m^3)
Steam Volume (m^3)
Wastewater Volume (m^3)
Water Volume (m^3)
Natural Gas Volume (m^3)



Descriptive Name Unit Name Unit Symbol Suggested Mappings
Volume in³

ft³

Air Volume (cubft)
Steam Volume (cf)
Wastewater Volume (cf)
Water Volume (cf)
Gas Volume (cf)

Usgal
Wastewater Volume (gal)
Water Volume (gal)

litre
Wastewater Volume (L)
Water Volume (L)

ETL tips and tricks

Performing a Batch Edit for Trend logs

To perform a Batch Edit (mapmultiple Trend logs at once):

1. Highlight multiple rows in theMappings tab by clicking and dragging downward the handles to
the left of the rows. To select all rows, press Ctrl+A.

2. Right-click and select Batch Edit. The Batch Edit Mappings dialog appears.

3. Complete all applicable fields in the dialog as needed.

Youmust complete the Target Device and Target Measurement fields before you can select
Included for the row.
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4. While the rows are still highlighted, right-click and select Include SelectedMapping(s). The
Included check box is now checked for the selected rows and these Trend logs are now
included in the job.

5. Click OK, and then click Apply to save the changes to the job. The Batch Edit values now
appear for the selected rows.

SeeMeasurement mapping for ETL to learn about themost common, supportedmeasurements in
used in PME and how to link to typical BuildingManagement tags.

Sorting contents by column

To sort contents by column:

l Right-click a column heading and choose from the sort menu to sort column contents by ascend-
ing or descending order.

Searching contents by column

To search the contents by column:

1. Click in the search field below a column heading.

2. Begin typing characters. Only column contents appear based on the search criteria you enter.
Note that characters are not case sensitive.



Searching Target Measurements by column

To search the Target Measurements by column:

1. Click in the search field below the column heading.

2. Begin typing characters. Only column contents appear based on the search criteria you enter.
Note that characters are not case sensitive.

SeeMeasurement mapping for ETL to learn about themost common, supportedmeasurements in
use in PME.

Filtering content by column

To filter the contents by column:

1. Click the filter symbol to the right of the column heading, and then choose (All), (Custom),
(Blanks), (Non blanks), or a specific Trend log.

2. If you choose (Custom), you can define a unique filter, based on your input, in the Custom
AutoFilter dialog. Complete the fields in the dialog and click OK.
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Copying and pasting Trend logs

You can select and copy one or more Trend logs from Building Operation and paste that data into a
document, such as a text editor or a spreadsheet.

To copy and paste Trend logs into a document:

1. Select one or more rows in theMappings tab.

2. Press Ctrl + C or right-click and choose Copy.

3. Open your document and place the cursor where you want to paste.

4. Press Ctrl + V or right-click and choose Paste.

5. The Trend log data appears in the document.

Finding and opening a Trend log in Building Operation

You can find and open a Trend log with the source tag path.

1. From the document created in the previous step Copy Source Tag(s) from the list.

2. Click in the Building Operation address bar.

3. Press Ctrl + V or right-click and choose Paste, and then press Enter. The Trend log opens.

Running a job manually

1. In the ETLConfiguration Job Configuration Tool screen, select a job to run from the JobMan-
agement drop-down list.

2. Click Control. The Job Control tab appears.

3. Click Run Once, and then click OK in the dialog when it appears. Wait until the output dialog
box appears (depending on your system size, this could take up to a few hours).

NOTE: To confirm the ETL job, look to see that the job executed successfully.

If the ETL Engine returns a Job execution failedmessage, click Open Log Folder in the dialog and
open the error log. Locate the timestamp that corresponds to your job and review the log. Based on
this information, make the appropriate changes to the job and then run the job again.

Running a job as a service

You can also set the job to run as a service. Using this method, the job automatically runs at set
times based on the settings you provide in the Job tab. Make sure to change the Sleep Time
Between Execution value (in seconds) if you require the service to be run on a schedule different
from the default value of 3600 seconds.

Refer to Grant database permissions for ETL job run as a service if SQL Server 2012 is installed in
your system and you want to run a job as a service.

To set the job to run as a service:

1. In the ETLConfiguration Job Configuration Tool screen, select a job to run from the JobMan-
agement drop-down list.

2. Click Control. The Job Control tab appears.



3. Click Register. ETL creates a registered service under the job name. Click OK in the dialog
when it appears. This option is available only after running a job successfully at least once.

4. Click Start/Continue to start the service.

5. Click Stop to stop the service, or click Unregister to unregister the service for this job.

6. Press OK to save and exit job.

Managing your ETL jobs

You can also switch between jobs, change task order and remove tasks from a job.

Switching between jobs

1. Click OK at the bottom right to save and exit the current job.

2. Select another job in the JobManagement drop-down list.

3. Click Edit.

Changing the order of tasks for a job

1. Select a job from the JobManagement drop-down list and click Edit.

2. Click the Tasks tab.

3. Highlight the task you want to move from the left pane.

4. Click the Up arrow or Down arrow icon tomove the task.

5. Press OK to save and exit job.

Removing a task from a job

1. Select a job from the JobManagement drop-down list and click Edit.

2. Click the Tasks tab.

3. Highlight the task you want to remove from the left pane.

4. Click the Delete icon. The task is removed from the pane.

5. Press OK to save and exit job.

Measurement mapping for ETL
This table describes the suggestedmappings for supported EBO values:

Descriptive Name Unit Name Unit Symbol Suggested Mappings
Absolute voltage in dB dBuV
AbsoluteHumidityMass kg/kg

lb/lb

Acceleration
meters per
second squared

m/s²

feet per second
squared

ft/s²

inches per
second squared

in/s²
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Descriptive Name Unit Name Unit Symbol Suggested Mappings
Acidity pH
Angle radian rad

deg

Fundamental Current Angle A
Fundamental Current Angle B
Fundamental Current Angle C
Fundamental Current Angle N
Fundamental Current Angle G

grad
Angular momentum joule second Js
Area squaremeter m²

square inch in²
square foot ft²
square yard yd²
acre a.
squaremile mile²

Capacitance farad F

Compressibility
meters squared
per Newton

m²/N

Conductance siemens S

Conductivity
siemens per
meter

S/m

Corrosion Rate m/yr
in/yr

Currency currency1

Energy Cost
Energy Cost AUD
Energy Cost EUR
Energy Cost GBP
Energy Cost CNY

currency2
currency3
currency4
currency5
currency6
currency7
currency8
currency9
currency10



Descriptive Name Unit Name Unit Symbol Suggested Mappings

Current A

Current Phase Average
Current Phase A
Current Phase B
Current Phase C
Neutral Current
Ground Current

Current Density A/m² Current Density (A/m^2)

Density
grams per cubic
meter

g/m³

pounds per cubic
inch

lb/in³

pounds per cubic
foot

lb/ft³

Diffusivity
meters squared
per second

m²/s

foot squared per
second

ft²/s

Dipole Moment debye
coulombmeter

Electrical Field
Strength

V/m

Energy J

Wh

Active Energy Delivered (kWh)
Active Energy Received (kWh)
Active Energy Delivered-Received
(kWh)

Btu

Water Heat Flow (BTU 59)
Energy Consumption (BTU ISO)
Air Heat Flow (BTU 59)
Air Heat Flow (BTU ISO)
Natural Gas Energy Flow (BTU 59)
Natural Gas Energy Flow (BTU ISO)
Steam Heat Flow (BTU 59)
Steam Heat Flow (BTU ISO)
Hot Water (Btu)
Gas btus

cal
thermal
tonh

Energy Apparent Vah
Apparent Energy Received (KVAh)
Apparent Energy Delivered-Received
(KVAh)
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Descriptive Name Unit Name Unit Symbol Suggested Mappings

Energy Reactive Varh

Reactive Energy Delivered (kVarh)
Reactive Energy Received (kVarh)
Reactive Energy Delivered-Received
(kVarh)

Enthalpy J/kg Specific Enthalpy (J/kg)
Btu/lb Specific Enthalpy (BTU 59/lb av)

Enthalpy Dry Air J/kg dry air Specific Enthalpy Dry Air (J/kg)

Btu/lb dry air
Specific Enthalpy Dry Air (BTU 59/lb
av)

Entropy J/K

Flow
cubic meters per
second

m³/s

Steam Volume Flow Rate (m^3/s)
Water Volume Flow Rate Supply
(m^3/s)
Water Volume Flow Rate Return
(m^3/s)
Water Volume Flow Rate (m^3/s)
Air Volume Flow Rate (m^3/s)
Natural Gas Volume Flow Rate
(m^3/s)
Wastewater Volume Flow Rate
(m^3/s)

cubic meters per
minute

m³/min

Steam Volume Flow Rate (m^3/min)
Water Volume Flow Rate Supply
(m^3/min)
Water Volume Flow Rate Return
(m^3/min)
Water Volume Flow Rate (m^3/min)
Air Volume Flow Rate (m^3/min)
Natural Gas Volume Flow Rate
(m^3/min)
Wastewater Volume Flow Rate
(m^3/min)

cubic meters per
hour

m³/h

Steam Volume Flow Rate (m^3/h)
Water Volume Flow Rate Supply
(m^3/h)
Water Volume Flow Rate Return
(m^3/h)
Water Volume Flow Rate (m^3/h)
Air Volume Flow Rate (m^3/h)
Natural Gas Volume Flow Rate
(m^3/h)
Wastewater Volume Flow Rate
(m^3/h)



Descriptive Name Unit Name Unit Symbol Suggested Mappings

cubic feet per
second

ft³/s

Steam Volume Flow Rate(cf/s)
Water Volume Flow Rate Supply
(cf/s)
Water Volume Flow Rate Return
(cf/s)
Water Volume Flow Rate (cf/s)
Air Volume Flow Rate (cf/s)
Air Volume Flow Rate (scf/s)
Natural Gas Volume Flow Rate (cf/s)
Natural Gas Volume Flow Rate
(scf/s)
Wastewater Volume Flow Rate (cf/s)

cubic feet per
minute

ft³/min

Steam Volume Flow Rate(cf/min)
Water Volume Flow Rate Supply
(cf/min)
Water Volume Flow Rate Return
(cf/min)
Water Volume Flow Rate (cf/min)
Air Volume Flow Rate (cf/min)
Air Volume Flow Rate (scf/min)
Natural Gas Volume Flow Rate
(cf/min)
Natural Gas Volume Flow Rate
(scf/min)
Wastewater Volume Flow Rate
(cf/min)

cubic feet per
hour

ft³/h

Steam Volume Flow Rate(cf/h)
Water Volume Flow Rate Supply
(cf/h)
Water Volume Flow Rate Return
(cf/h)
Water Volume Flow Rate (cf/h)
Air Volume Flow Rate (cf/h)
Air Volume Flow Rate (scf/h)
Natural Gas Volume Flow Rate (cf/h)
Natural Gas Volume Flow Rate
(scf/h)
Wastewater Volume Flow Rate (cf/h)
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Descriptive Name Unit Name Unit Symbol Suggested Mappings

gallons per
second

Usgal/s

Water Volume Flow Rate Supply
(gal/s)
Water Volume Flow Rate Return
(gal/s)
Water Volume Flow Rate (gal/s)
Wastewater Volume Flow Rate
(gal/s)

Flow
gallons per
minute

Usgal/min

Water Volume Flow Rate Return
(gal/min)
Water Volume Flow Rate Return
(gal/min)
Water Volume Flow Rate (gal/min)
Wastewater Volume Flow Rate
(gal/min)

gallons per hour Usgal/h

Water Volume Flow Rate Supply
(gal/h)
Water Volume Flow Rate Return
(gal/h)
Water Volume Flow Rate (gal/h)
Wastewater Volume Flow Rate
(gal/h)

liters per second l/s

Water Volume Flow Rate Supply (L/s)
Water Volume Flow Rate Return (L/s)
Water Volume Flow Rate (L/s)
Wastewater Volume Flow Rate (L/s)

liters per minute l/min

Water Volume Flow Rate Supply
(L/min)
Water Volume Flow Rate Return
(L/min)
Water Volume Flow Rate (L/min)
Wastewater Volume Flow Rate
(L/min)

liters per hour l/h

Water Volume Flow Rate Supply (L/h)
Water Volume Flow Rate Return (L/h)
Water Volume Flow Rate (L/h)
Wastewater Volume Flow Rate (L/h)

liq oz/s

Water Volume Flow Rate Supply (fl
oz imp/s)
Water Volume Flow Rate Return (fl
oz imp/s)
Water Volume Flow Rate (fl oz imp/s)
Wastewater Volume Flow Rate (fl oz
imp/s)



Descriptive Name Unit Name Unit Symbol Suggested Mappings

imperial gallons
per minute

Ukgal/min

Water Volume Flow Rate Supply (gal
imp/min)
Water Volume Flow Rate Return (gal
imp/min)
Water Volume Flow Rate (gal
imp/min)
Wastewater Volume Flow Rate (gal
imp/min)

Flow RateMass g/s
lb/s
oz/s
g/min
g/h
lb/min
Uston/h

Force N
lbf

Frequency Hz

Frequency (Hz)
Frequency (MHz)
Frequency (kHz)
Frequency (MHz)

cycles/min
cycles/h
/s
/min
/h

Frequency %/s

Grammage (GSM) g/m²

Grammage (GSM) (g/m²)
Grammage (GSM) (mg/m²)
Grammage (GSM) (kg/m²)
Grammage (GSM) (Mg/m²)

Heat Capacity J/(g·C) Specific Heat Capacity (J/(g deg C))

Btu/(lb·F)
Specific Heat Capacity (BTU 59/(lb
av deg F))

Heat Degree Days °Cdays Heating Degree Days Celsius
°Fdays Heating Degree Days Fahrenheit

Heat Flux W/m²
Btu/(s·ft²)
W/ft²

Heat Transfer
Coefficient

W/(m²·K)
Heat Transfer Coefficient (W/(m^2
K))
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Descriptive Name Unit Name Unit Symbol Suggested Mappings

Btu/(s·ft²·K)
Heat Transfer Coefficient (BTU 59/(s
ft^2 K))

Humidity % Rh

Relative Humidity (Hour Interval)
Air Relative Humidity Supply
(percent)
Air Relative Humidity Return
(percent)
Air Relative Humidity Mixed (percent)
Weather Relative Humidity

Illuminance lux lx

Illuminance (lx)
Illuminance (Mlx)
Illuminance (Klx)
Illuminance (Mlx)
Global Horizontal Illuminance (Hour
Interval)
Direct Normal Illuminance (Hour
Interval)
Diffuse Horizontal Illuminance (Hour
Interval)

ft·cd

Candelas per sq.
meter

H

Illuminance (H)
Illuminance (mH)
Illuminance (kH)
Illuminance (MH)

Inductance henry H
Length meter m

inch in
foot ft
yard yd
mile mile

Linear Momentum Newton Second Ns

Luminance
candelas per
squaremeter

cd/m²

Luminous Flux lm
Luminous Intensity cd
Magnetic Dipole
Moment

A·m²

Magnetic Field
Strength

A/m

Magnetic Flux Wb
Magnetic Flux Density T
Mass gram g



Descriptive Name Unit Name Unit Symbol Suggested Mappings
pound lb
ounce oz

carat
grains
USTon

Mass Transfer
Coefficient

(mol/(s·m²))/
(mol/m³)
(mol/(s·ft²))/
(mol/ft³)

Mass Velocity g/(s·m²)
lb/(s·ft²)

Moles mole mol
lbmol

Moment of Inertia g/m²
lb/ft²

Momentum g·m/s
lb·ft/s

NoCategory NoUnit
?

Percent Obscuration %/m
%/ft

Percentage %
Damper Position (percent)
Valve Position (percent)

ppm
CO₂Concentration Indoor (ppm)
CO₂Concentration Outdoor (ppm)

ppb
Phase deg

Power W
Active Power Phase B (kW)
Active Power Phase A (kW)
Active Power Phase C (kW)

VA
Apparent Power Phase A (KVA)
Apparent Power Phase B (KVA)
Apparent Power Phase C (KVA)

Btu/s
hp
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Descriptive Name Unit Name Unit Symbol Suggested Mappings

Btu/h

Water Heat Flow Rate (BTU 59/h)
Water Heat Flow Rate (BTU ISO/h)
Energy Consumption Rate (BTU
59/h)
Energy Consumption Rate (BTU
ISO/h)
Air Heat Flow Rate (BTU 59/h)
Air Heat Flow Rate (BTU ISO/h)
Natural Gas Energy Flow Rate (BTU
59/h)
Natural Gas Energy Flow Rate (BTU
ISO/h)
Steam Heat Flow Rate (BTU 59/h)
Steam Heat Flow Rate (BTU ISO/h)

tons refrig

Power Factor cosf
Power Factor Signed Phase A
Power Factor Signed Phase B
Power Factor Signed Phase C

Power Reactive var
Reactive Power Phase A (kvar)
Reactive Power Phase B (kvar)
Reactive Power Phase C (kvar)

Pressure N/m²

Air Pressure (N/m^2)
Natural Gas Pressure (N/m^2)
Steam Pressure (N/m^2)
Water Pressure Supply (N/m^2)
Water Pressure Return (N/m^2)
Water Pressure (N/m^2)

Pa

Air Pressure (Pa)
Natural Gas Pressure (Pa)
Steam Pressure (Pa)
Water Pressure Supply (Pa)
Water Pressure Return (Pa)
Water Pressure (Pa)
Water Pressure Differential (kPa)

psi

Air Pressure psi Natural Gas
Pressure (psi)
Steam pressure (psi)
Water Pressure Supply (psi)
Water Pressure Return (psi)
Water Pressure (psi)



Descriptive Name Unit Name Unit Symbol Suggested Mappings

mHg

Air Pressure (m Hg)
Natural Gas Pressure (N/m^2)
Steam Pressure (N/m^2)
Water Pressure Supply (N/m^2)
Water Pressure Return (N/m^2)
Water Pressure (N/m^2

inH₂0

Air Pressure (in H2O)
Natural Gas Pressure (in H2O)
Steam Pressure (in H2O)
Water Pressure Supply (in H2O)
Water Pressure Return (in H2O)
Water Pressure (in H2O)

bar

Air Pressure (bar)
Natural Gas Pressure (bar)
Steam Pressure (bar)
Water Pressure Supply (bar)
Water Pressure Return (bar)
Water Pressure (bar)
Water Pressure Differential (bar)
Air Pressure Absolute (bar)

Pressure mH₂0

Air Pressure (m H2O)
Natural Gas Pressure (m H2O)
Steam Pressure (m H2O)
Water Pressure Supply (m H2O)
Water Pressure Return (m H2O)
Water Pressure (m H2O)

inHg

Air Pressure (in Hg)
Natural Gas Pressure (in Hg)
Steam Pressure (in Hg)
Water Pressure Supply (in Hg)
Water Pressure Return (in Hg)
Water Pressure (in Hg)

db (SPL) Sound Pressure Level (dB)
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Descriptive Name Unit Name Unit Symbol Suggested Mappings

Pressure Drop Per
Length

Pa/m

Air Pressure Drop Per Length (Pa/m)
Natural Gas Pressure Drop Per
Length (Pa/m)
Steam Pressure Drop Per Length
(Pa/m)
Water Pressure Supply Drop Per
Length (Pa/m)
Water Pressure Return Drop Per
Length (Pa/m)
Water Pressure Drop Per Length
(Pa/m)

psi/ft

Air Pressure Drop Per Length (psi/ft)
Natural Gas Pressure Drop Per
Length (psi/ft)
Steam Pressure Drop Per Length
(psi/ft)
Water Pressure Supply Drop Per
Length (psi/ft)
Water Pressure Return Drop Per
Length (psi/ft)
Water Pressure Drop Per Length
(psi/ft)

Resistance ohm Ω Resistance
Resistivity ohmmeter Ωm
Specific Entropy J(g·K)

Btu/(lb·R)
J/(kg·K)

Specific Humidity
g H₂0/kg dry
air

Specific Volume m³/g
ft³/lb

Surface Energy
Density

J/m²

J/ft²
W/(h·m²)
W/(h·ft²)

Surface Tension N/m²
lbf/ft



Descriptive Name Unit Name Unit Symbol Suggested Mappings

Temperature °C

Weather Temperature CelsiusWater
Temperature (deg C)
Water Temperature Supply (deg C)
Water Temperature Return (deg C)
Water TemperatureMixed (deg C)
Air Temperature (deg C)
Air Temperature Return (deg C)
Air Temperature Supply (deg C)
Steam Temperature (deg C)
Compressed Air Temperature (deg C)
Natural Gas Temperature (deg C)
Steam Temperature (deg C)
Ambient Temperature Celsius
Temperature Celsius

K

°F

Weather Temperature Fahrenheit
Water Temperature (deg F)
Water Temperature Supply (deg F)
Water Temperature Return (deg F)
Water TemperatureMixed (deg F)
Air Temperature (deg F)
Air Temperature Return (deg F)
Air Temperature Supply (deg F)
Steam Temperature (deg F)
Compressed Air Temperature (deg F)
Natural Gas Temperature (deg F)
Steam Temperature (deg F)
Ambient TemperatureFahrenheit
Temperature Fahrenheit
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Descriptive Name Unit Name Unit Symbol Suggested Mappings

Temperature Diff Δ°C

Weather Temperature Differential
(deg C)
Water Temperature Differential (deg
C)
Water Temperature Supply
Differential (deg C)
Water Temperature Return
Differential (deg C)
Water TemperatureMixed Differential
(deg C)
Air Temperature Differential (deg C)
Steam Temperature Differential (deg
C)
Temperature Differential (deg C)
Ambient Temperature Differential
(deg C)

ΔK

Δ°F

Weather Temperature Differential
(deg F)
Water Temperature Differential (deg
F)
Water Temperature Supply
Differential (deg F)
Water Temperature Return
Differential (deg F)
Water TemperatureMixed Differential
(deg F)
Air Temperature Differential (deg F)
Steam Temperature Differential (deg
F)
Temperature Differential (deg F)
Ambient Temperature Differential
(deg F)



Descriptive Name Unit Name Unit Symbol Suggested Mappings

Temperature Rate of
Change

°C/min

Air TemperatureMixed Rate of
Change (deg C/min)
Air Temperature Rate of Change (deg
C/min)
Air Temperature Return Rate of
Change (deg C/min)
Air Temperature Supply Rate of
Change (deg C/min)
Ambient Temperature Rate of
Change (deg C/min)
Steam Temperature Rate of Change
(deg C/min)
Temperature Rate of Change (deg
C/min)
Water TemperatureMixed Rate of
Change (deg C/min)
Water Temperature Rate of Change
(deg C/min)
Water Temperature Return Rate of
Change (deg C/min)
Water Temperature Supply Rate of
Change (deg C/min)
Weather Temperature Rate of
Change (deg C/min

K/min
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Descriptive Name Unit Name Unit Symbol Suggested Mappings

°F/min

Air TemperatureMixed Rate of
Change (deg F/min)
Air Temperature Rate of Change (deg
F/min)
Air Temperature Return Rate of
Change (deg F/min)
Air Temperature Supply Rate of
Change (deg F/min)
Ambient Temperature Rate of
Change (deg F/min)
Steam Temperature Rate of Change
(deg F/min)
Temperature Rate of Change (deg
F/min)
Water TemperatureMixed Rate of
Change (deg F/min)
Water Temperature Rate of Change
(deg F/min)
Water Temperature Return Rate of
Change (deg F/min)
Water Temperature Supply Rate of
Change (deg F/min)
Weather Temperature Rate of
Change (deg F/min)



Descriptive Name Unit Name Unit Symbol Suggested Mappings

Temperature Rate of
Change

°C/h

Air TemperatureMixed Rate of
Change (deg C/h)
Air Temperature Rate of Change (deg
C/h)
Air Temperature Return Rate of
Change (deg C/h)
Air Temperature Supply Rate of
Change (deg C/h)
Ambient Temperature Rate of
Change (deg C/h)
Steam Temperature Rate of Change
(deg C/h)
Temperature Rate of Change (deg
C/h)
Water TemperatureMixed Rate of
Change (deg C/h)
Water Temperature Rate of Change
(deg C/h)
Water Temperature Return Rate of
Change (deg C/h)
Water Temperature Supply Rate of
Change (deg C/h)
Weather Temperature Rate of
Change (deg C/h)

K/h
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Descriptive Name Unit Name Unit Symbol Suggested Mappings

°F/h

Air TemperatureMixed Rate of
Change (deg F/h)
Air Temperature Rate of Change (deg
F/h)
Air Temperature Return Rate of
Change (deg F/h)
Air Temperature Supply Rate of
Change (deg F/h)
Ambient Temperature Rate of
Change (deg F/h)
Steam Temperature Rate of Change
(deg F/h)
Temperature Rate of Change (deg
F/h)
Water TemperatureMixed Rate of
Change (deg F/h)
Water Temperature Rate of Change
(deg F/h)
Water Temperature Return Rate of
Change (deg F/h)
Water Temperature Supply Rate of
Change (deg F/h)
Weather Temperature Rate of
Change (deg F/h)

Thermal Conductance W/(m²·K)

Thermal Conductivity W/(m²·K/m)

Air Thermal Conductivity (W/(m K))
Water Thermal Conductivity (W/(m
K))
Steam Thermal Conductivity (W/(m
K))
Natural Gas Thermal Conductivity
(W/(m K))

Btu/(h·ft²·F/ft)

Air Thermal Conductivity (BTU 59/(h
ft deg F))
Water Thermal Conductivity (BTU 59/
(h ft deg F))
Steam Thermal Conductivity (BTU
59/(h ft deg F))
Natural Gas Thermal Conductivity
(BTU 59/(h ft deg F))

Thermal Linear
Expansion

m/C

in/F



Descriptive Name Unit Name Unit Symbol Suggested Mappings
ft/F

Thermal Pressure psi/oF
Thermal Volume
Expansion

m³/C

in³/F
ft³/F

Thermoelectric Power V/K
Time year

month
week
day
h
min
s

Time Accuracy s/h
Torque Nm

lbf·in
lbf·ft

Turbidity NTU
Velocity m/s Air Velocity (m/s)

m/h Air Velocity (m/h)
mile/h Air Velocity (mile/h)
ft/s Air Velocity (ft/s)
ft/min Air Velocity (ft/min)
m/min Air Velocity (m/min)

Velocity Angular
radians per
second

rad/s

revolutions per
minute

RPM

Voltage V

Average Voltage Line-to-Neutral
Voltage Phases AB
Voltage Phases BC
Voltage Phases CA
Voltage Phases AN
Voltage Phases BN
Voltage Phases CN

Volume m³

Air Volume (m^3)
Steam Volume (m^3)
Wastewater Volume (m^3)
Water Volume (m^3)
Natural Gas Volume (m^3)
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Descriptive Name Unit Name Unit Symbol Suggested Mappings
Volume in³

ft³

Air Volume (cubft)
Steam Volume (cf)
Wastewater Volume (cf)
Water Volume (cf)
Gas Volume (cf)

Usgal
Wastewater Volume (gal)
Water Volume (gal)

litre
Wastewater Volume (L)
Water Volume (L)



Configuring the PME EWS server for HTTPS
By default, the EWS server in PME is configured for HTTP client connections.

To configure the EWS server for HTTPS client connections:

1. On the PME server, open the web.config file for editing, for example in Notepad. You can
find this file in ...\Power Monitoring Expert\applications\EWS.

2. Search for the <binding name="DataExchange_BP11Binding"> element in the file.
Find the <httpTransport ... /> child element and change it to <httpsTransport
... />.

3. Search for the <behavior name="DataExchange_BP11Behavior"> element in the file.
Find the <serviceMetadata httpGetEnabled="true" /> child element and add the
httpsGetEnabled="true" attribute. After the change the element should look like this:
<serviceMetadata httpGetEnabled="true" httpsGetEnabled="true"/>.

4. Save the web.config file. Close the file.

5. Restart Internet Information Services (IIS) on this computer.
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Database growth calculations
Factory default measurement logging

A measurement record in the database uses approximately 75 bytes of disk space. Based on the
factory default data logging configurations, we can calculate the database growth for data logged
from different device types.

Example

Device
Type

Daily Growth
Rate (kB)

Number of
Devices

Total Daily
Growth (MB)

Total Annual 
Growth (GB)

ION7650 780 10 7.62 2.72
PM8000 950 20 19.00 6.94
PM3200 85 70 5.81 2.07
TOTAL - 100 32.43 MB 11.84 GB

NOTE: Use the DatabaseGrowth Calculator tool to estimate the database growth for your
system. The tool is available through the Exchange Community. See Resources for link
information.

Custom measurement logging
Custommeasurement logging can be configured in themonitoring devices and, as software based
logging, in PME. A measurement record in the database uses approximately 75 bytes of disk
space.

The following shows the database growth estimate for logging of a single measurement every 15
minutes:

NOTE: Use the DatabaseGrowth Calculator tool to estimate the database growth for your
system. The tool is available through the Exchange Community. See Resources for link
information.

Power quality event logging
Power quality (PQ) events and waveform capture recording is event driven, whichmakes it
impossible to accurately predict their impact on database growth. In our experience, power quality
data accounts for approximately 10% - 20% of the total database size.



NOTE: Use the DatabaseGrowth Calculator tool to estimate the database growth for your
system. The tool is available through the Exchange Community. See Resources for link
information.
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Default device type support
The following tables list the pre-configured device types in PME9.0 and the license that is required
for each type:

Device Type License Device Type License Device Type License
3300 ACM E 3710 ACM S 3720 ACM S
3800 RTU M ION 6200 E ION 6200 (MODBUS) E
ION 7300 E ION 7330 M ION 7350 M
ION 7400 M ION 7500 M ION 7500 RTU M
ION 7550 M ION 7550 RTU M ION 7600 S
ION 7650 S ION 7700 S PM8000 M
ION 8300 M ION 8400 S ION 8500 S
ION 8600 S ION 8600C M ION 8650 S
ION 8650C M ION 8800 S ION 8800C M

ION 9000 S ACCESS 9200 E
ACCESS 9200
(MODBUS)

E

ACCESS 9300 E ACCESS 9330 M ACCESS 9340 M
ACCESS 9350 M ACCESS 9360 M 9410 M

ACCESS 9500 M
ACCESS 9500
RTU

M ACCESS 9510 M

ACCESS 9510 RTU M ACCESS 9600 S ACCESS 9610 S
ACCESS 9700 S 9810 S AccuSine_PCS M

AccuSine PCS Plus M
AccuSine PFV
Plus

M Acti 9 Smartlink E

Acti 9 Smartlink
Ethernet

E Altivar 61 E BCPM E

CM100-200 E CM2000 Series M CM3000 Series M

CM4000 Series S
Micrologic
5.2/6.2/5.3/6.3 A

E
Micrologic
5.2/6.2/5.3/6.3/7.2/7.3
E

E

ComX (WAGES) E DM2000 E DM6200 E
DM6200 H E DM6300 E EDS151 E
EDS461 E EM1000 Series E EM3460 E
EM3550 E EM3555 E EM4200 E
EM4300 Series E EM4800-08 Delta M EM4800-08Wye M
EM4800-12 M EM4800-24 M EM4900 M
EM4900 Logical Meter
[licensemultiplier =
0.01] (*)

S EM5600 M EM6400 E

EM6400 NG E EM6430 E EM6433 E
EM6433_36_38 H E EM6434 E EM6436 E
EM6436 Dual E EM6438 E EM6459 E



EM6459 H E EM7000 Series E Enercept Meter E

EnerSure BCPM xD M
EnerSure BCPM
2.0

M EnerSure Enkapsis M

EnerSure iBCPM xD M
EnerSure iBCPM
Enkapsis

M Galaxy VM E

Galaxy VX E iEM2000 Series E iEM3x50 Series E
iEM3x55 Series E IG6 E LVSMC E
MGE Galaxy 5000
Series

E MGE-UPS E
Micrologic
2.0/5.0/6.0/7.0 A

E

Micrologic
2.0/5.0/6.0/7.0 A IFE_
IFM

E
Micrologic
2.0/5.0/6.0 E

E
Micrologic 2.0/5.0/6.0
E IFE_IFM

E

Micrologic 5.0/6.0/7.0 H M
Micrologic
5.0/6.0/7.0 H IFE_
IFM

M
Micrologic 5.0/6.0/7.0
P

E

Micrologic 5.0/6.0/7.0 P
IFE_IFM

E
Micrologic
2.0/3.0/5.0/6.0/7.0
X

M
Momentum PLC A8
(WAGES)

M

Momentum PLC D10
(WAGES)

M
Momentum PLC
D16 (EPSS)

M PM1120_30 H E

PM1200 E PM200 Series E PM2000 Series E
PM3250 E PM3255 E PM5100 Series E
PM5300 Series M PM5350 E PM5350 IB/PB E
PM5500 Series M PM600 Series E PM700 Series E
PM800 Series M PM810 LE E PM9C E
PowerTag [license
multiplier = 0.05] (*)

M PowerTag NSX E Sepam Series 10 E

Sepam Series 20 E Sepam Series 40 M Sepam Series 48 M
Sepam Series 60 S Sepam Series 80 S SER 2408 M

SER 3200 M Smart-UPS TBD
Switchgear Monitoring
Device

M

Symmetra TBD SymmetraMW TBD Tesys T E
TwidoModular PLC
(WAGES) D12/28/44

E Varlogic_NRC_12 E VarPlus Logic E

Veeder Root TBD BCPM Flex Cct TBD Vigilohm IM20_LE E
VigilohmIM20H E WT4000 Series E

(*) The licensemultiplier indicates the fraction of a license each device of this type uses. For
example, amultiplier of 0.01means that 100 device of this type can share one full license.

E = Entry-Level Device License
M = Mid-Level Device License
S = Standard (High-End) Device License
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NOTE: PME assigns the lowest level required license to a device. If no license of that level is
available, then it uses and available next higher level device license. For example, if a system has
a PM8000 device, which requires aMid-Level license, PME will assign a free Standard license to
this device, if a Mid-Level license is not available.



Deploying and configuring a Multi-input Setpoint Display Bar
graphic component

You can create and deploy aMulti-input Setpoint Display Bar graphic component in the Graphics
Editor, and then bind and view the graphic object in Building OperationWorkstation.

To create the graphic component:

1. Navigate to:
<Extract path>\SBO Components\Graphics Editor\Components\ and double-
click the " Energy Expert- Generic Components" file. The new thermometer graphic com-
ponent is added to the Building Operation Graphics Editor library.

2. Open the Building Operation Graphics Editor.

3. From the Energy Expert– Generic Components category at the left, drag the PowerMeas-
urement Display Bar component onto a new page. TheMulti-input Setpoint Display Bar com-
ponent appears.

4. Select the component. In the Properties pane at the lower right, change the parameter settings
as needed (name, min/max, setpoint values, and so on). Make sure that the settings make
logical sense (for example, all setpoints are within themin/max range and in the following
order: SP4>SP3>SP2>SP1).

5. Save the new graphic component page as a .tgml file.

To deploy the graphic component:

1. Log in to Building OperationWorkstation.

2. In the System Tree, select a Server, and then choose File > New > Graphic, enter a name for
the file, and click Create. The new graphic file name appears in the System Tree.
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3. In the System Tree, right-click the graphic file name and select Properties.

4. In the Basic tab, click the button next to the File field and navigate to the .tgml file, select the
file, click Open and thenOK. TheMulti-input Setpoint Display Bar now appears in the Building
OperationWorkstation.

5. In the System Tree, select the Server, and then chooseNew > Value. The Create Object dia-
log appears. Repeat the above steps four times to create four new values.

6. Select Analog Value and complete the fields for Name, Location, and Description as needed,
and then click Create for each new value. The four new Analog Values now appear.

7. For each value, double-click the name after adding it. Click the up or down arrows to select a
number, and then click the Value button to select Forced or Force value for the object. Click
Yes to save the object.

8. To bind the graphic object to the value you just created, in the System Tree, right-click the
graphic file name and select Properties.

9. In the Bindings tab, enter the location of the graphic object in the object value field and click
OK. TheMulti-input Setpoint Display Bar now shows the preset setpoint values and bound val-
ues. The reading bar height and color change accordingly.

To verify the bind of the graphic component:



1. In the System Tree, right-click on the new graphic file name and click Edit. TheGraphics
Editor opens.

2. Revise some graphic component parameters (for example, min/max, setpoint values, or col-
ors), save the file, and return to Building OperationWorkstation. Your changes appear on the
Graphics page in Building OperationWorkstation.
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Deploying and configuring a Single-input Thermometer graphic
component

You can create and deploy a Single-input Thermometer graphic component in the Graphics Editor,
and then bind and view the graphic object in Building OperationWorkstation.

To create the graphic component:

1. Navigate to:
<Extract path>\SBO Components\Graphics Editor\Components\ and double-
click the "PowerModule - Generic Components" file. The new thermometer graphic com-
ponent is added to the Building Operation Graphics Editor library.

2. Open the Building Operation Graphics Editor.

3. From the Energy Expert– Generic Components category at the left, drag the Setpoint Display
Bar component onto a new page. The Single-input Thermometer bar component appears.

4. Select the component. In the Properties pane at the lower right, change the parameter settings
as needed (name, min/max, setpoint values, and so on). Make sure that the settings make
logical sense (for example, all setpoints are within themin/max range and in the following
order: SP4>SP3>SP2>SP1).

5. Save the new graphic component page as a .tgml file.

To deploy the graphic component:

1. Log in to Building OperationWorkstation.

2. In the System Tree, select a Server, and then choose File > New > Graphic, enter a name for
the file, and click Create. The new graphic file name appears in the System Tree.



3. In the System Tree, right-click the graphic file name and select Properties.

4. In the Basic tab, click the button next to the File field and navigate to the .tgml file, select the
file, click Open and thenOK. The Single-input Thermometer bar now appears in the Building
OperationWorkstation.

5. In the System Tree, select the Server, and then chooseNew > Value. The Create Object dia-
log appears.

6. Select Analog Value and complete the fields for Name, Location, and Description as needed,
and then click Create. The Analog Value now appears.

7. Double-click the value name after adding it. Click the up or down arrows to select a number,
and then click the Value button to select Forced or Force value for the object. Click Yes to
save the object.

8. To bind the graphic object to the value you just created, in the System Tree, right-click the
graphic file name and select Properties.
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9. In the Bindings tab, enter the location of the graphic object in the object value field and click
OK. The Single-input Thermometer bar now shows the preset setpoint values and bound val-
ues. The reading bar height and color change accordingly.

To verify the bind of the graphic component:

1. In the System Tree, right-click on the new graphic file name and click Edit. TheGraphics
Editor opens.

2. Revise some graphic component parameters (for example, min/max, setpoint values, or col-
ors), save the file, and return to Building OperationWorkstation. Your changes appear on the
Graphics page in Building OperationWorkstation.



Exposing custom device driver measurements through EWS
If you create a custom device driver in PME using the Device Type Editor tool, you need to take
extra steps to expose themeasurements from this device through EWS. The default device drivers
in PME andmany of the downloadable add-on drivers have their measurements exposed by default.

WARNING
INACCURATE DATA RESULTS
• Do not incorrectly configure the software or the devices.
• Do not base your maintenance or service actions solely onmessages and information
displayed by the software.

• Do not rely solely on softwaremessages and reports to determine if the system is functioning
correctly or meeting all applicable standards and requirements.

• Consider the implications of unanticipated transmission delays or failures of communications
links.

Failure to follow these instructions can result in death, serious injury, equipment
damage, or permanent loss of data.

To expose custommeasurements from a custom device type through EWS:

1. Create a DTE driver. In this example, a driver file was created for “My_DTE” device with two
registers, “My_Label_1” and “My_Label_2”.

2. Go in the following folder: C:\Program Files (x86)\Schneider Electric\Power

Monitoring Expert\system\WebServices\Extensions.

3. Select any XML file (for example: “Types_Measurements_8000.xml”), copy and paste it to the
same folder. Rename it to the newly created DTE "Device Type" name, “My_DTE.xml”

4. Open the XML file with a file editor. The structure of the XML resembles the following:

<?xml version="1.0"?>

<MeasurementStores xmlns:xsi="http://www.w3.org/2001/XMLSchema-

instance" xmlns:xsd="http://www.w3.org/2001/XMLSchema"> <Store

Name="8000" DisplayName="PM8000" Type="8000" SubType="Common">

...

...

<Measurement IONReferenceName="Active Energy Delivered" Meas-

urementName="Real Energy Into the Load" MeasurementUnit="kWh"

Exposed="true" IsManual="false" Handle="22704" Format="double" />

<Measurement IONReferenceName="Active Energy Delivered Interval"

MeasurementName="Real Energy Into the Load Interval" Meas-

urementUnit="kWh" Exposed="false" IsManual="false" Handle="24483"

Format="double" />

...

...

</Store>

</MeasurementStores>
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5. Modify the bold sections like the following tomatch your "Device Type" name as well as your
Register "Label". Make sure to change all the bold ones to what fits the new DTE, delete the
"Handle" section and specify the format as necessary.

<?xml version="1.0"?>

<MeasurementStores xmlns:xsi="http://www.w3.org/2001/XMLSchema-

instance" xmlns:xsd="http://www.w3.org/2001/XMLSchema"> <Store

Name="My_DTE" DisplayName="My_DTE" Type="My_DTE" SubType="Common">

...

...

<Measurement IONReferenceName="My_Label_1" MeasurementName="My_

Label_1" MeasurementUnit="My_Unit_1" Exposed="true"

IsManual="false" Format="Boolean" /> <Measurement

IONReferenceName="My_Label_2" MeasurementName="My_Label_2"

MeasurementUnit="My_Unit_2" Exposed="true" IsManual="false"

Format="double" />

...

...

</Store>

</MeasurementStores>

NOTE: When editing the XML file, format “Boolean” should be used for all Boolean values
and format “Double” for all analog values.

6. After completing the new xml file, go toManagement Console > Tools > System and click
Update EWS Server. It will take some time for the server to propagate the change via web
service. An IIS and/or computer restart might even be required.

7. The custom registers/measurements are now expose via EWS. See Hosting EWS values in
Building Operation for information on this topic.



Manual integration steps without using the Integration Utility
This section describes how tomanually integrate Building Operation and PME without using the
Energy Expert Integration Utility. Sometimes manual steps aremore convenient for certain tasks,
for example: makingminor changes to the system. This section also describes how the Integration
Utility works.

NOTE: Themanual steps cannot fully replace the Integration Utility for an Energy Expert
deployment. When deploying Energy Expert, youmust use the Integration Utility to create the
Diagram links.

The followingmanual steps are described in this section:

l Creating PME users for Building Operation

l Creating Diagrams, Reports, and Dashboards links in Building Operation

l Hosting EWS values in Building Operation

Creating PME users for Building Operation
You need to create two different PME users for the integration with Building Operation:

1. A user for the EWS connection between the two applications.

2. A user for the Building Operation connection to the PMEWeb applications (Dashboards and
Reports).

For information on how to create the EWS user, see Setting up EWS credentials.

For information on how to create the user to access theWeb Applications, see "Adding a standard
user" in theEcoStruxure™PowerMonitoring Expert 9.0 System Guide or the PMEWeb
Applications Help .

Creating Diagrams, Reports, and Dashboards links in Building Operation
Follow these steps to create links in EBO for all required Diagram, Report, and Dashboard
applications:

Enable the Generate Authentication URL page:

1. In PME, navigate to …\Applications\SystemDataService and openWeb.config with a
text editor, such as Notepad++.

2. In the appSettings tags, locate the line <add key="IsThirdPartyAuthEnabled"

value="false" /> and change the value to 'true', and then save the file.

<appSettings>

<add key="webpages:Version" value="1.0.0.0" />

<add key="ClientValidationEnabled" value="true" />

<add key="UnobtrusiveJavaScriptEnabled" value="true" />

<add key="ServiceInventoryEndpoint"

value="http://STANDALONE:23102/CoreServicesHost/Inventory/InventorySer

vice" />

<add key="enableConfigurationView" value="false" />

<add key="enableDiagnosticView" value="false" />

<add key="IsThirdPartyAuthEnabled" value="true" />
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<add key="FrameworkXmlRelativePath" value="..\ApplicationFramework\

Framework.xml" />

<add key="FrameworkSchemaRelativePath"

value="..\ApplicationFramework\Schemas\Framework.xsd" />

</appSettings>

3. After the authentication is enabled, use a web browser to navigate to http://<y-
ourservername>/SystemDataService/Auth/GenerateAuthURL.

4. Provide supervisor-level login information in the dialog and click OK. TheGenerate Authentic-
ation URL page appears.

NOTE: If you receive amessage indicating that the Generate Authentication URL page is
not enabled or that this feature is not licensed, check theWeb.config file andmake sure the
IsThirdPartyAuthEnabled line is set to 'true'.

5. Configure and generate the authentication URL by selecting options from the dropdown lists
and filling in the applicable fields described below.

Destination URL Type: Select one of the following from the dropdown list:

Dashboards:Provides a link to the PME Dashboard application without theWeb Applic-
ations banner along the top.

Web Reporter - Homepage:Provides a link to theWebReporter application without the
Web Applications banner along the top.

Web Reporter - Opened to Specific Report:Provides a link to a specific report in the
WebReporter application. To link to a specific report, youmust provide theWebReporter
Report ID of the report in the field. To find the report ID, see the ION_Net-
work.dbo.RPT_Report table. This table contains the report name and corresponding
ID number.

Web Diagrams - Device Diagram1:Provides a link to the default diagram for a device.
To use this feature, youmust provide the name of the device in the applicable field. See
the device list in theManagement Console to find the exact name of the device. Youmust
specify the device name in the formal "Group.Name".

Web Diagrams - Network Diagram2:Provides a link to the network diagram for the sys-
tem.

Full Website2:Provides a link to the complete PMEWeb Applications site



Relative Path to Dashboards: This is the URL to Dashboards. By default, the path
name is "/web", however the path name can be changed when installing PME.

Destination Protocol:Select either https (encrypted connection) or http (unencrypted
connection) from the dropdown list. Use the https option if PME is configured to use https.
Otherwise, use the http option.

Destination Host Name: The name of the PME host system. The name should already
be provided in this field.

1 In Energy Expert, the generated links will work only after you run the Integration Utility once.
2Not supported in Energy Expert.

6. Click Generate URL. The application generates a new URL.

Authentication URL: The generated URL appears in this field.

7. Log in to EBOwith your credentials.

8. In EBOWorkstation, create a new hyperlink and paste into it the newly generated URL.

Repeat the steps above as necessary for all applications.

Hosting EWS values in Building Operation
In order to integrate values from PME with Building Operation, youmust:

1. Create the EWS interface in Building OperationWorkstation

2. Host the PME values for that interface.

Configuring the EWS Server

Before you create an EWS interface in Building OperationWorkstation, youmust first enable the
EWS service. (The EWS service is disabled by default in PME.)

To enable the EWS service:

1. Navigate to ...\“Power Monitoring Expert Folder”\ Applications\EWS\

2. Open Web.Config in a text editor, such as Notepad.

3. Search for <add key="EWSEnabled" value="0" /> and change the value from "0" to
"1". (Conversely, to disable the EWS service, change the value from "1" to "0".)

4. Search for <add key="RealTimeRefreshRate" value="20" /> andmake sure the
value is set to "20".

<appSettings>

<add key="ServiceInventoryEndpoint"

value="http://STANDALONE:23102/CoreServicesHost/Inventory/InventoryService"

/>

<add key="EWSRealTimeTimeout" value="45" />

<add key="ServiceLocation" value="EWS Services" />

<add key="DigestAuthenticationModule_Realm" value="DataExchangeService" />

<add key="AllowMD5DigestHash" value="1" />

<add key="EWSEnabled" value="1" />

<add key="ContainerItemStructure" value="0" />

<add key="NaNValue" value="" />
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<add key="ConcatSourceAlarmEventId" value="1" />

<add key="RealTimeRefreshRate" value="20" />

<add key="RealTimeSessions" value="10" />

<add key="InternalStructureCacheTimeInSeconds" value="120" />

<add key="NumberOfDaysBackToInclude" value="10" />

<add key="InvalidAlarmTypes" value="ALM_CONTROL_EVENT,ALM_LOOSE_DROPOUT,ALM_

GENERIC_EVENT,ALM_CLOCK" />

</appSettings>

5. Save and close >Web.config. The EWS service is now enabled and with the correct refresh
rate. (The service can be enabled or disabled at any time by editing the Web.config file.)

Updating the EWS server

To update the EWS server in PME:

NOTE: RunManagement Console as Administrator user. To do this, right-click theManagement
Console program icon and select Run as administrator from the context menu. If you do not run
it as Administrator, then certain tools such as Update EWS Server are not functional.

1. OpenManagement Console.

2. Select Tools > System > Update EWS Server. A dialog box appears, indicating that the
update to EWS server configuration is successful.

3. Click OK.

NOTE: For any changes in the PME Management Console, such as adding a new device or
renaming an existing device, youmust 1) update the EWS server, and 2) regenerate a Vista
Diagram before using the Integration Utility.

Modifying which measurements EWS Server exposes by default

NOTE: The following step is optional, however, it becomes necessary if you want to change the
list of measurements that the EWS server exposes by default.

The EWS Server relies on two control files to define which devices are exposed and which
measurements are exposed for those devices.

l The following file contains the list of all PME devices:

...\<Power Monitoring Expert

Folder>\config\WebServices\Devices.Measurements.xml

If you do not want a device to be exposed, delete the complete line of an entry.

l The following file contains the list of measurement exposed for all supported devices types:

...\<Power Monitoring Expert

Folder>\config\WebServices\Types.Measurements.xml

To expose or un-expose a specific measurement for a specific device type, do the following:

a. Browse to that specific device type.

b. Identify themeasurement you wish to expose.



c. Set the “Exposed” parameter to “true” to expose or "false" to un-expose.

d. Set the “IsManual” parameter to “true”.

If you do not set “IsManual” to true, the next time you run Update EWS Server from the
Management Console, your configuration will be overwritten by the system default.

e. When you finish, select Tools > System > Update EWS Server to make the changes.

Creating and hosting the EWS interface in Building Operation Workstation

You canmanually create the EWS interface in Building OperationWorkstation and then host PME
values so that you can browse those values from within Building OperationWorkstation.

Tomanually create a new EWS web service interface:

1. Log in to Building Operation.

2. In the System Tree, right-click on Server, and then click New > Interface.

The Create Object: EcoStruxureWeb Service dialog appears.
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3. Enter a name and description for the new web interface in the respective fields, and click
Next. The Connection Information dialog appears.

4. Enter the server name or the IP address where PME is hosted in the EWS Server field.

5. Leave unchanged the values for Protocol and EWS Communication Port.

6. Enter EWS/DataExchange.svc?wsdl in the EWS Path field.

7. Enter the sameUser name and Password that you created for EWS.

8. Click Create. The new web service now appears in the System Tree. Next, proceed to host
the new web service.

Tomanually host the new EWS web service:

1. In the System Tree, navigate to and expand the Hardware folder.

2. Expand, and then select the newly-created interface for which you want to host values.

3. Right-click Root or any underlying level/devices and choose Host EWS Objects. The Select
EWS Interface dialog appears.



4. Choose the appropriate interface location, and then click Select.

Depending on the number of devices andmeasurements, this task can take up to an hour.

Repeat this step for any item you want to host.

The web service is now hosted and appears in the System Tree.

5. After the hosting completes, click the new EWS web service and browse the values in the List
View tab at the right.

To add additional columns of values in the List View tab:

1. In the List View tab, right-click on the Name/Description heading and select Add/Remove
columns.

2. Select the check box next to any column type you want to add to the List View, and then click
OK. The new column types and their respective values now appear in the List View tab.

NOTE: If you find that somemeasurements for a device aremissing from the list of
measurements, do the following:
Check tomake sure that all of themeasurements you want for that device are exposed; refer to
“Modifying whichmeasurements EWS Server exposes by default”.
If all of themeasurements you want for the device are exposed but still do not appear in the list of
measurements, and then you will need to repeat the procedure to create and host the EWS
interface. (PME takes some time between enabling the EWS server and when the EWS client
shows the exposedmeasurements.) See “Creating and hosting the EWS interface in Building
OperationWorkstation”.

Configuring Alarms

1. Log in to Building Operation.
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2. Alarms for Architecture 2 are automatically enabled after they are imported and can be viewed
along with all other alarms within the Alarms pane at the bottom of the dialog.

3. To configure the alarms associated with the devices for the EWS Client, in the System Tree,
right click on EWS Client and select Properties. The EWS Client dialog appears.



4. Complete the various fields and select the options you want on this dialog, and then click OK.
The system saves your configuration changes.

The Building Operation “Sum Alarm” is an ideal way to leverage alarms flowing from EWS. It allows
the users to create actions and notifications on filtered PME alarms. Refer to the EcoStruxure
Building Operation System ReferenceGuide for more information.

Solution Guide Reference

7EN02-0414-00 Page 189



Reference Solution Guide

Page 190 7EN02-0414-00

PME IP Port Requirements
PME depends on certain ports for the communication between its components and the connected
devices. Which ports are required for a specific installation depends on the system configuration
and themonitoring devices used.

The following table lists all relevant ports and their functions:

Location Function Protocol Ports Configurable Direction*

Database
Server

SQL Server
instance

TCP 1433 No Inbound

SQL Server
Browser

UDP 1434 No Inbound

PME
Server

IIS Server
HTTP 80 Yes Inbound
HTTPS 443 No Inbound

Application
Module Web
Services

TCP 23102 No Inbound

PME Diagnostics
Viewer (on
Engineering client)

TCP

13667
13671
6000-99
57779

No Inbound

PME Vista (on
Engineering client)

TCP
13666
13670
57777

No Inbound

PME Designer (on
Engineering client)

TCP 13666 No Inbound

PME Management
Console (on
Engineering client)

TCP 13666 No Inbound

PME OPC Client OPC 135 No Inbound
File and Printer
Sharing for
Engineering client

NetBIOS/SMB 139/445 No Inbound

Ecostruxure Web
Services

HTTP 80 No Inbound

Licensing Vendor
Daemon

TCP 27010 Yes Inbound



Location Function Protocol Ports Configurable Direction*

Power
Meter

Power Meter
communication

Modbus TCP 502 No Inbound
Modbus RTU 7701 No Inbound
ION 7700 No Inbound
PML 3721 No Inbound

Power Meter
access

Telnet 23 No Inbound
FTP 20/21 No Inbound
TFTP 69 No Inbound
SMTP 25 No Outbound
HTTP 80 No Inbound
HTTPS 443 No Inbound

Gateway
Ethergate
communication
gateway

Modbus/ION/PML 7800-03 No Inbound

* The direction of a port is determined by the communication initiation request which will establish
the communication socket.

The following image shows the ports and the components they are associated with:
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Setting SQL Server memory options
Note the following recommendations for setting SQLServer memory options on the server where
you install SQL Server:

l Do not set the SQL Server maximummemory to less than 1GB.

l Where only SQL Server is running on the host server, set the SQL Server maximummemory at
the system physical memory less at least 2GB for theWindows operating system. For
example, if your server has 8GB of memory, set the SQL Server maximummemory to nomore
than 6GB. This leaves at least 2GB for the operating system.

l Where the SQL Server is sharing the host server with other server processes, including Internet
Information Services (IIS) and ION services, set the SQL Server maximummemory to nomore
than half the physical memory on the server. For example, if your server has 8GB of memory,
set the SQL Server memory to nomore than 4GB. This leaves at least 4GB for the operating
system and all other server processes.

In addition to setting themaximummemory option, consult with your site administrator to determine
whether or not to enable the Lock pages in memory permission setting inWindows for the SQL
service account on all SQL Server instances.

NOTICE
LOSS OF DATA

Backup or archive any SQL Server database data before adjusting any databasememory
options.

Failure to follow these instructions can result in irreversible database changes.

Only personnel with advanced knowledge of SQL Server databases shouldmake database
parameter changes.

To set themaximummemory setting for your SQL Server:

1. Start SQL Server Management Studio and log in to your SQL Server instance.

2. Right-click the SQL Server name and click Properties in themenu to open theServer Prop-
erties dialog.

3. SelectMemory in the left pane and adjust the value in theMaximum server memory field.

4. Click OK to apply the changes and close the dialog.

5. CloseSQL Server Management Studio.

A server reboot or a restart of the SQL Server service is not required.

To enable the lock pages inmemory option:

1. Click Start > Run and type gpedit.msc in theRun dialog to open the Local Group Policy
Editor.
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2. In the left pane, navigate toComputer Configuration > Windows Settings > Security Set-
tings > Local Policies.

3. Expand Local Policies and select User Rights Assignment.

The policies are listed in the right pane.

4. Locate Lock pages in memory in the list and then double click the policy name to open the
Lock pages in memory Properties dialog.

5. Click Add User or Group on the Local Security Setting tab.

6. Add an account with the privileges to run sqlserver.exe and then click OK to close the dialog.

7. Click OK to close the Local Group Policy Editor.

A server reboot or a restart of the SQL Server service is not required.



Terms and definitions
Activation ID:Each license definition has one or more features included in a specific license type.
An activation ID allows you to license the features included in that license type. Any number of
Activation ID’s can be activated in the Floating LicenseManager at the same time.

American National Standards Institute (ANSI): The primary organization for the development of
technology standards in the United States. ANSI works with industry groups and is the U.S.
member of the International Organization for Standardization (ISO) and the International
Electrotechnical Commission (IEC).

EcoStruxure Building Operation: An integration platform for monitoring, control, and
management of energy, lighting, fire safety, security and HVAC of buildings.

Entitlement ID:A new entitlement is generated for each PurchaseOrder. The entitlement is sent
by email and will include all the Activation ID’s.

FlexNet Operations Portal: The web portal hosted by Schneider Electric (http://schneider-
electric.com/licensing) where the licenses are registered during activation. During an on-line
activation, the Floating LicenseManager will connect to the FlexNet Operations Portal
automatically. However, during an off-line activation, the user will need to connect to the FlexNet
Operations Portal from an alternate PC or a smart phone.

FlexNet Publisher:A web interface hosted on the PowerMonitoring Expert server for configuring
licensing components. The URL is http://localhost:8090 and the service is called
“lmadminSchneider”.

Floating License Manager:All PowerMonitoring Expert licenses are activated here. The Floating
LicenseManager will also indicate the current state of licenses (active or untrusted).

HTTP: This protocol is not secure and is subject to “man-in-the-middle” and eavesdropping attacks
that can allow attackers to gain access to website accounts and sensitive information.

HTTPS: This protocol provides secure communication over a computer network, with especially
wide deployment on the Internet. It results from layering the Hypertext Transfer Protocol (HTTP) on
top of the SSL/TLS protocol, thus adding the security capabilities of SSL/TLS to standard HTTP
communications. HTTPS provides authentication of the website and associated web server with
which one is communicating and thereby protects against “man-in-the-middle” attacks. Additionally,
HTTPS provides bidirectional encryption of communications between a client and server. HTTPS
creates a secure channel over insecure, unencrypted networks, such as Wi-Fi networks. HTTPS is
designed to withstand attacks and is considered secure against attacks (with the exception of older
deprecated versions of SSL). The encryption within HTTPS is intended to provide benefits like
confidentiality, integrity and identity. Your information remains confidential because only your
browser and your server can decrypt the traffic. Integrity protects the data from beingmodified
without your knowledge.

International Electrotechnical Commission (IEC): The primary organization for the development
of International Standards and Conformity Assessment for all electrical, electronic and related
technologies.

License Manager: This is where the Trial licenses can be viewed. PowerMonitoring Expert
licenses cannot be activated in the LicenseManager.
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License Returns:Once activated, a license is “locked” to its host computer (physical or virtual),
and therefore can only be activated on onemachine at a time. Returning the license simply means
reversing the activation process that is, “unlocking” the license from its host, thereby making it
available to be activated again, either on another host or the same host. By default, licenses can
only be returned once per calendar year. If necessary, the return limit can be increased by the
Software Registration Center.

Management Console “About” Box: This is the first place to check to help ensure that the
licensing components are functioning correctly. It will indicate whichmodules are licensed or made
available through the Trial.

Software Registration Center (SRC): The Software Registration Center cannot troubleshoot
licensing questions. You should not have to call the Software Registration Center for any licensing
questions except if you have exceeded your return limit or the licenses have become untrusted. The
Software Registration Center cannot issue new licenses.

Power Monitoring Expert:A powermanagement software solution for energy suppliers and
consumers. It allows you tomanage energy information frommetering and control devices installed
in your facility or other remote locations. The product offers control capabilities and comprehensive
power quality and reliability analysis to help you reduce energy-related costs.



Time synchronization for ION meters
You can synchronize the internal clocks of all networked PowerLogic™ ION™ meters and devices
through theManagement Console component of PowerMonitoring Expert. When they are
synchronized, all data logs have time stamps that are relative to a uniform time base.

NOTE: This information is specific to ION devices. It is not applicable to devices that are not
based on ION architecture.

Time synchronization signals are broadcast periodically over the network; eachmeter continually
assesses its ability to remain synchronized with the incoming broadcasts. Over a brief period, each
meter learns how its internal timing differs from that of the broadcast source and adjusts its
timekeeping to compensate. Very accurate time synchronization is achieved with this method.

Meters at modem sites are synchronized each time they are connected. The longer the duration
between connections, the larger the error in time synchronization. In the extreme case, this can
result in missing or duplicated logs. If this occurs, you can increase the frequency of connections
through the PowerMonitoring Expert software connection.

NOTE: This information assumes that you are using the time synchronization function in Power
Monitoring Expert. Although other methods of time synchronization are available, such as with
ION Setup, a Network Time Protocol (NTP) server, a Global Positioning System (GPS) receiver,
or 3rd party protocols, it is important that you use only onemethod of time synchronization on each
network. If you usemultiple methods, the timestamps will differ for the sites and devices that are
using separate time synchronizingmethods.

Before you configure time synchronization on your network, you should familiarize yourself with the
Clock module settings. Once you have done this, you can decide which synchronizationmethod
you want to use.

Enabling and configuring time synchronization
Time synchronization in PowerMonitoring Expert is initially disabled and needs to be enabled and
configured throughManagement Console. The communications port and protocol used for
communications between the software and the networked ION devices is automatically used to
send time synchronization signals to all connected ION devices. The software sends a time sync
packet and the time is set when the packet is received.

When reviewing time synchronizationmessages in the system log, remember that the time in the
message is not the time to which themeter was time synced, but rather it is the time themessage
was posted to the system log. Themessage is posted after themeter is time synced.

Note that ION time synchronization only uses the UTC setting; the LOCAL setting cannot be used.

Time synchronization values are set when sites or Ethernet devices are defined in a Power
Monitoring Expert network. Enable time synchronization or set custom intervals for supported
devices in any site throughManagement Console as follows:
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1. Start Management Console.

2. Select Sites orDevices on the System Setup pane:

Select Sites if you want to customize a particular serial, modem, or Ethernet Gateway
site.

Select Devices if you want to customize an individual Ethernet device.

3. Right-click the device or site and select Configure Device orConfigure Site to open the
related configuration dialog.

4. Right-click inside the dialog and select Advanced Properties.

5. Configure the Time Synch ION Enabled or Time Synch Ethernet Enabled, and Time
Synch Interval Ethernet fields as required for your system.

6. Click OK to save you changes.

The default time synchronization interval of 3600 seconds (displayed inmilliseconds) is
acceptable in most software installations.

NOTE: You need appropriate permissions to configuremeters on your network. Refer to the ION
System Security technical note for details on software andmeter security.



Web Applications Settings
TIP: You can open the Settings page from theSETTINGS link in theWeb Applications banner.

Use the Settings page to access configuration tools andWeb Application settings.

NOTE: Only users with Supervisor, Operator, and Controller access level can access the
configuration tools. Only users with Supervisor access level can configure theWeb Application
settings.

The Settings page consists of a Settings Library and a configuration area. The Settings Library
provides access to the following configuration tools and settings:

Configuration Tools

Hierarchy Manager
Modeling Configuration
Rate Editor
User Manager

Settings

Diagnostics and Services
Localization
Registration Information
Report Theme
Theme

NOTE: The availability of the Rate Editor andModeling Configuration are subject to licensing.
EcoStruxureWeb Services (EWS) appears in theSettings pane only if it is enabled in the system.

Settings

Diagnostics and Services

Diagnostics and Usage

Diagnostics and Usage anonymously sends data to a secure server. Schneider Electric uses this
data to help improve our software by understanding how you use it.

The diagnostics and usage service collects and sends data to Schneider Electric weekly on
Monday at 2:00 AM (server time). Each time the service runs, it creates a log file in the
system\bin folder in the PowerMonitoring Expert install location. All diagnostics and usage data
is sent to Schneider Electric anonymously. None of the collected information identifies you or your
company.

This operation is enabled by default.

To disable the sending of data, select Disable in the dropdown list and click Save to apply the
change.

Solution Guide Reference

7EN02-0414-00 Page 199



Reference Solution Guide

Page 200 7EN02-0414-00

The following diagnostic and usage data is collected:

Diagnostic data Usage data

l PowerMonitoring Expertversion

l Operating system version and type (32- or 64-bit)

l Number of CPU cores

l Systemmemory (RAM)

l .NET Framework version

l SQLServer version

l Distributed or local database

l Location and locales

l Number of monitors in use

l Client screen resolution

l Screen DPI

l Total number of devices

l Device type count

l Number of users

Connected Services

Connected Services lets you share the operational data that is collected by PowerMonitoring
Expert with Schneider Electric. The collected energy and power data can then be used by
connected services – such as EcoStruxure™Power Advisor and EcoStruxure™Asset Advisor – to
help identify gaps or issues in your powermanagement system. It can also help identify power
quality issues within your electrical distribution system.

The collected data depends on the specific services that the customer receives from Schneider
Electric.

To disable the collecting of operational data, select Disable in the dropdown list and click Save to
apply the change.

Localization

Use the Localization configuration page to select the language, region, and currency symbol. The
setting forRegion determines date, time, number, and currency formats.

1. Select the system Language from the drop-down list.

2. Select theRegion from the drop-down list.

Instructions indicate that the applicationmust be reloaded before your changes take effect.

3. Select theCurrency Symbol you want to use from the drop-down list.

4. When you complete your localization settings, click Save.

Registration Information

Registration Information will be used by Schneider Electric to help provide support and to enhance
the service we provide to you. Schneider Electric will never sell nor share this information.



By registering you acknowledge that your registration information will be shared with Schneider
Electric and you consent to receiving occasional communications about your product. Product
communication includes new features, service pack releases, and recommended cybersecurity
updates.

You can edit the registration information at any time through the System Settings.

Report Theme

Change the Report theme to customize the Reports colors and the Reports logo.

To change the Reports colors:

1. UnderReport Colors, choose toUse Theme Colors, or toOverride Theme Colors.
The theme colors are defined by the Theme settings for theWeb Applications. See Theme for
more information.

2. If you chooseOverride ThemeColors, then set the colors for the Report Title, Section Header,
Table Header, Summary, Row Shading, and Section Title, using the drop-down selectors.

3. Click Save to apply the changed settings.

To change the Reports Logo:

1. In SETTINGS, open the Settings Library and click Report Theme.

2. UnderReport Logo, click Select to open the Select Report Logo Image dialog.

3. Select an image currently available in the repository, or

a. Click Upload Image to choose an image file available on your system or drag an image
file into the application area.

b. Click Finish to add it to the image repository.

4. Click OK to complete your selection.

5. Click Save to apply the changed settings.

NOTE: You can useGIF, JPG, JPEG, or PNG image formats. The recommended file size is 250 x
100 pixels. Images are automatically re-sized to fit the logo area in Reports.

Theme
Use the Theme configuration page to:

l Change the image and text that is displayed in the top left corner of theWeb Applications win-
dow.

l Change the color for the borders and other elements of the user interface.

l Specify if you want to display the vendor logo in the top right corner of theWeb applications win-
dow.

l Choose the location of the side panel to be on the right or left side of the user interface.

l Specify if you want to use compact mode navigation.

l Reset the theme to system defaults.
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To change the top left logo and text:

1. Under Theme, click User Defined.

2. Under Image, click Select....

3.  In Select Image, select the image you want, or if the image is not in the Image Library,

Click Upload Image... and either choose an image file available on your system by click-
ingChoose Files..., or drag an image file into the application area.

Click Finish to add it to the Image Library.

4. Click OK to complete your image selection.

The image file name is shown under Image. The image is updated on the banner when you
save your settings. You can useGIF, JPG, JPEG, or PNG image formats. Themaximum file
size is 2MB. Images are automatically resized to fit the logo area on the banner.

5. Use the Text field to change the text beside the logo in the banner. The text is updated when
you save your settings.

6. Click Save to apply the changed settings.

To change the theme color:

1. Under Theme, click User Defined.

2. Under Theme Color, select from several preset color themes or create your own using the

color selector that opens when you click the color theme icon on the right.

When you click a preset color, it is temporarily applied to the interface to show you the effect
of the change.

3. Click Save to apply the changed settings.

To specify the display of the vendor logo:

1. Under Theme, click User Defined.

2. Turn onShow Vendor logo to display the logo, or turn off Show Vendor logo to hide the
logo, in the top right corner of theWeb Applications window.

3. Click Save to apply the changed settings.

To choose the location of the side panel:

1. UnderNavigation, select Left orRight.

2. Click Save to apply the changed settings.

To specify the use of compact mode navigation:

1. UnderNavigation, turn onAlways use compact mode for Navigation.

2. Click Save to apply the changed settings.

Compact navigation replaces themain navigation bar at the top of theWeb Applications user
interface with an options button . The options button is displayed at the top left corner of the
banner. When you click the button, the navigation links to the different Web applications are shown.
Compact mode is used for small displays, such as onmobile devices. TheWeb Applications user



interfaces switches to compact mode automatically when the browser size is reduced below a
certain size. Turning on theAlways use compact mode for Navigation setting forces this mode
regardless of browser size.

To reset the theme to the system defaults:

1. Click Default Theme.

2. Click Save to apply the changed settings.

Hierarchy Manager
Depending on the number of devices you are currently monitoring, organizing the data coming from
those devices can be a difficult task. Hierarchy Manager allows you to organize the devices in
EcoStruxure™PowerMonitoring Expert into recognizable views by defining their relationships as
parts of a systemmodel. Once themodel has been created, energy data associated with the
hierarchy can be grouped, aggregated, and used by other components of PowerMonitoring Expert.

The Hierarchy Manager views are intended to represent the real world electrical, physical, and
business characteristics of your organization. The items contained in a view, and how those items
relate to each other are specified using a template approach. There are several example templates
included in the product to help you create the views applicable to your organization. One of these
templates is configured when PowerMonitoring Expert is first installed.

Open the Hierarchy Manager application from the Configuration Tools section on theSettings page
in theWeb Applications banner. You can also open Hierarchy Manager from the Toolsmenu in the
Management Console.

The following topics provide specific information regarding the features and use of the Hierarchy
Manager application:

l Hierarchy templates

Nodes

Node properties

Common elements of hierarchy templates

l Creating a hierarchy

l Creating an apportionedmeter

l Creating a virtual meter

l Dynamic hierarchy

l Meter apportionment

l Virtual meter

l Using hierarchies in other applications

After you have configured the views of the hierarchy structure, you can use them in different areas
of PowerMonitoring Expert.

NOTE: Before using Hierarchy Manager, ensure that devices, logical devices, or managed circuits
have been added to PowerMonitoring Expert through theManagement Console component.
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Hierarchy templates

When the Hierarchy Manager application opens, everything displayed in the application is based on
the hierarchy template defined in the system. This template defines the parameters of themodel. If
you were to describe the physical layout of a building for example, you could describe the name of
the building, each floor of the building, and the rooms or areas that each floor contains. The
hierarchy template for a building's physical layout does the same thing, using Nodes to represent
the different aspects of themodel.

Note that aVirtual MeterNode is included in the hierarchy template. You can define virtual meters
without associating them with a hierarchy, or you can include virtual meters in a hierarchy the same
way that you include devices. You can select virtual meters for many of the reports in the Reports
application.

Each Node contains instances of that particular Node type, which in turn are defined by a set of
properties. These properties not only define the different parts of themodel, they also define the
relationships that exist between the different Nodes. This is useful when aggregating the device
data used in other parts of PowerMonitoring Expert.

Once themodel has been created, the devices that are collecting data can be associated with the
different levels of the hierarchy that are defined in the template.

Nodes
A Node can be described as the building block of a hierarchy. Nodes are used tomodel a customer
system and can represent:

l Electrical equipment

l Logical concepts

l Physical locations

l Other real-world objects

Nodes are displayed in Hierarchy Manager as a set of tabs. Each tab is labeled with the name of the
part of themodel it represents. Each Node displays a number of Node instances in a grid format. In
Hierarchy Manager, a Node can be described as the type of object required tomodel a system,
while Node instances can be thought of as the reference to the real-world objects in that system.
For example, if 'Car' is used as an example of a Node, then 'my Corvette' could describe an
instance of the Car Node.

A hierarchy that represents the physical layout of a company's industrial site might have a Site
Node, a Building Node, and an Areas Node. Each of those Nodes can contain instances of that
Node type. Under the Building Node for example, you could list the different buildings located in a
particular site. The Properties of each of these Nodes are specified by the user.

Each Node instance is represented in the system as a set of properties that define the
characteristics of that instance. These properties can be further broken down into Attributes and
References.



Node properties

Attributes and References can be used to describe the properties of a Node, and their relationships
to other Nodes. These properties provide the context that helps to describe the different parts of the
model. For example, a Node called Floors might contain attributes such as floor number, and
references such as the association between the Floors Node and the Building Node, or the
association between Floors and Areas.

Attributes

The Attributes of a Node describe the properties of that Node, such as its name and characteristics.
These Attributes could include the breaker rating of an electrical panel or contact information of a
tenant. For example, a Node called Buildings that is part of a physical layout hierarchy could have
an Attribute such as the building name.

Attributes are configurable by entering information into an Attribute field. To add Attribute content to
a new Node instance, select a tab and click Add. To edit existing Attribute content, double-click a
Node instance, or highlight it and click Edit. When theProperties dialog opens, select an attribute
field by clicking in the applicable field and entering the necessary information. Click OK when you
finish specifying all of the necessary attributes for the Node.

References

References describe how aNode in a hierarchy is associated with other Nodes. For example, in a
hierarchy that describes the physical layout of a company's building, a Node called Floor could have
a reference that describes its association with a Node called Areas. These references indicate
which offices are part of each floor. In this example, since a Floor can contain many offices, it is
considered a one-to-many association. Since an office can only be associated with a single floor, it
is considered a one-to-one association. By making these connections between the Nodes, the
hierarchy structure of themodel begins to take shape.

Reference fields require clickingAdd, Edit, orDelete. To add reference content to a Node instance,
click Add for the reference, then select the appropriate entry from the list that appears. You can also
enter dynamic hierarchy time ranges in this section.

To edit existing reference content, double-click the entry in the grid, or highlight it and click Edit, and
thenmake the necessary changes. In most cases, this change would involve either the start or end
dates of the particular reference.

To delete existing reference content, select an entry from the applicable reference type and click
Delete.

NOTE: The Delete button should not be used to end an association with a particular Node
instance. In situtations where a relationship between two Node instances ends after a certain
date, the ideal solution is to edit the references and change the To field to a specific end date that
defines the time range for the relationship. See Creating a hierarchy for more information.
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Common elements of hierarchy templates

The components that make up Hierarchy Manager can appear differently depending on the hierarchy
template installed in the system. Although these different hierarchy templates can have different tab
and property names, and the relationships between the Nodes differ, themethod used tomodify the
hierarchy is similar for most templates. This section provides information regarding the basic steps
tomodifying a hierarchy, regardless of the template used.

Hierarchy Manager has a series of tabs across the top of the page. These tabs are the
representation of the Nodes. Clicking on any of these tabs displays the instances of the Node types
in a grid format.

The process involved with creating an instance of a Node type is the same for most hierarchy
templates. To create a new instance, select the applicable tab and click Add. TheProperties
window opens, containing fields that represent the properties for that particular Node instance. Any
required fields are identified with aRequiredmessage. Click in the attribute fields and enter the
necessary information. Reference fields are selected from a grid, and can also have a time
dimension associated with them (see Dynamic hierarchy for additional information). Click Add to
open theSelect dialog and select the applicable item from the grid. If there are no items to choose
from, youmight need to create a new instance for that Node type.

To edit an instance of a Node type, click the applicable tab, double-click an instance in the grid, or
select it and click Edit. Make the changes to the applicable fields in theProperties dialog and click
OK.

To delete an existing instance of a Node type, select the applicable tab, select an instance on that
tab and click Delete. After you confirm the delete action, the instance disappears from the grid, and
any reference information regarding the deleted instance is removed from all affected Node
instances.

Tree View

Displaying the views of a template is also similar for most template types. You can see the view of
a hierarchy by clicking theShow Views link. The view shows the different levels of the hierarchy,
and the date range for each entry of the hierarchy.

Date Range: Use the To and From fields to select the date range to display the hierarchy.

Available Views: Use this section to switch between different views if there is more than one view
available. The available views are determined by the hierarchy template. Click Updatewhen you
change the date range, the scale, or view.

Scale: Select Days orMonths to provide the appropriate scale to the hierarchy view.

Beside each hierarchy level is a bar that indicates when in the date range the Node was part of the
hierarchy. If the bar has a rounded edge, the Node reference has an end date within the date range.
If the bar has a square edge, the Node reference continues beyond the date range.

You can click the pencil (edit) icon to the left of the bars to open and edit the properties for the
related item.

If you do not see a node in the hierarchy view, make sure the date range includes the date that Node
was part of the hierarchy. You can view the date range for a hierarchy entry by hovering the pointer
on it.



Creating a hierarchy

The following example uses the default hierarchy template (with Site, Buildings, and Areas nodes)
to illustrate the basic functionality of Hierarchy Manager.

In this scenario, you are the facility manager for Faber College. The college includes three buildings,
two of which have already been added to Hierarchy Manager. Building Three has just been
completed, and youmust add this building information into Hierarchy Manager. This involves
creating a new building and areas entries, and adding devices to the areas, all beginning on a
specific date.

At the same time, renovations to Building Two have just been completed which include the
replacement of several meters. In Hierarchy Manager, youmust swap the old devices with the new
by changing the end date for the existing devices to the day they were removed. New devices must
be associated with their correct areas and their start dates must correspond to the date they were
installed.

Open Hierarchy Manager

You need an access level of Supervisor, Controller, or Operator to use the application.

1. Open Hierarchy Manager in one of the following ways:

Click Settings inWeb Applications, and then click Hierarchy Manager in theCon-
figuration Tools panel.

OpenManagement Console and click Tools > Hierarchy Manager.

2. Type a user name and password in the Log In dialog, if required, and click OK to open
Hierarchy Manager.

Site, Buildings, andAreas tabs represent each Node type.

In the following steps, devices have already been added to the system throughManagement
Console, and the hierarchy has been populated with site, building, and area information. For
additional information regarding adding devices to the system, refer to the "Management
Console" section of thePowerMonitoring Expert System Guide.
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Add Building Three to the hierarchy

1. Click theBuildings tab.

TheBuildings grid includes Building One and Two, the site they are associated with, and the
areas defined for each building.

2. To add Building Three, click Add above the Buildings grid to open theProperties dialog for the
Buildings node, then type Building Three in theName field.

3. Click Add above the Site grid to open theAdd Site References dialog and select the Faber
College site name in the grid.



4. Click the From date field or click the calendar icon beside it. Select a start date of March 15 in
the calendar.

When you select the date, the calendar closes.

5. Confirm that the date has changed in theStart Date column underSites, then click OK.
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Associate areas and devices to Building Three

1. Click theAreas tab.

Four new areas need to be created: Room 3A to Room 3D. You need to associate these areas
with the new building, and assign devices to each area. Set the start date for all of these to
March 15.

2. Click Add above theAreas grid to open theProperties dialog for the Areas node, then type
Room 3A in theName field.

3. Click Add above theBuilding grid to open theAdd Building References dialog.

4. Select Building Three in the grid.

5. Click the From field or click the calendar icon beside it. Select the start date of March 15 in the
calendar.



When you select the date, the calendar closes.

6. Confirm that the date has changed in the From field underBuilding, then click OK.

7. Click Add above theDevice grid to open theAdd Device References dialog.

8. Select Faber.Bldg3A to assign it to the Room 3A.

9. Click the From field or click the calendar icon beside it. Select the start date of March 15 in the
calendar.

When you select the date, the calendar closes.

10. Confirm that the date has changed in theStart Date column underDevice, then click OK.

11. Follow the same steps to create Room 3B, 3C, and 3D as areas, and assign the respective
devices Faber.Bldg3B, Faber.Bldg3C, and Faber.Bldg3D to them. The following image shows
the complete set of entries on theAreas tab.

View the hierarchy in a tree configuration

To see the hierarchy in a tree organization, switch to the Tree View by clickingShow Views. You
can use this window to select the type of view you want to see (if multiple views are available), and
the date range for the view. Click Update to refresh the view after youmake your selections.
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Click:

l The plus sign in the view to expand that entry.

l Theminus sign beside an entry to collapse that part of the hierarchy.

l The pencil (edit) icon to open and edit the properties for the related item.

l The bar for each entry to see the Node name and the effective date range for that entry.

l Click Show Types to return to the initial Hierarchy Manager page.

Adding and removing devices

This part of the example involves replacing two devices in Building Two after a renovation. Set the
end dates for the devices you are replacing to the date they are removed. Then assign new devices
to the areas with their start dates set to the day the devices are installed.

The devices that you are replacing are associated with Room 2B and 2C in Building Two.

When this task is complete:

l The entry for each device is grayed-out and italicized in the hierarchy if theEnd Date is the cur-
rent date or earlier.

l Any reports that include these areas only includes data collected by these devices up to this
new end date.

NOTE: Date ranges extend from start of day to start of day. This means that the end date does not
include data collected for that day.

1. Open Hierarchy Manager and click theAreas tab.

2. Double-click Room 2B in the grid, or select it and click Edit to open theProperties for Room
2B dialog.



3. Double-click Faber.Bldg2B in theDevice grid, or select it and click Edit to open theEdit
Device References dialog.

4. Click the To field, or click the calendar icon beside it. Select the end date of March 15 in the
calendar.

When you select the date, the calendar closes.

5. Confirm that the date has changed in theEnd Date column underDevice, then click OK.

You can now associate the new device with this area. For the purposes of this example the
new device has already been added to the system throughManagement Console.

6. Click Add above theDevice grid to open theAdd Device References dialog.

7. Select the new device, Faber.Bld2BN.

8. Click the From field, or click the calendar icon beside it. Select the start date of March 15 in
the calendar.

When you select the date, the calendar closes.

9. Confirm that the date has changed in theStart Date column underDevice, then click OK.

10. Perform the same steps for Room 2C.

When you complete these tasks, any reports that include these areas with a date range that
extends beyond the device start date includes data collected by these new devices as of their start
date. The reports do not include any data for the removed devices as of their end date.

Creating an apportioned meter

You can create an apportionedmeter when you add a device to a hierarchy node by changing the
value in thePercentage field in the Add Device References dialog. The default value is 100 percent.
The percentage can be a negative, positive, or integer value. The percentage field is restricted to 15
characters. Time intervals for apportionedmeters function in the sameway as devices. SeeMeter
apportionment for more information.
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NOTE: You cannot edit the percentage for an apportioned device after you set it. To change the
percentage, you need to change the end date and add the device with a new start date and updated
apportionment percentage, or delete it from the hierarchy and add it again as new entry with the
required percentage.

To create an apportionedmeter:

1. Select the device you want to apportion in the Add Device References dialog.

2. Change the value in thePercentage field.

3. If required, click the From or To fields to change the start and end dates for the apportioned
meter.

4. Click OK.

The following image shows that Faber.Bldg2A has an apportioned value of 75 percent as of March
15.

Creating a virtual meter

TheVirtual Meter tab includes Add, Edit, andDelete controls above a data grid showing any
previously created virtual meters.



Add: SelectingAdd opens the Properties dialog. Type a name for the virtual meter and click Add in
theDevices area to select devices to attach to it. You can attach a device, a previously created
virtual meter, or an apportionedmeter in the sameway you attach a device to a hierarchy node.

Time intervals of the attached devices operate in the samemanner as time intervals onmeters
attached to hierarchy nodes.

Edit: Editing a virtual meter is like editing the relationship between a hierarchy node and a device.
You can add, edit, or delete virtual meters but you need to ensure that your changes respect time
intervals.

For example, if you are replacing ameter, you need to update theEnd Date for it and you need to
specify an appropriateStart Date for the new meter. Do not delete the original meter as this
removes themeter historically.

Delete: You can delete a virtual meter but you need to take care when doing so. When you delete a
virtual meter, the relationships between all hierarchy nodes and the virtual meter are removed.
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Adding a virtual meter to a hierarchy node

After you create a virtual meter, it appears in device lists with the other devices. You can attach a
virtual meter to a hierarchy node in the sameway as the other devices.

See Virtual meter for more information.

Dynamic hierarchy

Another feature of Hierarchy Manager is the ability to assign devices or Node instances for discrete
units of time. Instead of devices existing in either an assigned or unassigned state independent of
time, a device can be assigned to one Node instance for a specific length of time, then assigned to
another instance for another length of time.

With this time dimension, Hierarchy Manager can be used by organizations that require an ever-
changing representation of their system. If one tenant moves out and another moves in, that change
can be reflected in the hierarchy. Energy and power usage can be tracked for each tenant over time,
and billing information can be collected, aggregated, and displayed in a report.

NOTE: If your hierarchy does not change over time you do not need to set the date ranges for the
various devices or Node instances. In PowerMonitoring Expert, these static hierarchies exist from
the date when the system was first commissioned (system start), to the farthest date the system
recognizes (end of time).

Replacing or reconfiguring a device can also be captured in a hierarchy. If a device requires
replacement or reconfiguring, it can be unassigned from an instance on a specific date, and the new
or reconfigured device assigned to the same instance. The entry for the unassigned device is
grayed-out and italicized in the hierarchy if theEnd Date is the current date or earlier.

Dynamic hierarchies are established when you create or edit the properties of a Node instance that
is associated with a device. For example, if Customer A is set to lease a rack from a data center,
you can assign the racks and circuits to that customer on a specific date. When tenant A's lease
expires, you can remove the assignment of the racks and circuits on the expiration date and
reallocate them to tenant B.

See Creating a hierarchy for details on how to use the dynamic hierarchies function.

Meter apportionment

Meter apportionment allows you to assign a percentage of a device that has been assigned to an
area. For example, if a common area is monitored by a single meter but shared by two tenants, for
billing purposes youmight want to allocate only a portion of themeter to each tenant. If tenant 1
uses 60% of the common area and tenant 2 uses 40%, you can attach 60% of ameter's reading to
the tenant 1 area node and the other 40% to the tenant 2 area node.

See Creating an apportionedmeter for more information.



Virtual meter

A virtual meter allows you to aggregatemeasurements from any combination of devices,
apportionedmeters, or other virtual meters available in Hierarchy Manager. The newly created
virtual meter can be assigned to a node in Hierarchy Manager just like any other device, and
appears in dialogs that have aViews selection. You can even create an apportionedmeter from a
virtual meter.

Examples:

l Assume that there are several feeder meters connected to themain power bus and you want to
calculate the total power usage. You can create a virtual meter that includes each of the feeder
meters. Then you can choose one of the reports supporting virtual meters to generate a report
showing the total power usage for the virtual meter.

l Assume that there is a large areamonitored by a single meter (M1). Within that area is a single
room that is monitored by a separatemeter (M2). Tenant 1 is using the small room and Tenant 2
is using the remaining area. To calculate Tenant 2's power usage, the readings fromM2must
be subtracted from the readings of M1. This can be accomplished by assigningM1 and an
apportionedmeter of M2with an allocation of -100%, removingM2's readings from Tenant 2's
power usage calculation.

The alternative is to create a virtual meter. For example, create a new virtual meter Tenant_2_
Net_Meter, and assign the two devices, M1 andM2 (-100%), to the virtual meter. The virtual
meter is assigned to Tenant 2's node. If at some time in the future a new meter is added, you
can edit the virtual meter to include the new meter.

See Creating a virtual meter for more information.

Using hierarchies in other applications
You can use hierarchies in the following PowerMonitoring Expert (PME) applications:

l Dashboards

l Reports

l Trends

In the Dashboards application, you can use hierarchies in the gadget data series selector to select
data from a source based on its location in the hierarchy. Selecting a hierarchy View allows you to
group device data at different aggregation points in the hierarchy. For example, it is possible to
create a dashboard that depicts the energy usage of a single floor in a building as a single data
series even though there aremultiple meters monitoring different circuits.

You can also use hierarchies in several of the reports available in the Reports application. You can
use the source selector for these reports to select items from the hierarchy to include in the report.
As in the Dashboards application, a hierarchy View groups device data at different aggregation
points, which are then displayed in a report. In addition to the default reports, hierarchies can also be
used in custom reports that have been created for use in different solutions.

You can use hierarchies in the Trends application to select data from a source based on its location
in the hierarchy.
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Configuring the Energy Modeling report
Before you can use themodeling report, youmust first create amodel for your facility or process
with the CreateModel Report. This model is then used in the UseModel Report. You only use the
CreateModel report during configuration. After themodel has been created, you do not need to run
this report again, unless you want to create a new model.

To create amodel and use the Energy Modeling report:

1. Run the CreateModel report with an initial set of parameters and analyze the results. Select
No for theSave Model Configuration input parameter.

TIP: Consider choosing a reporting period with normal consumption behavior to create your
model. For example, a good period could be "Last Year".

2. Based on the results, define sub-models and exception periods, if applicable.

3. Re-run the CreateModel report using sub-models, exception periods, andmodified input para-
meters and analyze the results.

4. Repeat steps 2 and 3 until you are satisfied with the accuracy of themodel.

5. Run the CreateModel report onemore time, select Yes for theSave Model Configuration
and enter ameaningful model name. This saves your model to the database.

6. Run the UseModel report with themodel you created. Ensure that the sub-models and excep-
tion periods are correctly defined for the reporting period.

7. (Optional) Setup a subscription to run the UseModel report on a regular basis. Select Yes for
the Insert Date input parameter. This saves themodel output data to the database. You can
use this data in the Trends and Dashboards applications.

Defining a sub-model

Sub-models are used to improve the accuracy of the overall model by recognizing time intervals or
operating conditions with different consumption characteristics. For example, using a sub-model
that differentiates between weekdays and weekend days can bemore accurate for processes that
are influenced by a workweek pattern, than using a single model for all days. Which sub-model
works best depends on the nature of the facility or process.

Sub-models are defined with theModeling Configuration tool in theSettings > Configuration
Tools area of theWeb Applications. Use one of the pre-defined sub-models, or create your own.

To define a sub-model:

1. In Modeling Configuration, select theSub-Models tab.

2. Click Insert in the top right corner of the window to switch to insert mode.

3. Enter aSub-Model Name, select aMinimum Aggregation Interval, and enter aDesired
Label, andCondition in the input boxes at the top of themain display grid.

The Conditionmust be a valid SQL query statement.



4. Click Insert to the right of the input boxes to insert the new sub-model definition. The defin-
ition is moved to the bottom of themain display grid, below any pre-existing sub-model defin-
itions.

5. Click Search in the top right corner of the window to switch back to searchmode.

6. (Optional) To edit an existing definition, click Edit to the right of the definition in the display
grid, or click any of the fields of the definition in the grid. To update the definition, after editing

it, click Update , to cancel click Cancel . To delete a sub-model definition, click Delete

.

Defining exception periods

Exception periods are special time intervals, such as holidays, with unpredictable consumption
behavior that is different from the rest of the time period. Exception periods can be defined down to a
specific time interval for a specific source andmeasurement.

You can either choose tomodel these exception periods separately, whichmeans they will become
a sub-model, or you can choose to exclude them from themodel completely.

Exception periods override sub-model definitions if they cover the same time period. For example,
you could define a holiday, a day your facility was in shutdown, or a day when you performed
system tests, as an exception period. If that day was a weekend day and you are using a sub-model
to differentiate between weekdays and weekend days, then the exception period overrides the sub-
model, whichmeans that special day will bemodeled differently than a regular weekend day.

Exception periods are defined with theModeling Configuration tool in theSettings >
Configuration Tools area of theWeb Applications.

To define exception periods:

1. In Modeling Configuration, select theException Periods tab.

2. Click Insert in the top right corner of the window to switch to insert mode.

3. Enter anException Period Name, select aSource andMeasurement, enter aDesired
Label, andCondition in the input boxes at the top of themain display grid.

The Conditionmust be a valid SQL query statement.

NOTE: TheDesired Label is used to control if the exception period is excluded from the
model, or if it is treated as a sub-model. Enter the text Delete as Desired Label if you want to
exclude that period from themodel. Enter any other text, for example a descriptive text such
as Holiday, if you want to sub-model the exception period. An excluded exception period will
be blank in the final model output graphic.

4. Click Insert to the right of the input boxes to insert the new exception period definition. The
definition is moved to the bottom of themain display grid, below any pre-existing exception
period definitions.

5. Click Search in the top right corner of the window to switch back to searchmode.
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6. (Optional) To edit an existing definition, click Edit to the right of the definition in the display
grid, or click any of the fields of the definition in the grid. To update the definition, after editing

it, click Update , to cancel click Cancel . To delete an exception definition, click Delete

.

See aModel creation example.

Create Model Report

NOTE: This report is part of the Energy Analysis Module. This Module requires a separate license.

This report is used to create amodel of your facility or process. Themodel is then used in the Use
Model Report to compare expected consumption to actual consumption.

You only use the CreateModel Report during configuration. After themodel has been created, you
do not need to run this report again, unless you want to create a new model.

Prerequisites

To use this report, the data for the independent variables and for the dependent variable must be
available in the PowerMonitoring Expert database for the reporting period. If you want to use sub-
models and exception periods, then thesemust be defined.

Report inputs:
Title

Type a title for the report in the text box.
Dependent Variable

The dependent variable is themeasurement you want to model. For example, if you aremodeling
the energy consumption of a building based on outside temperature, then the energy is the
dependent variable.

To specify the dependent variable,

1. Click Select Source and select a device from theDevices list or a Hierarchy node from the
Views list.

2. Click Select Measurement and select themeasurement to bemodeled.

3. Select an aggregationmethod for themeasurement from theAggregation Method drop down
list.

The following aggregationmethods are available:

AVG: calculates the averagemeasurement value over the interval.
SUM: adds up themeasurements values over the interval.
DELTA: subtracts the beginningmeasurement value from the endmeasurement value of the
interval.



NOTE: If you are using a Hierarchy node as a source for the dependent variable and you are using
a cumulativemeasurement, such as Real Energy (kWh), youmust use SUM as aggregation
method. This is because the hierarchy converts the cumulativemeasurement into interval
measurements.

Independent Variable(s)

The independent variable is the driver that influences themeasurement you want to model. For
example, if you aremodeling the energy consumption of a building based on outside temperature,
then the outside temperature is the independent variable. You can specify one or more independent
variables.

To specify the independent variables,

1. Click Select Source and select a source from the list. Hierarchies are not supported for inde-
pendent variables.

2. Click Select Measurement and select themeasurement.

3. Select an aggregationmethod for themeasurement from theAggregation Method drop down
list.

The following aggregationmethods are available:

AVG: Calculates the averagemeasurement value over the interval.
SUM: Sums themeasurements values over the interval.
DELTA: Subtracts the beginningmeasurement value from the endmeasurement value of the
interval.
MIN: Selects theminimummeasurement value over the interval.
MAX: Selects theminimummeasurement value over the interval.
CDD: Calculates the Cooling Degree Days.
HDD: Calculates the Heating Degree Days.

For CDD or HDD, enter the base temperature in theDegree Days Base Temperature input
box that is displayed when one of these options is selected.

To add additional variables, click the + sign next to theSelect Source button. Click - to remove a
variable. To enable or disable a variable, select or clear the check box next to theSelect Source
button.
Reporting Period

Use this input to select the timeframe for the data you want to view in the report.

Select the reporting period from the dropdown list. The timeframe options in the timeframe dropdown
are relative to the date the report is run. To run a report that starts and ends in the past, select the
fixed date option. Type a start and end date in the date boxes or click the arrows beside the dates to
display a pop-up calendar and select a date. Type a time in the time boxes or click the up and down
arrows beside the time to adjust the hours or minutes up or down.

Select whether you want to view timestamps in either Server Local Time, UTC (Universal
Coordinated Time), or in the timezone of the source.
Interval and SubModel Configuration

Select the reporting interval from the Interval drop-down list.
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Select the submodel from the SubModel drop-down list. The options in this drop-down list depend
on the selected Interval and the submodels that have been defined in Settings > Configuration
Tools > Modeling Configuration.

TheDatabase Driven option is used to define operating conditions instead of time periods for sub-
modeling. For example, you could define the condition of Power Factor < 0.8. That means that one
sub-model is used when the Power Factor is < 0.8 and a different one when it is >= 0.8. This is
similar to sub-modeling based on weekdays versus weekend days, just that the Power Factor value
is used as a condition instead of the day of the week.

When you select Database Driven, additional input boxes are displayed to select theSource,
Measurement, Key, andValue. The Key is the condition, for example for Power Factory < 0.8,
enter <0.8 in the Key input box. The Value box is just a label to identify the condition, so you could
enter Low PF for low Power Factor.

You can add one or more conditions. Click the + icon to add additional conditions.

NOTE: Conditions are applied in the order in which they are defined in the report.

Use Exception Periods

Choose to use exception periods or not by selectingYes orNo forUse Exception Periods.
Show Detailed Results

Choose to include details in the report or not by selectingYes orNo forShow Detailed Results.

Details include the calculated formulas and individual relationship between each driver and the sub
model data.
SaveModel Configuration

Choose to save the createdmodel to the database or not by selectingYes orNo forSafe Model
Configuration.

For saving themodel, enter themodel name in theModel Name input box that is displayed when
Yes is selected forSafe Model Configuration.

Example:

SeeModel creation example

To calculate themodels, PME uses the Accord Framework Library which can be found at:
http://accord-framework.net/index.html

Use Model Report

NOTE: This report is part of the Energy Analysis Module. This Module requires a separate license.

The UseModel Report shows the expected consumption of your facility or process, based on a
model created with the CreateModel Report. The report shows a graphical representation of the
modeled data, the actually measured data, and the delta between the two. It also includes tables
with numeric data.

Use this report to compare expected consumption to actual consumption in order to identify
unexpected changes in your consumption, or to identify actual savings as a result of energy
management measures.



NOTE: The report is not limited to energy consumptionmodeling. You can use it to model any
quantity that is dependent on drivers, for example you canmodel Power Factor based on power
demand.

Prerequisites

To use this report, at least onemodel must have been defined for your facility or process. The data
for the independent variables must be available in the PowerMonitoring Expert database for the
reporting period.

Report inputs:
Title

Type a title for the report in the text box.
Choose aModel and a Reporting Aggregation Interval

Select themodel you want to use for the report from theModel drop-down list.

Select the aggregation interval you want to use for the report from theReporting Aggregation
Interval drop-down list. The options available in this drop-down list depend on the selectedmodel.
Display Mode

Select in which form you would like to see the report output from theDisplay Mode drop-down list.

The following display modes are available:

Forecast: Compare themodel output for the reporting period to the actually measured data for that
period, where themodel was created for a baseline period in the past.
Backcast: Compare themodel output for a past period to the actually measured data for that
period, where themodel was created for the reporting period in the present time.

Reporting Period

Use this input to select the timeframe for the data you want to view in the report.

Select the reporting period from the dropdown list. The timeframe options in the timeframe dropdown
are relative to the date the report is run. To run a report that starts and ends in the past, select the
fixed date option. Type a start and end date in the date boxes or click the arrows beside the dates to
display a pop-up calendar and select a date. Type a time in the time boxes or click the up and down
arrows beside the time to adjust the hours or minutes up or down.

Select whether you want to view timestamps in either Server Local Time, UTC (Universal
Coordinated Time), or in the timezone of the source.
IncludeMeasured Data

Choose to include the actual data with themodeled data or not by selectingYes orNo for Include
Measured Data.
Enter an optional coefficient in% to be applied on themodeled data

(Optional) Enter coefficients that are applied to themodeled data to adjust themodel output based
on known or expected changes.
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For example, if you implemented an energy conservationmeasure on June 1, 2016 for which you
are expecting an energy saving of 15%, enter -15 as a coefficient and June 1, 2016 as the start date
from which to apply it on. All modeled data, starting with that date, will be adjusted by -15%. You
can addmultiple coefficients at multiple dates. Coefficients are applied cumulatively, on top of any
previously applied coefficients.

To specify a coefficient,

1. Enter the coefficient value in percent, including the sign, in the text box.

2. Enter the date on which this coefficient takes effect into the date box.

To add additional coefficients, click the + sign next to the coefficient text box. Click - to remove a
coefficient.
Insert Data

You can save the output of themodel report into the PowerMonitoring Expert database and use it
for display in Dashboards and Trends. The source name created for this data in the database is
Modeled_Data.<model name>. The followingmeasurements will be recorded for this source:

Measured: This is a copy of the dependent variable measured data.
Modeled Data: This is the data calculated by themodel for the dependent variable.
Residual: This is the delta between theMeasured data and theModeled data
Residual%: This is the Residual data in percent.

To save the data into the database, select Yes for Insert Data.

TIP: Setup a subscription to run themodel report weekly for the last 7 days and save the output
into the database. This will ensure you have a complete data set for modeled data for use in
Dashboards and Trends.

Example:



TIP: Move your pointer over the chart line to see tooltips with measurement details.

NOTE: This example only shows selected pages from the report, it does not show the entire
report.

To calculate themodels, PME uses the Accord Framework Library which can be found at:
http://accord-framework.net/index.html
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Model creation example

The following example shows the process of creating amodel for use with the UseModel Report. It
shows the steps for creating a basic model and then improving it iteratively.

In this example we use the report to model the HVAC related electrical energy consumption of a
building. Our goal is to create a daily model for energy consumption based on outside temperature
and humidity. We use consumption data for the year 2017 to create themodel.

Model creation run 1

The dependent variable is the electrical Real Energy (kWh)measurement for the HVAC system of
the building. The independent variables are the outside temperature and humidity.

We use the following inputs for the CreateModel report:

Title CreateModel Report

Dependent Variable
Source = HVAC - Fans and Compressors
Measurement = Real Energy (kWh)
AggregationMethod = SUM

Independent Variable(s)

Source = Victoria.Weather
Measurement = Weather Temperature (°C)
AggregationMethod = AVG

Source = Victoria.Weather
Measurement = Weather Relative Humidity
(%)
AggregationMethod = AVG

Reporting Period 1/1/2017 - 12/31/2017, Server Local Time

Interval and SubModel Configuration
Interval = Week
SubModel = No SubModel

Use Exception Periods No
Show Detailed Results No
SaveModel Configuration No

For the first run we choose an interval ofWeek, only to see if there is a strong relationship between
consumption and the independent variables. Later we change this toDay to get a Daily Model.

Results:



TIP: Move your pointer over the chart line to see tooltips with measurement details.

Themodel accuracy, measured by the R² value, is pretty high, which show that there is a correlation
between the energy consumption and the outside temperature as well as humidity.

For the next run, we use a Daily aggregationmethod.

Model creation run 2

We change the Interval to Day.

We use the following inputs for the CreateModel report:

Title CreateModel Report

Dependent Variable
Source = HVAC - Fans and Compressors
Measurement = Real Energy (kWh)
AggregationMethod = SUM
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Independent Variable(s)

Source = Victoria.Weather
Measurement = Weather Temperature (°C)
AggregationMethod = AVG

Source = Victoria.Weather
Measurement = Weather Relative Humidity
(%)
AggregationMethod = AVG

Reporting Period 1/1/2017 - 12/31/2017, Server Local Time

Interval and SubModel Configuration
Interval = Day
SubModel = No SubModel

Use Exception Periods No
Show Detailed Results No
SaveModel Configuration No

Results:



The R² has dropped and the visual correlation is not very high. The charts show that there is a big
difference in consumption between weekdays and weekends. This difference cannot be explained
by outside temperature or humidity alone. For the next run we use sub-models for weekdays and
weekends.

Model creation run 3

Weuse aWeekday vs Weekend sub-model.

We use the following inputs for the CreateModel report:

Title CreateModel Report

Dependent Variable
Source = HVAC - Fans and Compressors
Measurement = Real Energy (kWh)
AggregationMethod = SUM

Independent Variable(s)

Source = Victoria.Weather
Measurement = Weather Temperature (°C)
AggregationMethod = AVG

Source = Victoria.Weather
Measurement = Weather Relative Humidity
(%)
AggregationMethod = AVG

Reporting Period 1/1/2017 - 12/31/2017, Server Local Time

Interval and SubModel Configuration
Interval = Day
SubModel =Weekday vs Weekend

Use Exception Periods No
Show Detailed Results No
SaveModel Configuration No

Results:
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The R² has much improved. There is a good correlation between outside temperature and humidity
and consumption. There are still a few days with a large negative residual value. Upon closer
inspection we find that most of these days are holidays. For the next run we use exception periods
to account for the holidays.

Model creation run 4

Weuse exception periods to account for the holidays.

We use the following inputs for the CreateModel report:

Title CreateModel Report

Dependent Variable
Source = HVAC - Fans and Compressors
Measurement = Real Energy (kWh)
AggregationMethod = SUM



Independent Variable(s)

Source = Victoria.Weather
Measurement = Weather Temperature (°C)
AggregationMethod = AVG

Source = Victoria.Weather
Measurement = Weather Relative Humidity
(%)
AggregationMethod = AVG

Reporting Period 1/1/2017 - 12/31/2017, Server Local Time

Interval and SubModel Configuration
Interval = Day
SubModel = Weekday vs Weekend

Use Exception Periods Yes
Show Detailed Results No
SaveModel Configuration No

Results:
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Wehave again improved themodel. In our example, the building is cooled electrically, whichmeans
the greatest impact of outside temperature on energy consumption is during the cooling season. To
account for that, we change the AggregationMethod for outside temperature to Cooling Degree
Days (CDD) for the next run.

Model creation run 5

We change the AggregationMethod for outside temperature to Cooling Degree Days (CDD) with a
base temperature of 11 °C.

We use the following inputs for the CreateModel report:

Title CreateModel Report

Dependent Variable
Source = HVAC - Fans and Compressors
Measurement = Real Energy (kWh)
AggregationMethod = SUM

Independent Variable(s)

Source = Victoria.Weather
Measurement = Weather Temperature (°C)
AggregationMethod = CDD

Source = Victoria.Weather
Measurement = Weather Relative Humidity
(%)
AggregationMethod = AVG

Reporting Period 1/1/2017 - 12/31/2017, Server Local Time

Interval and SubModel Configuration
Interval = Day
SubModel = Weekday vs Weekend

Use Exception Periods Yes
Show Detailed Results No
SaveModel Configuration No

Results:



Wenow have a pretty accuratemodel of our energy consumption based on outside temperature and
humidity.

TIP: Choose to includemodel creation details in the report.

Select Yes forShow Detailed Results in the Report Inputs to include information on themodeling
formulas and the relationship between the drivers and the submodel data. The following are
selected examples of the type of details you can get.
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Statistical information:

Weekday sub-model data driven by outside temperature vs measured data:

Weekday sub-model data driven by outside temperature with influence of humidity removed vs
measured data:



Weekend sub-model data driven by outside temperature vs measured data:

Weekend sub-model data driven by relative humidity vs measured data:

Next Step:

Run the CreateModel report one last time with theSave Model Configuration parameter set to
Yes. This saves themodel into the database andmakes it available for use with the UseModel
Report.

Rate Editor
The Rate Editor is aWeb-based application that lets you change cost values for items included in a
billing report.

Open the Rate Editor application from the Configuration Tools section on theSettings page in the
Web Applications banner. You can also open Rate Editor from the Toolsmenu in theManagement
Console.

TheRate File list on the left lists all of the rate files contained in the ratelibrary folder in the Power
Monitoring Expert install location under applications\config\reports\billing report.
When you add rate files to the folder, they are included in theRate File list.

Rate Editor User Interface

The Line Item Label andUnit Cost areas on the right list a description of line items and the
associated cost values defined in each rate file. Click a rate file to view its line items and cost
values.
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Tomodify the unit cost value for billing report purposes:

1. Click the unit cost value that you want to change to enable editing.

2. Type the new value and press Enter to complete the update.

3. To return to the previous value, click Undo.

The rate files included in the product are examples of various billing scenarios. The files are
intended to be copied andmodified tomeet your specific requirements. For further information about
creating or modifying rate files, see the documentation, tutorials, and examples included in the
BillingModule Toolkit (available in the PowerMonitoring Expert Exchange).

User Manager

TIP: You can open User Manager from the Configuration Tools folder on theSETTINGS page in
theWeb Applications banner. You can also open User Manager from the Tools > Web Tools
menu in theManagement Console.

NOTE: Youmust have supervisor-level access to use User Manager, otherwise the link on the
SETTINGS page is not available.

Use User Manager to configure users and user groups. PowerMonitoring Expert (PME) does not
provide any pre-configured user accounts or user groups. One supervisor account is created with a
user defined password during the installation of the software. Create user accounts and groups to
meet your needs. User Manager also gives information about theWeb Application user licenses for
the system.

WARNING
POTENTIAL COMPROMISE OF SYSTEM AVAILABILITY, INTEGRITY, AND
CONFIDENTIALITY

Use cybersecurity best practices when configuring user access.

Failure to follow these instructions can result in death, serious injury, equipment
damage, or permanent loss of data.

Cybersecurity policies that govern user accounts and access – such as least privilege and
separation of duties – vary from site to site. Work with the facility IT System Administrator to ensure
that user access adheres to the site-specific cyber security policies.

To configure users and user groups, see:

Users

l Users

l Adding a standard user

l Adding aWindows user

l Adding aWindows group



l Changing a username

l Changing a user password

l Changing a user access level

l Changing user details

l Deleting a user

User groups

l User Groups

l Adding a user group

l Adding a user to a user group

l Adding sources to a user group

l Changing a user group name

l Removing a user from a user group

l Removing sources from a user group

l Changing application access for a user group

l Moving a user between user groups

l Deleting a user group

For information on theWeb Application user licenses, see:

l ViewingWeb Applications user license information

For reference information see:

l UserManager user interface

l User access levels and permissions

Users

A user is an account in PowerMonitoring Expert (PME) that provides access to the system. A user
has a username, whichmust be unique, and a password. You use the username and password to
log into PME.

PME supports 3 different types of users - standard users, Windows users, andWindows groups.

The following table shows the characteristics of each user type:

User Type Characteristics

Standard user

This is a PME native user account. The username, password, and
details are defined in the PME UserManager.

Note: The email addresses defined for a user can be used for report
subscriptions.
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User Type Characteristics

Windows user
This is an account from an external Windows system. The
username, password, and details are defined through theWindows
Active Directory or local Windows operating system.

Windows group
This is a group of accounts from an external Windows system. The
username, password, and details are defined through theWindows
Active Directory or local Windows operating system.

Each user has an access level, which is set in User Manager. The access level determines which
actions the user is allowed to take in PME.

There are 5 different access levels. The highest level is Supervisor, the lowest level is Observer.
All Windows users that are amember of aWindows group in PME have the same access level as
the one set for theWindows group. For details on the permissions granted by the different access
levels see User access levels and permissions.

Each user is amember of at least one user group. The user group determines which sources and
applications the user can access. By default, users are assigned to the Global user group which has
access to all sources and applications in the system. See user groups for details on how to
configure groups and assign users to groups.

Rules
The following rule applies to users in PME:

l AWindows user that is amember of multipleWindows groups with different access levels in
PME, gets the highest access level of any of the groups.

Example:

Windows user BillG is amember of Windows group A with observer access level in PME.
Windows user BillG is also amember of Windows group B with operator access level in PME.
As a result, BillG has operator access level in PME.

Limitations
The following limitations exist for standard PME users:

l Usernames must be unique in PME.

l Usernames cannot contain any of the following characters: whitespace character, < > : " / \ | ? *
, ; @ #% ' ^ & ( ) ! = + - ~ . $             

l Passwords cannot contain a whitespace character.

l Usernames and passwords must be between 1-50 characters long.

l Email addresses are not checked for the correct format. Any leading or trailing whitespace char-
acters are removed.

l Multiple email addresses must be separated by a ; (semicolon).

l First name, last name, and organizationmust be between 0-50 characters long. Any leading or
trailing whitespace characters are removed.

The following limitations exist for all PME users:



l A user cannot change its own access level.

l A user cannot delete its own account.

Related topics:

Users

l Users

l Adding a standard user

l Adding aWindows user

l Adding aWindows group

l Changing a username

l Changing a user password

l Changing a user access level

l Changing user details

l Deleting a user

User groups

l User Groups

l Adding a user group

l Adding a user to a user group

l Adding sources to a user group

l Changing a user group name

l Removing a user from a user group

l Removing sources from a user group

l Changing application access for a user group

l Moving a user between user groups

l Deleting a user group

For information on theWeb Application user licenses, see:

l ViewingWeb Applications user license information

For reference information see:

l UserManager

l UserManager user interface

l User access levels and permissions

Adding a standard user

Add a standard user to create an account for accessing PME. Set the access level for the user to
control what they are allowed to do.
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WARNING
POTENTIAL COMPROMISE OF SYSTEM AVAILABILITY, INTEGRITY, AND
CONFIDENTIALITY

Use cybersecurity best practices when configuring user access.

Failure to follow these instructions can result in death, serious injury, equipment
damage, or permanent loss of data.

Cybersecurity policies that govern user accounts and access – such as least privilege and
separation of duties – vary from site to site. Work with the facility IT System Administrator to ensure
that user access adheres to the site-specific cyber security policies.

To add a standard user:

1. In User Manager, select theUsers tab, and then click Add Standard User.

2. In Add Standard User, enter a username and password, and assign an access level.

3. (Optional) EnterDetails information.

4. Click Add.

Related topics:

Users

l Users

l Adding a standard user

l Adding aWindows user

l Adding aWindows group

l Changing a username

l Changing a user password

l Changing a user access level

l Changing user details

l Deleting a user

User groups

l User Groups

l Adding a user group

l Adding a user to a user group

l Adding sources to a user group

l Changing a user group name

l Removing a user from a user group

l Removing sources from a user group



l Changing application access for a user group

l Moving a user between user groups

l Deleting a user group

For information on theWeb Application user licenses, see:

l ViewingWeb Applications user license information

For reference information see:

l UserManager

l UserManager user interface

l User access levels and permissions

Adding a Windows user

Add aWindows user to give this user access to PME. Set the access level for theWindows user to
control what they are allowed to do.

WARNING
POTENTIAL COMPROMISE OF SYSTEM AVAILABILITY, INTEGRITY, AND
CONFIDENTIALITY

Use cybersecurity best practices when configuring user access.

Failure to follow these instructions can result in death, serious injury, equipment
damage, or permanent loss of data.

Cybersecurity policies that govern user accounts and access – such as least privilege and
separation of duties – vary from site to site. Work with the facility IT System Administrator to ensure
that user access adheres to the site-specific cyber security policies.

To add aWindows user:

1. In User Manager, select theUsers tab, and then click Add Windows User

2. In AddWindows User - Selection:

a. Select a domain name.

Use aWindows domain name to add a user from an Active Directory. Use the local
computer name or use localhost to add a user from the local list of Windows users.

b. To find theWindows user you want, (optional) enter a keyword into theAvailable Win-
dows Users search box, and then click Find.

The search result includes all usernames that match all or part of the keyword string.

c. In the search result table, select theWindows user you want to add, and then click Next.

3. In AddWindows User - Details, assign an access level, and then click Finish.
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Related topics:

Users

l Users

l Adding a standard user

l Adding aWindows user

l Adding aWindows group

l Changing a username

l Changing a user password

l Changing a user access level

l Changing user details

l Deleting a user

User groups

l User Groups

l Adding a user group

l Adding a user to a user group

l Adding sources to a user group

l Changing a user group name

l Removing a user from a user group

l Removing sources from a user group

l Changing application access for a user group

l Moving a user between user groups

l Deleting a user group

For information on theWeb Application user licenses, see:

l ViewingWeb Applications user license information

For reference information see:

l UserManager

l UserManager user interface

l User access levels and permissions

Adding a Windows group

Add aWindows group to give all Windows users in this group access to PME. Set the access level
for theWindows group to control what they are allowed to do.



WARNING
POTENTIAL COMPROMISE OF SYSTEM AVAILABILITY, INTEGRITY, AND
CONFIDENTIALITY

Use cybersecurity best practices when configuring user access.

Failure to follow these instructions can result in death, serious injury, equipment
damage, or permanent loss of data.

Cybersecurity policies that govern user accounts and access – such as least privilege and
separation of duties – vary from site to site. Work with the facility IT System Administrator to ensure
that user access adheres to the site-specific cyber security policies.

To add aWindows group:

1. In User Manager, select theUsers tab, and then click Add Windows Group

2. In AddWindows Group - Selection:

a. Select a domain name.

Use aWindows domain name to add a group from an Active Directory. Use the local
computer name or use localhost to add a group from the local list of Windows groups.

b. To find theWindows group you want, (optional) enter a keyword into theAvailable Win-
dows Groups search box, and then click Find.

The search result includes all groups that match all or part of the keyword string.

c. In the search result table, select theWindow group you want to add, and then click Next.

3. In AddWindows Group - Details, assign an access level.

(Optional) Click onView Windows Users in this Windows Group to see theWindows
users that aremembers of the group.

4. Click Finish.

Related topics:

Users

l Users

l Adding a standard user

l Adding aWindows user

l Adding aWindows group

l Changing a username

l Changing a user password

l Changing a user access level

l Changing user details

l Deleting a user
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User groups

l User Groups

l Adding a user group

l Adding a user to a user group

l Adding sources to a user group

l Changing a user group name

l Removing a user from a user group

l Removing sources from a user group

l Changing application access for a user group

l Moving a user between user groups

l Deleting a user group

For information on theWeb Application user licenses, see:

l ViewingWeb Applications user license information

For reference information see:

l UserManager

l UserManager user interface

l User access levels and permissions

Changing a username

Change a username to give the user a better or moremeaningful name.

NOTE: You can only change the name of a standard user in User Manager. You cannot change the
name of aWindows user or group.

To change a username:

1. In User Manager, select theUsers tab.

2. In the users table, select the row of the user for which you want to change the name, and then
click Edit in this row.

3. In Edit Standard User, change the name underUsername to the new name, and then click
Save.

Related topics:

Users

l Users

l Adding a standard user

l Adding aWindows user

l Adding aWindows group



l Changing a username

l Changing a user password

l Changing a user access level

l Changing user details

l Deleting a user

User groups

l User Groups

l Adding a user group

l Adding a user to a user group

l Adding sources to a user group

l Changing a user group name

l Removing a user from a user group

l Removing sources from a user group

l Changing application access for a user group

l Moving a user between user groups

l Deleting a user group

For information on theWeb Application user licenses, see:

l ViewingWeb Applications user license information

For reference information see:

l UserManager

l UserManager user interface

l User access levels and permissions

Changing a user password

Change a user password to update the password as part of a security best practice, or because the
existing password is lost.

NOTE: You can only change the password for a standard user in User Manager. You cannot
change the password for aWindows user.
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WARNING
POTENTIAL COMPROMISE OF SYSTEM AVAILABILITY, INTEGRITY, AND
CONFIDENTIALITY

Use cybersecurity best practices for password creation andmanagement.

Failure to follow these instructions can result in death, serious injury, equipment
damage, or permanent loss of data.

Cybersecurity policies that govern passwords vary from site to site. Work with the facility IT
System Administrator to ensure that passwordmanagement adheres to the site-specific cyber
security policies.

To change a user password:

1. In User Manager, select theUsers tab.

2. In the users table, select the row of the user for which you want to change the password, and
then click Edit in this row.

3. In Edit Standard User, enter the new password underPassword and underConfirm Pass-
word, and then click Save.

Related topics:

Users

l Users

l Adding a standard user

l Adding aWindows user

l Adding aWindows group

l Changing a username

l Changing a user password

l Changing a user access level

l Changing user details

l Deleting a user

User groups

l User Groups

l Adding a user group

l Adding a user to a user group

l Adding sources to a user group

l Changing a user group name

l Removing a user from a user group

l Removing sources from a user group



l Changing application access for a user group

l Moving a user between user groups

l Deleting a user group

For information on theWeb Application user licenses, see:

l ViewingWeb Applications user license information

For reference information see:

l UserManager

l UserManager user interface

l User access levels and permissions

Changing a user access level

Change a user access level to give this user higher or lower access permissions in PME.

WARNING
POTENTIAL COMPROMISE OF SYSTEM AVAILABILITY, INTEGRITY, AND
CONFIDENTIALITY

Use cybersecurity best practices when configuring user access.

Failure to follow these instructions can result in death, serious injury, equipment
damage, or permanent loss of data.

Cybersecurity policies that govern user accounts and access – such as least privilege and
separation of duties – vary from site to site. Work with the facility IT System Administrator to ensure
that user access adheres to the site-specific cyber security policies.

To change a user access level:

1. In User Manager, select theUsers tab.

2. In the users table, select the row of the user for which you want to change the access level,
and then click Edit in this row.

3. In the Edit window, choose the new access level underAccess Level, and then click Save.

Related topics:

Users

l Users

l Adding a standard user

l Adding aWindows user

l Adding aWindows group

l Changing a username
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l Changing a user password

l Changing a user access level

l Changing user details

l Deleting a user

User groups

l User Groups

l Adding a user group

l Adding a user to a user group

l Adding sources to a user group

l Changing a user group name

l Removing a user from a user group

l Removing sources from a user group

l Changing application access for a user group

l Moving a user between user groups

l Deleting a user group

For information on theWeb Application user licenses, see:

l ViewingWeb Applications user license information

For reference information see:

l UserManager

l UserManager user interface

l User access levels and permissions

Changing user details

Change user details to add additional information or update outdated information.

NOTE: You can only change the details of a standard user in User Manager. You cannot change
the details of aWindows user or group.

To change user details:

1. In User Manager, select theUsers tab.

2. In the users table, select the row of the user for which you want to change the details, and then
click Edit in this row.

3. In Edit Standard User, change the details information underDetails, and then click Save.

Related topics:



Users

l Users

l Adding a standard user

l Adding aWindows user

l Adding aWindows group

l Changing a username

l Changing a user password

l Changing a user access level

l Changing user details

l Deleting a user

User groups

l User Groups

l Adding a user group

l Adding a user to a user group

l Adding sources to a user group

l Changing a user group name

l Removing a user from a user group

l Removing sources from a user group

l Changing application access for a user group

l Moving a user between user groups

l Deleting a user group

For information on theWeb Application user licenses, see:

l ViewingWeb Applications user license information

For reference information see:

l UserManager

l UserManager user interface

l User access levels and permissions

Deleting a user

Delete a user if this user is no longer needed, for example if someone no longer needs access to
PME.

NOTE: Windows users or groups are only removed from PME. The group or user is not deleted
fromWindows.
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To delete a user:

1. In User Manager, select theUsers tab.

2. In the users table, select the row of the user you want to delete, and then click Delete in this
row.

3. In the confirmation dialog box, click Delete for a standard user, orRemove for aWindows
user or group.

Related topics:

Users

l Users

l Adding a standard user

l Adding aWindows user

l Adding aWindows group

l Changing a username

l Changing a user password

l Changing a user access level

l Changing user details

l Deleting a user

User groups

l User Groups

l Adding a user group

l Adding a user to a user group

l Adding sources to a user group

l Changing a user group name

l Removing a user from a user group

l Removing sources from a user group

l Changing application access for a user group

l Moving a user between user groups

l Deleting a user group

For information on theWeb Application user licenses, see:

l ViewingWeb Applications user license information

For reference information see:

l UserManager

l UserManager user interface

l User access levels and permissions



User Groups

User groups determine which sources and applications users can access in PowerMonitoring
Expert (PME). Each user is amember of at least one user group.

PME has two built-in groups, the Global group and the Unassigned group. Members of the Global
group can access all sources and applications in the system. Members of the Unassigned group
can access none of the sources and applications in the system. Members of the Unassigned group
are also not allowed to log into PMEWeb Applications.

In addition to the built-in groups, you can create any number of custom user groups in PME. Use
User Manager to create a custom group and define which sources and applications its members can
access.

NOTE: User groupmembership determines which sources and applications are visible to a user.
User groups do not set the user access level for the groupmembers. Access levels are set for
each user individually as part of the user account settings.

The user group feature only applies to the Dashboards, Diagrams, Trends, Alarms, and Reports
applications in PME. For all other applications users have full access to all sources regardless of
their groupmembership.

Rules
The following rules apply to groupmembership in PME:

l A user is amember of at least one group.

l A user can be amember of multiple groups.

l When a new user is created, it is automatically added to the Global group.

l If a member of the Global group is added to another group, it is automatically removed from the
Global group.

l If a user is removed from theGlobal group without being added to a custom group, it is auto-
matically added to the Unassigned group.

l If a user is removed from its last custom group, or this group is deleted, the user is auto-
matically added to the Unassigned group.

l If a member of a custom group is added to the Global group, it is automatically removed from all
custom groups.

l A Supervisor level user can only be amember of the Global group.

l If a Non-Supervisor level user that is amember of a custom group is promoted to Supervisor, it
is automatically removed from all custom groups and added to the Global group.

l If the last custom group is deleted, all of its members aremoved to the Global group.

The following rules apply to resource access by groups in PME:

l A user that is amember of multiple groups can access the sources of each group.

l If a member of a custom group is deleted or removed from the group, then this user's public con-
tent, such as dashboards or reports, remains available to the group.
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l If a member of a custom group is deleted or removed from the group, then this user's private con-
tent, such as dashboards or reports, is only available to users with Supervisor access.

l If a member of a custom group is removed from the group, then this user has no longer access
to any of its content, such as dashboards or reports, that was created during its groupmem-
bership.

Limitations
The following limitations exist for user groups in PME:

l TheGlobal and Unassigned user groups cannot be renamed or deleted.

l The default settings for which sources and applications can be accessed in the Global and
Unassigned user groups cannot be changed.

l User group names must be between 1-255 characters long. Any leading or trailing whitespace
characters are removed.

l If a user group name contains a ] (left angle bracket), the bracket must be followed by a space
or be at the end of the name.

l If a user group name contains a& (ampersand), the ampersandmust not be followed by a #
(hash).

Related topics:

Users

l Users

l Adding a standard user

l Adding aWindows user

l Adding aWindows group

l Changing a username

l Changing a user password

l Changing a user access level

l Changing user details

l Deleting a user

User groups

l User Groups

l Adding a user group

l Adding a user to a user group

l Adding sources to a user group

l Changing a user group name

l Removing a user from a user group

l Removing sources from a user group

l Changing application access for a user group



l Moving a user between user groups

l Deleting a user group

For information on theWeb Application user licenses, see:

l ViewingWeb Applications user license information

For reference information see:

l UserManager

l UserManager user interface

l User access levels and permissions

Adding a user group

Add a user group to control which sources and applications the groupmembers can access in PME.

To add a user group:

1. In User Manager, select theUser Groups tab, and then click Add User Group.

2. In Add User Group - User Group Name, enter a group name, and then click Next.

3. In Add User Group - Users, select the users you want to be in the new group form the list of
available users, and then click Next.

NOTE: Supervisor level users are not included in the available users list. Supervisor level
user can only be amember of the Global group, not a custom group.

4. In Add User Group - Sources, in theAvailable Sources tree, select the sources you want the
users in this group to be able to access, and then click Next.

5. In Add User Group - Applications, select the applications you want the users in this group to
be able to access.

6. Click Finish.

Related topics:

Users

l Users

l Adding a standard user

l Adding aWindows user

l Adding aWindows group

l Changing a username

l Changing a user password

l Changing a user access level

l Changing user details

l Deleting a user
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User groups

l User Groups

l Adding a user group

l Adding a user to a user group

l Adding sources to a user group

l Changing a user group name

l Removing a user from a user group

l Removing sources from a user group

l Changing application access for a user group

l Moving a user between user groups

l Deleting a user group

For information on theWeb Application user licenses, see:

l ViewingWeb Applications user license information

For reference information see:

l UserManager

l UserManager user interface

l User access levels and permissions

Adding a user to a user group

Add a user to a user group to give this user access to the sources and applications assigned to this
group in PME.

To add a user to a user group:

1. In User Manager, select theUser Groups tab.

2. In the user groups table, select the row of the user group to which you want to add users, and
then click Edit in this row.

3. In Edit User Group, select theUsers tab, and then, in the user table, select the user you want
to add.

NOTE: Supervisor level users are not included in the available users list. Supervisor level
user can only be amember of the Global group, not a custom group.

4. Click Save.

Related topics:

Users

l Users

l Adding a standard user

l Adding aWindows user



l Adding aWindows group

l Changing a username

l Changing a user password

l Changing a user access level

l Changing user details

l Deleting a user

User groups

l User Groups

l Adding a user group

l Adding a user to a user group

l Adding sources to a user group

l Changing a user group name

l Removing a user from a user group

l Removing sources from a user group

l Changing application access for a user group

l Moving a user between user groups

l Deleting a user group

For information on theWeb Application user licenses, see:

l ViewingWeb Applications user license information

For reference information see:

l UserManager

l UserManager user interface

l User access levels and permissions

Adding sources to a user group

Add sources to a user group to give the users in this group access to these sources in PME.

To add sources to a user group:

1. In User Manager, select theUser Groups tab.

2. In the user groups table, select the row of the user group to which you want to add sources,
and then click Edit in this row.

3. In Edit User Group, select theSources tab, and then, in theAvailable Sources tree, select
the sources you want to add.

4. Click Save.
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Related topics:

Users

l Users

l Adding a standard user

l Adding aWindows user

l Adding aWindows group

l Changing a username

l Changing a user password

l Changing a user access level

l Changing user details

l Deleting a user

User groups

l User Groups

l Adding a user group

l Adding a user to a user group

l Adding sources to a user group

l Changing a user group name

l Removing a user from a user group

l Removing sources from a user group

l Changing application access for a user group

l Moving a user between user groups

l Deleting a user group

For information on theWeb Application user licenses, see:

l ViewingWeb Applications user license information

For reference information see:

l UserManager

l UserManager user interface

l User access levels and permissions

Changing a user group name

Change a user group name to give this group a better or moremeaningful name.



To change a user group name:

1. In User Manager, select theUser Groups tab.

2. In the user groups table, select the row of the user group for which you want to change the
name, and then click Edit in this row.

3. In Edit User Group, select theUser Group Name tab, and then change the name under
Name to the new group name.

4. Click Save.

Related topics:

Users

l Users

l Adding a standard user

l Adding aWindows user

l Adding aWindows group

l Changing a username

l Changing a user password

l Changing a user access level

l Changing user details

l Deleting a user

User groups

l User Groups

l Adding a user group

l Adding a user to a user group

l Adding sources to a user group

l Changing a user group name

l Removing a user from a user group

l Removing sources from a user group

l Changing application access for a user group

l Moving a user between user groups

l Deleting a user group

For information on theWeb Application user licenses, see:

l ViewingWeb Applications user license information

For reference information see:

l UserManager

l UserManager user interface

l User access levels and permissions
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Removing a user from a user group

Remove a user from a user group to no longer give this user access to the sources and applications
assigned to this group in PME.

To remove a user from a user group:

1. In User Manager, select theUser Groups tab.

2. In the user groups table, select the row of the user group from which you want to remove a
user, and then click Edit in this row.

3. In Edit User Group, select theUsers tab, and then, in the user table, clear the check box for
the user you want to remove.

4. Click Save.

Related topics:

Users

l Users

l Adding a standard user

l Adding aWindows user

l Adding aWindows group

l Changing a username

l Changing a user password

l Changing a user access level

l Changing user details

l Deleting a user

User groups

l User Groups

l Adding a user group

l Adding a user to a user group

l Adding sources to a user group

l Changing a user group name

l Removing a user from a user group

l Removing sources from a user group

l Changing application access for a user group

l Moving a user between user groups

l Deleting a user group

For information on theWeb Application user licenses, see:

l ViewingWeb Applications user license information



For reference information see:

l UserManager

l UserManager user interface

l User access levels and permissions

Removing sources from a user group

Remove sources from a user group to no longer give the users in this group access to these sources
in PME.

To remove sources from a user group:

1. In User Manager, select theUser Groups tab.

2. In the user groups table, select the row of the user group from which you want to remove
sources, and then click Edit in this row.

3. In Edit User Group, select theSources tab.

4. In theSelected Sources list, select the source you want to remove, and then click Remove

for this source.

5. Repeat step 4 for all the sources you want to remove from the user group.

(Optional) Click Remove All to remove all sources from the group.

6. Click Save.

Related topics:

Users

l Users

l Adding a standard user

l Adding aWindows user

l Adding aWindows group

l Changing a username

l Changing a user password

l Changing a user access level

l Changing user details

l Deleting a user

User groups

l User Groups

l Adding a user group

l Adding a user to a user group

l Adding sources to a user group
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l Changing a user group name

l Removing a user from a user group

l Removing sources from a user group

l Changing application access for a user group

l Moving a user between user groups

l Deleting a user group

For information on theWeb Application user licenses, see:

l ViewingWeb Applications user license information

For reference information see:

l UserManager

l UserManager user interface

l User access levels and permissions

Changing application access for a user group

Change application access for a user group to add or remove access to certain applications for the
members of this group in PME.

To change application access for a user group:

1. In User Manager, select theUser Groups tab.

2. In the user groups table, select the row of the user group for which you want to change applic-
ation access, and then click Edit in this row.

3. In Edit User Group, select theApplications tab, and then select the check boxes for the
applications you want to add, or clear the check boxes for the applications you want to
remove.

4. Click Save.

Related topics:

Users

l Users

l Adding a standard user

l Adding aWindows user

l Adding aWindows group

l Changing a username

l Changing a user password

l Changing a user access level

l Changing user details

l Deleting a user



User groups

l User Groups

l Adding a user group

l Adding a user to a user group

l Adding sources to a user group

l Changing a user group name

l Removing a user from a user group

l Removing sources from a user group

l Changing application access for a user group

l Moving a user between user groups

l Deleting a user group

For information on theWeb Application user licenses, see:

l ViewingWeb Applications user license information

For reference information see:

l UserManager

l UserManager user interface

l User access levels and permissions

Moving a user between user groups

Move a user to a different user group to change which sources and applications this user can
access in PME.

Tomove a user between two user groups, remove the user from the one group and add it to the other
group. The order in which these two tasks are performed is not important.

Related topics:

Users

l Users

l Adding a standard user

l Adding aWindows user

l Adding aWindows group

l Changing a username

l Changing a user password

l Changing a user access level

l Changing user details

l Deleting a user
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User groups

l User Groups

l Adding a user group

l Adding a user to a user group

l Adding sources to a user group

l Changing a user group name

l Removing a user from a user group

l Removing sources from a user group

l Changing application access for a user group

l Moving a user between user groups

l Deleting a user group

For information on theWeb Application user licenses, see:

l ViewingWeb Applications user license information

For reference information see:

l UserManager

l UserManager user interface

l User access levels and permissions

Deleting a user group

Delete a user group if this group is no longer needed, for example after all users have been removed
from the group.

To delete a user group:

1. In User Manager, select theUser Groups tab.

2. In the user groups table, select the row of the user group you want to delete, and then click
Delete in this row.

3. In Delete User Group, click Delete.

Related topics:

Users

l Users

l Adding a standard user

l Adding aWindows user

l Adding aWindows group

l Changing a username

l Changing a user password



l Changing a user access level

l Changing user details

l Deleting a user

User groups

l User Groups

l Adding a user group

l Adding a user to a user group

l Adding sources to a user group

l Changing a user group name

l Removing a user from a user group

l Removing sources from a user group

l Changing application access for a user group

l Moving a user between user groups

l Deleting a user group

For information on theWeb Application user licenses, see:

l ViewingWeb Applications user license information

For reference information see:

l UserManager

l UserManager user interface

l User access levels and permissions

Viewing Web Applications user license information

View license information to determine the number of available free licenses left in the system. You
can also see which users have licenses issued to them, and when they were issued.

NOTE: The license information shown in the User Manager is read-only. Use the Floating License
Manager to make changes to theWeb Application user licenses in the system.

To view license information:

1. In User Manager, select the Licenses tab.

2. View license summary information in the top left area of the page. View detailed license inform-
ation in the user license table of the page.

Related topics:

Users

l Users

l Adding a standard user
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l Adding aWindows user

l Adding aWindows group

l Changing a username

l Changing a user password

l Changing a user access level

l Changing user details

l Deleting a user

User groups

l User Groups

l Adding a user group

l Adding a user to a user group

l Adding sources to a user group

l Changing a user group name

l Removing a user from a user group

l Removing sources from a user group

l Changing application access for a user group

l Moving a user between user groups

l Deleting a user group

For information on theWeb Application user licenses, see:

l ViewingWeb Applications user license information

For reference information see:

l UserManager

l UserManager user interface

l User access levels and permissions



User Manager user interface

Users user interface (UI)

1
User Manager Help.
Click Help to open the online help.

2
Users, User Groups, and Licenses tabs.
Click a tab to open the associated screen.

3
Add Standard User, Add Windows User, and Add Windows Group function buttons.
Click a button to activate its function.

4
Search Users box.
Enter a search string to find users in the users table.

5
Users table.
Shows the existing users in the system.

6
Edit and Delete icons.
Click Edit to make changes to this user. Click Delete to delete this user.

7
Number of displayed users.
Shows the number of items visible on this page, and the total number of items in the system.

8
Page selector.
Navigate between pages. Set the number of items that are displayed on a page.

User Groups UI
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1
Add User Group button.
Click the button to add a new user group.

2
User Group table.
This table shows the existing user groups in the system.

Licenses UI

1 Web Applications User Licenses Summary.
2 Licenses table.

User access levels and permissions

The access level that is assigned to a user in PowerMonitoring Expert determines the permissions
this user has in the system. The following tables, Table 1 and Table 2, show the permissions
granted by the different access levels. Both tables show the same information, presented in
different formats. Table 1 is organized by access level, Table 2 is organized by application.

NOTE: Web Application access is controlled through user group settings. If a user group does not
have access to aWeb Application, then the groupmembers cannot access this application
regardless of their user access permissions.

Table 1: Permissions by access level

Supervisor Operator Controller User Observer Permissions Application

(Not
Alarm
Views)

View public content

- Dashboards
- Diagrams
- Trends
- Alarms
(Viewer)
- Reports



View diagrams Vista

View diagrams Designer

Run the application

- Logical
Device Type
Editor
- DB
Manager
- Diagnostics
Viewer
- Device
Type Editor
- Remote
Modem
Setup
- VIP Setup
- Update
EWS
- PQDIF
Exporter
- TOU Editor
- Configure
Managed
Circuits

View alarms
Alarms
(Viewer)

(Not
Diagrams
or Alarm
Views)

Create private
content

- Dashboards
- Diagrams
- Trends
- Alarms
(Viewer)
- Reports

Acknowledge
alarms

Alarms
(Viewer)

View all private
content in own user
groups
Edit/delete public
content in own user
groups

- Dashboards
- Diagrams
- Trends
- Alarms
(Viewer)
- Reports
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Run the application

- Hierarchy
Manager
- Rate Editor
- Alarm
Configuration

Connect/disconnect
sites and devices

Management
Console

Modify device
network
configuration
Add devices to the
system

Management
Console

Run the application Update OPC

View/edit/delete
any content

- Dashboards
- Diagrams
- Trends
- Alarms
(Viewer)
- Reports

Create/edit users
Create/edit user
groups

User
Manager

Create/edit diagram
links

Diagrams

Run the application

-Web Apps
Settings
- User
Manager

Create/edit
diagrams

Vista

Create/edit
diagrams

Designer

Run the application

- Event
Watcher
- Reports
Configuration
- Diagrams
Configuration
- Deactivate
Alarms
- Configure
Managed
Circuits



Table 2: Permissions by application

Application Permissions Supervisor Operator Controller User Observer

- Dashboards
- Diagrams
- Trends
- Alarms
(Viewer)
- Reports

View public content
(Not

Alarm
Views)

Create private
content

(Not
Diagrams
or Alarm
Views)

View all private
content in own user
groups
Edit/delete public
content in own user
groups

View/edit/delete any
content

Alarms
(Viewer)

Acknowledge alarms

View alarms

User
Manager

Create/edit users
Create/edit user
groups
Run the application

Diagrams
Create/edit diagram
links

Web Apps
Settings

Run the application

- Hierarchy
Manager
- Rate Editor
- Alarm
Configuration

Run the application

Vista
View diagrams

Create/edit diagrams

Designer
View diagrams

Create/edit diagrams
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Management
Console

Connect/disconnect
sites and devices

Modify device
network
configuration
Add devices to the
system

Update OPC Run the application

- Event
Watcher
- Reports
Configuration
- Diagrams
Configuration
- Deactivate
Alarms
- Configure
Managed
Circuits

Run the application

- Logical
Device Type
Editor
- DB Manager
- Diagnostics
Viewer
- Device Type
Editor
- Remote
Modem Setup
- VIP Setup
- Update
EWS
- PQDIF
Exporter
- TOU Editor
- Configure
Managed
Circuits

Run the application



Web security changes
TheGenerate Authentication URL page allows for generating destination URL types that can be
used in Building Operation. This section provides instructions for enabling the page, and describes
the function of the various components.

User authentication
PMEWeb applications require user authentication to launch. There aremultiple methods to access
a PMEWeb application from inside another EcoStruxure supervisor software:

l Manual PME Authentication: The user must enter PME user credentials into a login window
before a PMEWeb application can launch. These credentials are then cached for the rest of the
PME session.

l Automatic PME Authentication: (least secure) Specific URL addresses are created for the
target PME web application. When one of these PME URLs is used to launch a PMEWeb
application from another supervisory software, PME automatically allows access without
prompting the user to enter PME credentials. This method provides a seamless user experience
but it does not provide the security level of theManual Authenticationmethod. For security reas-
ons, supervisor-level user names cannot be used.

l Windows Authentication: (most secure) Logs the user into PME using their current Windows
credentials. This method provides a seamless user experience and is themost secure.

NOTE: TheWindows Authentication option is themost secure, but requires that PowerMonitoring
Expert has been configured withWindows Active Directory users and user groups.

When testing the generated authentication URL, test the URL in a separate browser session, not
just in a separate tab in the current browser. Otherwise, your current login credentials may be used,
or youmay be logged out of this page altogether.

To open a new browser session in Internet Explorer, open the File menu and select New Session. If
you are using Chrome, open a new incognito window.

User authentication with Windows Active Directory
To link Windows Active Directory to a Building Operation Domain:

1. Log on toWorkStation

2. OpenControl Panel

3. Click Domains

4. Click Add

5. Give it a name, then click Next

6. In the Authentication window, type the Active Directory Windows domain name (for example,
Example.org). Click Next.

7. Do not add domainmembers. Click Next.

8. Leave the default Domain Policies of 9 login attempts

9. Click Create
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To add the Active Directory user groups to the Building Operation Domain:

1. In the System view, right-click the Groups in the new Domain

2. Click New > User Account Group

3. Ignore the Users page. Click Next.

4. Add the default workspace. Click Next.

5. (optional) adjust the policies.

6. click ... for theWindows group name field.

7. Select the AD user group from the list and click OK.

8. Click Create.

To give the User Group permissions in Building Operation:

1. Open the user group.

2. Select thePermissions tab

3. Click + to add a path permissions line

4. Assign read permissions (or more, if needed).

5. Save the changes

To log on toWorkStation with aWindows account:

1. Log intoWindows / Remote Desktop with theWindows user

2. OpenWorkStation and check the windows login button (forget what it's called)
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